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Introduzione

Informazioni su M-Print® PRO

Il programma serve a siglare e a stampare su materiale su cui scrivere (cartellini MultiCard,
targhe ed etichette).

Possono essere stampati:

Cartellini MultiCard

Targhette a inserimento su fogli
Etichette su pagine

Bobine di etichette in continuo
Guaine termoretraibili
MetalliCards

Materiale MultiMark

Il programma puo essere installato localmente o come installazione di rete affinché il programma
sia disponibile in rete (vedere il capitolo “Versione di rete “, sezione “Setup”).

Avvertenze relative al presente manuale

La presente documentazione presuppone la conoscenza pratica del sistema operativo utilizzato,
ossia di Microsoft Windows.

6 In caso contrario si prega di consultare il manuale utente di Windows.
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Simboli

Nelle presenti istruzioni per 'uso saranno adottate le seguenti convenzioni:

Gras Componenti importanti del programma: pulsanti, voci menu, barre degli
setto strumenti, descrizioni ecc. saranno rappresentati in grassetto.
" " 1 nomidelle finestre e i rimandi ad altri capitoli saranno messi tra virgolette.

> Separatori per le voci dei sottomenu (ad es. Visualizza > Zoom)

° | testi che seguono questo tipo di evidenziazione descrivono attivita da eseguire
nella sequenza predefinita.

Simboli utilizzati

Le informazioni relative a M-Print® PRO dovranno assolutamente essere
rispettate.

e Con questo simbolo sono contrassegnate importanti informazioni supplementari.

Spiegazione dei termini
Qui di seguito saranno citati termini speciali utilizzati nel software M-Print® PRO.

Marcatore
Il marcatore serve a contrassegnare un elemento elettrico o elettronico (morsetti, conduttori,
impianti, apparecchi ecc.) nonché a siglare un mezzo di produzione.

Tipo di marcatore
Marcatore di un determinato tipo, ad es. MultiCard DEK 5/3,5.

Avvertenze di installazione

Per l'installazione del programma sara necessario possedere i diritti
dell Amministratore per il computer interessato.
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Istruzioni generali

Introduzione

Il presente capitolo illustra le varie possibilita di avvio e di chiusura del programma.
Sono inoltre contenute indicazioni generali per la struttura del programma e la configurazione
dell'interfaccia.

Avvio e chiusura del programma

Avvia programma

Fare doppio clic sul simbolo che si trova nel campo di lavoro del computer.

Chiudi programma
Nella barra dei menu selezionare la voce File > Esci.

Se un progetto risulta ancora aperto, viene visualizzata una finestra di dialogo che consente di
salvare il progetto.

Istruzioni per l'uso Istruzioni generali o 3



Interfaccia del programma

All'interno dell’interfaccia del programma avviene 'elaborazione dei marcatori.
L’interfaccia del programma viene visualizzata automaticamente all’avvio del programma. Essa
mette a disposizione tutti gli elementi necessari per I'elaborazione dei marcatori.

A seconda della configurazione, l'interfaccia del programma si compone di elementi diversi.

rE M-Print® PRO - [SM 27/27 K MC NE WS] Eléu
ﬁ File Modifica Visualizza Inseriscc Forma Formato  Strumenti  Finestra Guida _Mmx
L EE EEE D A% B X S FH 9 o] E] 0% - G @ R SE) g
: 7 Arial -0 v A A MEIE=| B 2 u&u,ﬂ%%lﬁ@lﬂ

BB
G EeO0 /O ks + B
(imEE E g

M-Print® PRO v. 8. 5. 1 |

Esplora progetti X 4 Paginainiziale | CC1527 MMWS | DEK56.5MCNEWS -~ SM 27/27 KMCNEWS | boX
E] @ |3 ¢ =27 ot 2 A A s e el & A el e
= CC15/27 MM WS - - =]
4 Pagina 0l =x
DEK5/65MCNEWS | | [= PROJECT |  MARKER
5| Pagina 01 =il ==
= |
Pagina 02 E
=i Pagina 03 o= il
=58 SM27/27 KMC NEWS - | ™= —
« ; m G . -
|
Pmpneta b I —]
4 | & | B I ]
E Awvio del programma o~ E —
Mome MARKER Bl |
B Dimensioni e posizione .
Sinistra 0 = |
In atto 0 . —
Destra 7 =
Inferiore 27 e
| arhezza 77 S J
i
Ennon lnfurmazmmi Pagina m_
Per aprire la Guida, premere F1 I Marcatore: 1/12 Colonna: 1/6 Riga: 1,2 |?I|

Ulteriori informazioni sono reperibili nel capitolo "Interfaccia del programma”.
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Tipi di file supportati

All'apertura sono supportati i seguenti tipi di file:

M-Print® PRO File (*.mpc)

File ordinazione M-Print® PRO (*.mpo, *.mpo2)
Template M-Print® PRO (*.mpt)

Documento M-Print (*.abp, *.gdc)

Documento M-Label (*.mld)

Documento M-Comm (*.tmf)

File esportazione RailDesigner (*.rde)
TXX/TXY Files (*.txx; *.txy)

Foglio di lavoro di Microsoft® Excel® (*.xIs)
File XMT (*.xmt, *.txt)

M-Print® PRO Import Script (*.mis) (vedere il capitolo "Importazione veloce di Excel®")

Istruzioni per l'uso Istruzioni generali o 5



Funzioni utilizzate di frequente
In questa sezione vengono descritte le funzioni utilizzate di frequente a titolo di esempio
Elaborazione di un elemento

E possibile creare degli elementi utilizzando la voce di menu "Inserisci" o la barra degli strumenti
"Elementi" (vedere il capitolo "Barre degli strumenti").

Per poter modificare uno o piu elementi prima € necessario selezionarlo/selezionarli (vedere il
capitolo "Selezionare gli elementi").

Vedere anche il capitolo "Finestra Proprieta”.

Inserendo elementi o cambiando successivamente le dimensioni degli elementi & possibile
mantenere o variare la simmetria degli elementi (vedere il capitolo "Simmetria degli elementi").

6 e Istruzioni generali Istruzioni per l'uso



Inserimento di un campo di testo

Creazione di un nuovo campo di testo

Fare clic su questo simbolo nella barra degli strumenti o selezionare la
voce di menu Inserisci > Campo di testo.

Posizionare il cursore nel punto in cui si desidera immettere il testo.

ey Creare un nuovo campo di testo circolare

Stesse funzioni come un normale campo di testo. Scegliere la voce menu
Inserisci > Campo di testo circolare.

Con la proprieta "Punto di ancoraggio” si stabilisce I'angolo iniziale del
testo.

Creazione di una nuova casella di gruppo

Stesse funzioni come un normale campo di testo. Scegliere la voce menu
Inserisci > Casella di gruppo. Vedere il capitolo ,Casella di gruppo®.

Se viene visualizzato questo puntatore, sara possibile creare un campo di
testo.
Tenere premuto il pulsante sinistro del mouse. Tracciare un riquadro, poi
rilasciare il pulsante del mouse. Si aprira un settore di editazione in cui sara
possibile immettere il testo.

L'immissione del testo sara possibile solamente nei settori ammessi:
se compare questo puntatore I'immissione non sara possibile.

A116 ' |Se, dopo l'inserimento del testo, i campi di testo presentano un triangolo
A115 —w- 1 r0ss0, Cio significa che il testo non rientra nello spazio previsto dal campo.
In questo caso il testo non verra né visualizzato né stampato
completamente. Sara dunque necessario ridurre il testo o farlo adattare
automaticamente dal programma (vedere il capitolo "Adatta dimensioni
font" nel capitolo "Menu Formato").
23456 Se, dopo l'inserimento del testo, i campi di testo presentano un triangolo
| 789 | |rosso, il testo non sara visualizzato su una sola riga, ma su piu righe, non
essendo piu sufficiente il campo di testo.
Sussistono le seguenti possibilita di adattamento:
- Adatta lunghezza marcatore.
Vedere capitolo "Istruzioni generali", sezione "Adatta lunghezza
marcatore".
- Adatta stringhe.
Vedere capitolo "Istruzioni generali”, sezione "Adatta stringhe".
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Inserire una forma

@ Creazione di rettangoli/quadrati
Fare clic su questo simbolo o selezionare la voce Inserisci > Rettangolo
nella barra dei menu.
Tenendo premuto il pulsante sinistro del mouse tracciare un rettangolo.

Impostando la proprieta "Arrotondamento X" o "Arrotondamento Y" da un
normale rettangolo diventa un rettangolo con bordi arrotondati.

O Creare un rettangolo arrotondato / quadrato arrotondato
Fare clic su questa icona oppure nella barra menu scegliere la voce
Inserisci > Rettangolo arrotondato.
Tenendo premuto il pulsante sinistro del mouse tracciare un rettangolo con
bordi arrotondati.

| rettangoli con bordi arrotondati si differenziano dai normali rettangoli solo
per il fatto che & impostata la proprieta "Arrotondamento X" o
"Arrotondamento Y". Se si impostano questi valori su 0 viene visualizzato
un normale rettangolo.

Creazione di linee

Fare clic su questo simbolo nella barra degli strumenti o selezionare la
voce Inserisci > Linea nella barra dei menu.
Tenendo premuto il pulsante sinistro del mouse tracciare una linea.

@l Creazione di cerchi/ellissi
Fare clic su questo simbolo o selezionare la voce Inserisci > Ellisse nella
barra dei menu.
Tenendo premuto il pulsante sinistro del mouse tracciare un'ellisse.

6 E possibile impostare la posizione e le dimensioni esatte nella finestra
"Proprieta” (vedere la sezione "Finestra Proprieta").

8 e Istruzioni generali Istruzioni per l'uso



Inserimento di un'immagine
Il programma supporta i formati grafici BMP, EMF, GIF, ICO, JPG, PNG, WMF e TIFF.

Inserimento di un'immagine
Fare clic su questo simbolo o selezionare la voce Inserisci > Grafico nella
barra dei menu.
Tenendo premuto il pulsante sinistro del mouse tracciare una cornice. Sara
ora visualizzata una finestra in cui & possibile selezionare il file desiderato.
Premere quindi il pulsante Apri. Verra cosi inserita la figura selezionata.

Nella finestra "Proprieta” & possibile indicare se la figura deve essere
inserita nelle sue dimensioni originali oppure se deve essere adattata alla
cornice.

| grafici non vengono collocati nel campo, bensi viene creato solamente un
collegamento ad essi. Il percorso € visualizzato nella finestra "Proprieta”
(vedere la sezione "Finestra Proprieta").
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Inserimento di un codice a barre

Il programma supporta i seguenti tipi di codice a barre:

- Code 39

- Code 128

- Code 2/5 Industrial

- Code 2/5 Interleaved

- EAN13 (con/senza carattere controllo)
- EANS (con/senza carattere controllo)
- EAN128

- UPC-A (con/senza carattere controllo)
- UPC-E (con/senza carattere controllo)
- Codice QR

- Matrice dati

- GS1 DataMatrix

- MicroPDF417

Inserimento di un codice a barre
Selezionare nella barra dei menu la voce Inserisci > Codice a barre.
Viene visualizzato un menu a tendina nel quale & possibile selezionare un
codice a barre.
Tracciare con il mouse un campo, poi rilasciare il pulsante del mouse. Il
codice a barre selezionato viene inserito.
Nella finestra "Proprieta” & possibile immettere il codice in forma numerica
o alfanumerica (vedere la sezione "Finestra Proprieta").

e Per alcuni codici a barre viene calcolato internamente un carattere di
controllo (per esempio "EAN 8"). Questo carattere di controllo non deve
essere né digitato manualmente né essere importato con il valore del
codice a barre.

Se il carattere di controllo viene trasmesso o digitato, occorre selezionare
un altro tipo di codice a barre (per esempio "EAN 8 con carattere di

controllo").

6 Controllare sempre la rilevabilita dei codici a barre nei terminali prima di
approvarli.

e A partire dalla versione 9.2, é presente una libreria di codici a barre

aggiornata. Per visualizzare i codici a barre con la libreria precedente,
seleziona la voce "Usa libreria codici a barre versione 1" nelle impostazioni
dei codici a barre. Vedere il capitolo ,Jmpostazioni standard elementi®.
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Inserimento di caratteri speciali

Nella tabella di caratteri & possibile selezionare il tipo di carattere e avere una panoramica di tutti
i caratteri, compresi quelli speciali, disponibili per il tipo di carattere desiderato.

Selezionare le voci di menu Visualizza > Tabella di caratteri e Carattere per aprire la tabella di

caratteri.
Tabella di carakteri =
B Arial w
Decidentale w
| u # $ % | 1 I: :l = |
+ |, |- o1 g4
167|812 . ]=|=]|=
YIEIA|B|C|DIE|F|G|H
[1JKILIMINIOP|Q[IR
S TIUW W[ H[Y[Z]] |
111 alb|lc|d|je|f
glhli|j|k|!I|m|n]olp
glrls|t|u|w|w|x|yv|Z|w

® Selezionare il carattere mediante la freccia del primo menu a tendina e la lingua mediante la
freccia del secondo menu a tendina.

Posizionare il cursore nel punto in cui deve essere inserito il carattere.

Fare doppio clic sul carattere da inserire. Quest’ultimo apparira nel campo di testo
evidenziato.

E possibile copiare e incollare un carattere da questa finestra anche con il menu di scelta rapida:

® Selezionare il carattere che si desidera copiare. Fare clic con il pulsante destro del mouse e
scegliere Copia carattere.

® Posizionare il cursore nel punto in cui deve essere inserito il carattere (editor online). Fare
clic con il pulsante destro del mouse e scegliere la voce del menu di scelta rapida Inserisci.

Istruzioni per l'uso Istruzioni generali o 11



Inserimento di simboli

Con la funzione Inserisci simbolo & possibile selezionare e incollare dei simboli.
Selezionare nella barra dei menu le voci Visualizza > Simboli per aprire la finestra dei simboli.

Simbaoli 4

I'*sywnbols'\ - I

| |

A\

-

O

S |8 (|

LFEIO6

p= |

Inserisci simbolo

® Fare clic sul simbolo che si desidera incollare.
® Portarsi con il mouse sul campo in cui si desidera incollare il simbolo.

® Tenendo premuto il pulsante sinistro del mouse tracciare un rettangolo. Il simbolo verra cosi
inserito.

® E possibile modificare le dimensioni del simbolo facendo clic su di esso e trascinandone gli
angoli al fine di ingrandirlo o di diminuirlo.

In alternativa:
® Selezionare il campo in cui si desidera incollare il simbolo.
® [are doppio clic sul simbolo che si desidera incollare.

La rappresentazione del simbolo pud essere personalizzata con la proprieta
"Dimensioni" (vedere la sezione "Comportamento" nel capitolo
"Personalizzazione delle proprieta").
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Cartella simboli

E preimpostata nel campo a discesa la cartella standard per i simboli. Per modificare il percorso
si rimanda al capitolo "Finestra di dialogo Opzioni", sezione "Directory".

Ricercareffiltrare la cartella dei simboli
Per effettuare ricerche o filtrare i file dei simboli € possibile immettere un termine di ricerca.

Vi sono diverse possibilita:

Chiave di Risultato
ricerca

Se il campo di ricerca rimane un vuoto, vengono visualizzati tutti i
contenuti della directory selezionata

Simbolo00? Il punto interrogativo rappresenta il segnaposto per un carattere.
Sono reperiti ad es. "Simbolo001.bmp" e "Simbolo002.bmp".

Simbolo* L'asterisco rappresenta il segnaposto per un numero di caratteri a
piacere.

Sono reperiti ad es. "Simbolo010.bmp" e "Simbolo020.bmp".

Per azzerare il campo di ricerca fare clic su .
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Inserire una scala

Si possono inserire scale diritte o circolari (arrotondate).

L#2 182 Creanuovascala
Fare clic su una delle icone qui accanto nella barra degli strumenti oppure
selezionare la voce menu Inserisci > Scala o Scala arrotondata.
Tracciare con il mouse un campo, poi rilasciare il pulsante del mouse.

Si apre una finestra di dialogo che consente di impostare i dati di
riferimento della scala.

® Scegliere il tipo di scala e stabilire valori, distanze e diciture.

® | adicitura della scala dipende solamente dal valore iniziale, dal valore finale e dalla distanza
della dicitura.

Esempio 1:
Se il valore iniziale = 0, il valore finale = 8 e la distanza della dicitura = 2 si ottiene la
seguente sequenza numerica: 0, 2, 4, 6, 8

Esempio 2:

Se il valore iniziale = 1, il valore finale = 100 e la distanza della dicitura = 20 si ottiene la
seguente sequenza numerica: 1, 21, 41, 61, 81

Il valore finale 100 in questo caso non é visualizzato.

® | e distanze dei trattini della scala (distanza grande / piccola) si riferiscono sempre
all'intervallo di valori.

Esempio:

Intervallo di valori (valore iniziale / finale) da 0 a 50 e distanza grande = 10.

Sono visualizzati 6 trattini grandi della scala (0, 10, 20, 30, 40, 50).

Se inoltre si sceglie la distanza della dicitura = 10, viene provvisto di dicitura anche ogni
trattino grande della scala.
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Finestra delle impostazioni

Skaleneinstellungen ﬁ

Skalenart

@ Lineare Skala

_ Logarithmische Skala 10,00
I Angepasste Skala Stittzstellen. ..
Skalenfestlegungen
Anfangswert: 0,00 Anfangswinkel: 225
Endwert: 10,00 Endwinke!: 135
Grofier Abstand: 2,00
Kleiner Abstand: 1,00
Beschriftungen
Abstand: 2,00
Ausrichtung: @) Horizontal
_! Tangential

["| Beschriftung um 180° gedreht

Zeicheneinstellungen

Skalenradius: 5,370 mm
Skalenhahe: 0,837 mm
SchriftgroBe: 6,00 Punkte

[ OK ] [ Abbrechen ]

Tipo di scala
La rappresentazione della dimensione modulare. € possibile scegliere tra:
Lineare: l'andamento dell'intervallo di valori € lineare.

Logaritmico: l'andamento dell'intervallo di valori & quadratico, vale a dire che
viene visualizzata una scala logaritmica.

Adattato: L'andamento dell'intervallo di valori € stabilito mediante punti. Tra
i punti 'andamento & lineare (vedere il capitolo "Punti
d'appoggio").

Valore iniziale
Dicitura all'inizio della scala

Valore finale
Dicitura alla fine della scala

Distanza grande
Distanza tra i trattini grandi della scala (misurata nell'intervallo di valori)

Distanza piccola
Distanza tra i trattini piccoli della scala (misurata nell'intervallo di valori)
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Angolo iniziale (solo scala arrotondata)
Angolo con cui inizia la scala arrotondata (vedere anche il capitolo "Scala arrotondata”.

Angolo finale (solo scala arrotondata)
Angolo con cui finisce la scala arrotondata (vedere anche il capitolo "Scala
arrotondata”.

Distanza

Distanza della dicitura da quella successiva (partendo dal valore iniziale)

Esempio: Se il valore iniziale = 0, il valore finale = 8 e la distanza della dicitura = 2 si
ottiene la seguente sequenza numerica: 0, 2, 4, 6, 8.

Allineamento (solo scala arrotondata)

Per la visualizzazione della dicitura. & possibile scegliere tra:

Orizzontale: la dicitura € visualizzata in orizzontale

Tangenziale: la dicitura e visualizzata tangenzialmente (in direzione
dell'andamento del cerchio).

La dicitura puo essere visualizzata ruotata di 180° nei due allineamenti.

Lunghezza della scala o raggio della scala

In una scala diritta la lunghezza dell'elemento della scala inserito.

In una scala arrotondata il raggio interno dell'elemento della scala.

Il valore viene preimpostato quando si traccia lI'elemento con il mouse.

Altezza scala
L'altezza della scala corrisponde all'altezza dei trattini grandi della scala.
Il valore viene preimpostato quando si traccia l'elemento con il mouse.

| trattini piccoli della scala sono sempre lunghi meta dei trattini grandi della scala.
Dimensione carattere

La dimensione del carattere della dicitura.
Il valore viene preimpostato quando si traccia I'elemento con il mouse.

6 E possibile impostare la dicitura, la posizione e le dimensioni esatte della scala
nella finestra "Proprieta” (vedere la sezione "Finestra Proprieta").

6 Ulteriori informazioni ed esempio sono presenti nel capitolo "Scale".
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Nota sulla visualizzazione

Se nella visualizzazione della scala sono mostrati triangoli rossi, significa che i valori della scala
scelti non si adattano alle dimensioni dell'elemento della scala. In questo caso I'elemento deve
essere ingrandito con il mouse nelle direzioni indicate.

Allineamento di elementi sulla griglia

Mediante le voci di menu Visualizza > Griglia > Allinea alla griglia & possibile far si che gli
elementi si fissino o meno alle linee della griglia.
A questo scopo € necessario che la griglia sia visibile (menu Visualizza > Griglia > Mostra).

Selezionare gli elementi

Seleziona elemento
Facendo clic sul simbolo con il pulsante sinistro del mouse & possibile

selezionare I'elemento.

Seleziona piu elementi

Se gli elementi da selezionare sono direttamente uno vicino all’altro, oppure
uno sotto I'altro, & possibile evidenziarli in un unico passaggio con l'ausilio
di una cornice.

Facendo clic sul simbolo a fianco sara possibile attivare una cornice per
selezionare gli elementi. Tenere premuto il pulsante sinistro del mouse.
Trascinare la cornice attorno agli elementi che si desidera selezionare.
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Spostamento degli elementi

Gli elementi che si trovano sul livello del designatore di progetto oppure di quello del marcatore
possono essere spostati solamente all’interno dell’area definita del designatore di progetto o del
marcatore.

® FEvidenziare I'elemento che si desidera spostare facendo clic con il pulsante sinistro del
mouse. Portando sull’elemento il puntatore del mouse, quest’ultimo cambiera come segue e
I'elemento potra cosi essere spostato:

1—I—r

Tenere il pulsante del mouse premuto e spostare I'elemento nella posizione desiderata.

Un'ulteriore possibilita per spostare un elemento € I'impostazione tramite la finestra "Proprieta”
(vedere a questo proposito la sezione "Finestra Proprietd", categoria "Dimensioni e posizione").
In questo modo sara possibile immettere valori precisi.
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Rotazione degli elementi

® Fare clic sull’elemento (testo, forma, immagine, codice a barre) che si desidera ruotare.
® Selezionare le voci di menu Forma > Ruota...

Viene visualizzata la finestra seguente:

Ruota rz

Direzione angaolo (relativo alla posizione corrente)
(%) Sinistra (a0° (11800 z7ne
O ]

Ik ] [ annulla ]

Qui € possibile immettere 'impostazione desiderata e confermare facendo clic su OK.

e Notare che durante la rotazione I'elemento si adatta, se necessario, alle
dimensioni dell’area di marcatura.

Esempio:

La figura seguente mostra I'elemento prima della rotazione:

... e dopo la rotazione:
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Copiare e incollare gli elementi

La funzione copia/incolla (copy/paste) consente di trasferire soltanto le proprieta specifiche del
documento.

La totalita delle proprieta viene trasferita solamente se si tratta dello stesso tipo di elemento
(ad es. testo su testo, immagine su immagine).

Fare clic sull’elemento (o sugli elementi) che si desidera copiare.
Selezionare le voci di menu Modifica > Copia.
Fare clic sull’elemento in cui I'elemento deve essere incollato.

Selezionare le voci di menu Modifica > Incolla per incollare il contenuto OPPURE Modifica
> Incolla elementi per incollare I'elemento.

e Non tutti gli elementi possono essere incollati su altri elementi.

Tagliare e incollare gli elementi

Evidenziare I'elemento che deve essere tagliato.
Selezionare la voce di menu Modifica > Taglia.
Fare clic sull’elemento in cui I'elemento deve essere incollato.

Selezionare le voci di menu Modifica > Incolla per incollare il contenuto OPPURE Modifica
> Incolla elementi per incollare I'elemento.

Non tutti gli elementi possono essere incollati su altri elementi (vedere il capitolo
"Copiare e incollare gli elementi")!
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Duplicazione degli elementi

® Evidenziare I'elemento che si desidera duplicare.
® Selezionare le voci di menu Modifica > Duplica.
® | ’elemento duplicato viene collocato con un leggero scostamento sull’elemento evidenziato.

Cancellazione degli elementi

® FEvidenziare I'elemento che si desidera cancellare.
® Selezionare la voce di menu Modifica > Elimina.
® Nel sottomenu della voce Cancella & possibile selezionare le seguenti sottovoci:

Contenuto Cancella solo il contenuto dell'elemento.
dell'elemento

Questo campo Cancella l'intero campo.

Marcatori Cancella tutti i marcatori su cui si trovano gli elementi evidenziati

selezionati senza chiedere conferma.

Questa pagina Cancella la pagina attualmente visualizzata.

Pagine... Apre una finestra di dialogo che consente di cancellare piu
pagine.

Se una voce di menu non é disponibile (disattivata), significa che non & possibile
selezionare la funzionalita corrispondente.
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Blocco di un elemento

E possibile bloccare campi di testo, campi di grafico, codici a barre e forme.
Solo nei campi di testo € possibile eseguire ancora immissioni e formattazioni.
Tra le altre vengono bloccate le seguenti proprieta:

- Dimensioni e posizione

- Bordi e riempimenti

- Proprieta del campo

- Orientamento e ordine dei tab

® Fvidenziare I'elemento che si desidera bloccare.

= Fare clic su questo simbolo nella barra degli strumenti per bloccare I'elemento
evidenziato.

Esempio di "elemento bloccato”

-1+

Creare elementi quadraticamente

Per creare elementi quadratici vedere il capitolo "Simmetria degli elementi".
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Simmetria degli elementi

Con la simmetria degli elementi € possibile mantenere le dimensioni (rapporto tra altezza e
larghezza) degli elementi oppure portarle su valori uguali (quadratiche).

Per fare cio ci sono diverse possibilita:

Inserire tenendo premuto il tasto Shift (dimensioni quadratiche)
Se si inseriscono gli elementi tenendo premuto il tasto Shift, le dimensioni vengono mantenute
guadratiche.
Eccezioni:
e Linea — viene inserita orizzontalmente o verticalmente
e Campo di testo circolare — & sempre circolare
e Scala

Trascinare tenendo premuto il tasto Shift + Alt (portare a dimensioni quadratiche)
Se si trascinano gli elementi esistenti (€ possibile la selezione multipla) dal rispettivo angolo
tenendo premuta la combinazione di tasti Shift+Alt, le dimensioni vengono variate
quadraticamente.
Eccezioni:

e Linea - viene modificata orizzontalmente o verticalmente

e Scala

Trascinare tenendo premuto il tasto Shift + Ctrl (mantenere le proporzioni)

Se si trascinano gli elementi esistenti (€ possibile la selezione multipla) dal rispettivo angolo
tenendo premuta la combinazione di tasti Shift+Ctrl, vengono variate le proporzioni delle
dimensioni. Il rapporto tra altezza e larghezza non viene variato.

Eccezioni:
e Linea - mantiene il suo angolo
e Scala
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Modifica della sequenza degli elementi

Se piu elementi sono stati disposti uno sopra l'altro, & possibile modificarne la sequenza

utilizzando la barra degli strumenti "Layout".
Le seguenti impostazioni si riferiscono all’elemento evidenziato del livello corrente.

" L’elemento viene spostato a un livello superiore.

1 L’elemento viene spostato a un livello inferiore.

'w? L’elemento viene portato in primo piano.

L’elemento viene portato sullo sfondo.

e

® FEvidenziare I'elemento che si desidera posizionare e premere il simbolo corrispondente.

Sara possibile accedere a queste funzioni anche tramite la barra dei menu selezionando la voce
Forma e quindi I'allineamento desiderato.

Modifica delle dimensioni di un elemento

® Fare clic sull’elemento di cui si desidera modificare le dimensioni.
D
® Trascinando I'elemento dagli angoli sara possibile ingrandirlo o diminuirlo.

Tramite la finestra "Proprietd" é possibile indicare le dimensioni esatte nella categoria
"Dimensioni e posizione".

Vedere a questo proposito la sezione "Finestra Proprieta".
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Adattamento dell’altezza

® Evidenziare gli elementi di cui si intende adattare I'altezza e fare clic sul simbolo seguente.
® Selezionare la voce di menu Forma > Stessa altezza per adattare l'altezza.

Adattamento della larghezza

® Evidenziare gli elementi di cui si intende adattare la larghezza e fare clic sul simbolo
seguente.

® Selezionare la voce di menu Forma > Stessa larghezza per adattare la larghezza.

Salvare un'immagine su file

Se si vogliono salvare tutte le immagini come incorporate nel file del programma (ad esempio
per inoltrare il file), richiamare la voce menu "File > Incorpora immagini e salva con home..." e
salvare il file con un altro nome.

Tutte le immagini vengono integrate/incorporate nel file.
Per salvare di nuovo all'esterno le immagini incorporate nei file vedere il capitolo "Estrarre

immagini dai file")
Estrarre immagini dai file

Le immagini possono essere integrate nei file di programma (vedere il capitolo "Contenuto"). La
proprieta "Tipo" dell'immagine & impostata sul valore "incorporato”.

Per estrarre in un secondo momento queste immagini dal file, procedere nel modo seguente:
® fare clic con il tasto destro del mouse su un'immagine integrata.

® Dal menu di scelta rapida che appare scegliere la voce "Salva immagine con nome...".
® Scegliere il percorso e il nome dell'immagine e fare clic su "Salva".
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Raggruppa
E' possibile raggruppare piu (almeno due) elementi di un marcatore.
® Selezionare gli elementi da raggruppare e scegliere la voce menu Modifica -> Raggruppa.
Esiste la possibilita di riunire i gruppi in altri gruppi.
Le modifiche di alcune proprieta hanno effetto sull'intero gruppo (per esempio spessore della
linea, colore di riempimento).
Facendo clic su un elemento di un gruppo si seleziona il gruppo. Facendo un ulteriore clic su un
elemento si puo selezionare I'elemento nel gruppo, in modo da poter modificare le sue proprieta
(per esempio il suo testo).

Quando si sciolgono dei gruppi, i relativi gruppi in essi contenuti vengono mantenuti.

E' possibile raggruppare solamente elementi dello stesso tipo di campo (vedere anche il capitolo
"Campao").

Gli elementi selezionati di un gruppo possono essere cancellati dal gruppo.
Spostare un gruppo con il mouse

Il gruppo puo essere spostato con il mouse soltanto facendo clic sui suoi bordi. Il puntatore del
mouse cambia in modo corrispondente.

Moo ] ] o
AR 4-I+
B [

] ] n

Panoramica dei gruppi esistenti
La selezione oggetto mostra una panoramica dei gruppi esistenti. In questa visualizzazione si
puo selezionare anche un gruppo (vedere il capitolo "Selezionare gli elementi").
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Formatta testo

La formattazione del testo e I'impostazione delle linee potra essere effettuata mediante la barra
degli strumenti "Formatta testo" oppure tramite la finestra "Proprieta”.

Allineamento di un testo

Evidenziare il testo e selezionare nella barra degli strumenti "Formatta testo” il pulsante
corrispondente per allineare il testo.

Modifica del tipo di codice a barre

Nella finestra "Proprieta”, nella categoria "Contenuto”, & possibile selezionare un tipo di codice a
barre (vedere anche la sezione "Contenuto” nel capitolo "Finestra Proprieta").

Proprieta »
| A

o 24 | B | R

=
Orientamento 0
Bloccato Falze
Adatta dimenzioni True
b oztra testo True
Raffigurazione Campo zpecifico del doc
Tipo Code 39 |
Testo Code 2/5 Interleaved

Code 2/5 [ndustne
Code

R affigurazione
Imposta la raffigurazione degl elementi selezionati.

Nel campo "Tipo" selezionare il tipo di codice a barre desiderato.

Nel campo "Testo" & ora possibile immettere il codice in forma numerica o alfanumerica a
seconda del tipo di codice a barre.

® Per alcuni codici a barre ci sono ancora altre proprieta che possono essere scelte (per
esempio dimensioni o livello ECC per il valore di correzione degli errori).
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Modifica di un livello

Le pagine di un tipo di marcatore sono suddivise in livelli.

L'elaborazione dei singoli livelli avviene mediante la finestra "Livelli”’; vedere a questo proposito
la sezione "Finestra Proprieta".

® Per attivare o disattivare i livelli, selezionare la voce di menu Visualizza > Livelli.

® Facendo doppio clic sul nome del livello (ad es. "Livello marcatore) € possibile richiamare la
finestra "Proprieta livello" per il livello selezionato.

e ]

BIEIBIEIE]

Livello bloccata

Livello libero

Livello marcatore

Livello progetto

Livella di sfondo

Modifica del nome di un livello

Mediante la finestra di dialogo "Proprieta livello" & possibile modificare il nome del livello (vedere
il capitolo "Modifica di un livello").

® Riportare il nome desiderato nella casella "Nome livello" e confermare 'immissione con OK.

Proprieta livello

Mame livelo:

La modifica sara valida per questo file.

Livello marcatore
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Modifica dei colori di un livello

E possibile modificare i colori di un livello nella finestra "Proprieta livello”. Per visualizzare il
livello desiderato fare doppio clic sul nome del livello che si desidera modificare (vedere capitolo
"Madifica di un livello").

® Consente di modificare il colore del bordo o il colore di riempimento facendo clic sul pulsante
raffigurante un triangolo. Nel menu a discesa che appare € possibile selezionare il colore
desiderato.

Proprieta livello

Morne livello: Livello marcatare |
Colori;
Colore bordo: [ ] Standard - Colore riempimento: ID Standard ,.I
] Standard || [1rasparente
o NN
PR (NEEECEEN(]
Yisibile I Riguadro di evidenziazior
alkri
[ Imposta come predefinito ] [ (04 ] [ annulla

® Facendo clic sul pulsante Altri viene visualizzata una scelta di colori piu ampia.

Qui é possibile scegliere tra colori predefiniti 0 personalizzati.
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Esclusione di un livello dalla visualizzazione

® Se si desidera disattivare un livello in modo da non renderlo visibile, fare clic sul simbolo

degli occhi:

[

Tutti i livelli per i quali non viene visualizzato questo simbolo non sono visibili.

Lirelli b4
...... |
ol | Livella bloccato
| Livella libera
= Livella marcatore
e | Livella progetta
ol Livello di sfondo

Facendo nuovamente clic sul simbolo, il livello si rende nuovamente visibile.
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Esclusione di un livello dalla stampa

® Se non si desidera stampare un livello, fare clic sul simbolo della stampante:

=

Tutti i livelli per i quali non viene visualizzato questo simbolo non vengono stampati.

Lireeslli >

Livello bloccako
Livello libero
Livello marcatore
Livello progetto
Livella di sfanda

)| =) | m) | w) | =)

Inserimento di un livello libero

A differenza degli altri livelli, i livelli liberi possono essere duplicati.

® Nella finestra "Proprieta” fare clic sul simbolo seguente: verra inserito un nuovo livello libero.

Facendo nuovamente clic sul simbolo verra creato un ulteriore livello libero.
Cancella livello libero

® Nella finestra "Livelli" fare clic sul livello libero che si desidera cancellare. Fare clic sul
simbolo seguente:

x

E possibile cancellare tutti i livelli liberi meno uno, che dovra essere sempre
presente.
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Spostamento di un livello libero in un’altra posizione

Dopo aver creato diversi livelli liberi, & possibile spostarli uno sotto I'altro, vale a dire collocarli
uno sopra l'altro in una sequenza diversa.

Nella finestra "Livelli" sono disponibili i seguenti simboli:

4 Sposta il livello di una posizione verso l'alto.

$ Sposta il livello di una posizione verso il basso.

® FEvidenziare i livelli liberi che si desidera spostare in un’altra posizione e premere il pulsante
corrispondente.

Riduzione dei livelli liberi a uno solo

Facendo clic sul seguente simbolo, tutti i livelli liberi saranno ridotti a uno solo.

e

Non e possibile selezionare singoli livelli da ridurre. Il comando riunira sempre
tutti i livelli liberi a un solo livello.
Questa procedura non potra essere annullata!

Blocco di un livello

E possibile bloccare singoli livelli in modo che non sia possibile modificarne gli elementi. Non
sara piu nemmeno possibile effettuare modifiche di testo.

® Fare clic sul livello che si desidera bloccare.
® Nella finestra "Livelli" fare clic sulla terza colonna del livello.

Verra visualizzato il simbolo seguente.
Ora il livello & bloccato e non puo piu essere elaborato.

Facendo clic di nuovo, il blocco del livello sara disattivato.
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Sequenza di testo predefinita

Impostazione di una sequenza di testo predefinita

Per impostare una sequenza di testo procedere come segue:

® Aprire un tipo di marcatore e inserire il testo da salvare (ad es. da A 1 a A 10) in un elemento
di testo.

® Evidenziare il testo da salvare come sequenza di testo.
® Selezionare la voce di menu Strumenti > Sequenza di testo predefinita....

® Assegnare un nome descrittivo alla sequenza di testo.

Salvare il testo automatico

Mome della sequenza di testo:

A 1-10] | Aggurg |
Sequenze di testo disponibili:
Rirnuoeyi
Salva

annulla

® Fare clic su Aggiungi, quindi su Salva.

Per inserire una sequenza di testo predefinita, vedere la sezione "Inserimento di una sequenza
di testo predefinita”.
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Inserimento di una sequenza di testo predefinita

Per inserire una sequenza di testo predefinita (vedere "Impostazione di una sequenza di testo
predefinita"), procedere come segue:

® Aprire un tipo di marcatore ed evidenziare I'elemento a partire dal quale deve essere inserita
la sequenza di testo predefinita.

® Selezionare le voci di menu Inserisci > Sequenza di testo predefinita....
® Selezionare la sequenza desiderata e il numero di ripetizioni.

Sequenza di testo predefinita

Murera di sequenze di testo inserite: | 3 $| L Inserisci J

Snnull
Sequenze di testo disponibili;

® Fare clic su Inserisci.

In questo caso la sequenza di testo predefinita viene inserita tre volte:
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Numerazione automatica

Introduzione

Mediante la funzione "Numerazione automatica" & possibile dotare i tipi di marcatore di una
siglatura progressiva.

Con la funzione di autoriempimento € possibile siglare solo i campi specifici del
documento (vedere il capitolo "Finestra Proprieta™).

® Evidenziare il campo o il settore in cui deve essere effettuata la siglatura.
® Selezionare la voce di menu Inserisci > Numerazione automatica....

Viene visualizzata la finestra della numerazione automatica.

La finestra "Numerazione automatica"

1. Contatore v
Sistema Immissione oK
(®) Decimale {0-9) Valore iniziale:
annulla

(CJPLC f Ottale (0-7) Valore finale: =
(O) Esadedimale (0-F) Prefisso: I:I Guida in linea...
() Alfanumerico Suffisso; I:I Ultima seguenza
O Carattere di testo Bloceo: I:I Ripristina impostazioni standard
Opzioni Sequenza formattata
Fase: Duplica ogni valore: | 1 | | ||
Incremento a blocco: Ripeti: rErrE

Ignora marcatore: III 1 marcatore selezionato
|:| Inserisci sequenza

prima del testo esistente dopo il testo esistente 1

|:| Campi progetto
Prefisso: Contatore: 0 Suffisso:
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All'interno della finestra sono disponibili i seguenti pulsanti:

l 0K ]II pulsante OK consente di confermano le immissioni.

[ Arnulla ]II pulsante Annulla consente di annullare la procedura.

[ Guida in linea. . ]II pulsante Guida in linea consente di aprire la finestra Guida
in linea.

[ Ultima sequerza ]II pulsante Ultima sequenza consente di caricare I'ultima

sequenza di caratteri utilizzata.

[ Ripristina impostazioni standard ]II pulsante Ripristina predefinite consente di impostare
nuovamente i valori predefiniti di default.

Indicare nella parte di finestra "Sistema" il tipo di numerazione in questione.

Decimale
Decimale utilizza il sistema decimale, quindi le 10 cifre che vanno da 0 a 9, poi 10, 11, 12, ecc.

PLC/Ottale
In questo caso € possibile impostare un formato specifico di siglatura per PLC. Il tipo di siglatura
per PLC prevede di norma due contatori separati da un punto (ad es. 4.0).

Il contatore Y effettua una numerazione ottale da 0 a 7, mentre il contatore di blocco X effettua
una numerazione in conformita al valore iniziale del campo di blocco tenendo in considerazione il
passo di blocco. Nel campo Prefisso viene indicata di norma una lettera (ad es. | per Input) ed &
possibile altresi selezionare un suffisso (vedere esempio 2).

Esadecimale
Basato su di un sistema di cifre che si fonda sul sistema esadecimale e che lavora con i caratteri
da0a9,A BC,D,E,F.

Esempio: 0,1, ....9,A,B,C,D, E, F, 10, 11, ...,18, 19, 1A, 1B, 1C, 1D, 1E, 1F, 20, ... 29, 2A, ...
2F, 30, ... ecc.

Alfanumerico

In questo caso sono disponibili tre sequenze numeriche: da a a z, oppure da A a Z, oppure da 0
ao.

Esempio di numerazione: da b a m (é sempre permesso solamente 1 carattere, quindi non da
AA a Z2).

Carattere di testo
Nei campi di testo viene scritta sempre la stessa parola, ad es. "ISB". Sequenza di caratteri:
1234, oppure ABCD, oppure 1a2Bd3.
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Indicare nella parte di finestra "Immissione” i valori corrispondenti.

Valore iniziale e valore finale
La numerazione pu0 avvenire in ordine crescente o decrescente.

L’occupazione preventiva automatica dei campi Avvio e Fine risulta dal numero dei campi
selezionati.

Prefisso
Con questa funzione € possibile preporre uno o piu caratteri alfanumerici al valore di conteggio
(ad es. linea oppure L oppure 2004-).

Suffisso
Con questa funzione € possibile aggiungere uno o piu caratteri alfanumerici al valore di
conteggio (ad es. sinistra oppure X).

Blocco
In questo programma si intende per blocco un contatore supplementare inserito tra il prefisso ed
il valore iniziale.

Nella parte di finestra "Opzioni" si dovranno selezionare i seguenti punti:

Fase
Con questa funzione € possibile stabilire di quale valore il valore iniziale deve essere aumentato
o diminuito.

Esempi:

Se il valore iniziale & = 1, il valore finale = 20 e il passo = 3 si creera la seguente sequenza
numerica: 1, 4, 7, 10, 13, 16, 19

Se il valore iniziale & = 8, il valore finale = 2 e il passo = 2 si ottiene la seguente sequenza
numerica: 8, 6, 4, 2

Se il valore iniziale = A, il valore finale = K e il passo = 2 apparira la seguente sequenza di
caratteri:
A C EG, LK

Incremento a blocco
Con questa funzione & possibile stabilire di quale valore si deve incrementare il blocco, ad es.
blocco = 0 e passo di blocco = 2. Esempio: 0, 2, 4, 6...

Duplica ogni valore

Con questa funzione € possibile indicare quante volte deve essere duplicato ogni valore.
Immettendo in questo campo il valore 2, si otterra con una numerazione da 1 a 5 la seguente
sequenza di caratteri: 1, 1, 2, 2, 3, 3, 4,4, 5, 5.

Istruzioni per l'uso Istruzioni generali o 37



Ripeti
Con questa funzione € possibile indicare il numero di volte in cui si necessita della sequenza di
caratteri (il valore tra I'avvio e il termine).

Ignora marcatore
Con questa funzione € possibile indicare quanti campi da siglare devono essere saltati.

Esempio: Inizio = 1, fine = 5, campi da saltare = 3
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Inserisci sequenza
Fare clic sulla casella di selezione per attivare o disattivare questa funzione.

Se i campi che si desidera siglare contengono gia un testo, sara possibile determinare il punto in
cui il testo dovra essere inserito. Selezionare la corrispondente opzione:

Davanti al testo esistente
Dietro al testo esistente

Se questa funzione non viene selezionata, l'intero contenuto del marcatore verra sovrascritto.

Campi progetto
Fare clic sulla casella di selezione per attivare o disattivare questa funzione.

Questa funzione consente di numerare automaticamente i campi progetto. Nel campo di testo
"Contatore" si puo inserire il valore iniziale (se si cancella il campo "Contatore" non avviene
NESSUNA numerazione automatica). E possibile inoltre indicare un prefisso o un suffisso.
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Sequenza formattata
Immettere nel campo sinistro la formattazione per il contatore di blocco e in quello destro quella
per la sequenza di numerazione definita dal valore di avvio fino a quello finale.

Le seguenti formattazioni valgono per il contatore di blocco e per la sequenza di numerazione.
La formattazione del blocco sara applicata se nel campo "Blocco” & presente una voce.

#.00 La numerazione possiede due posizioni decimali. Ne risultera per la
sequenza numerica da 1 a 3 la formattazione:
1,00 poi 2,00 poi 3,00 ecc.

$#.00 Davanti al numero sara posta una costante (in questo caso il segno del
dollaro).

####.00  Formatta la sequenza numerica da 1000 a 2000: 1.000,00 poi 1.001,00
poi 1.002,00 ecc.

0% Formatta la sequenza numerica da 1 a 5 in 100%, 200%, .., 500%
(percentuale).

Anteprima
Con questa funzione viene visualizzato il primo campo contenente la siglatura.

Riconoscimento automatico delle immissioni

La funzione di autoriempimento provera a riconoscere il testo del primo campo selezionato per
occupare preventivamente in maniera funzionale la finestra "Riempimento automatico".

Se per esempio si immette in un campo di testo A4.0X, il sistema riconoscera che A ¢ il prefisso,
X il suffisso, 4. il contatore di blocco e 0 il valore iniziale.
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Campi aggiuntivi nei marcatori per morsetti

Quando si aggiunge un marcatore per morsetti MultiMark (pitched strip) appare una finestra di
dialogo estesa.

Tramite la finestra di dialogo € possibile selezionare se i marcatori debbano essere siglati in
"Manuale" o "Automatico".

In caso di siglatura automatica, viene visualizzata un'anteprima del contenuto del campo nel
riquadro inferiore della finestra di dialogo.

Modalitd I oK I
() Manuale
Annulla
1. Contatore i

Sistema Immissione R
(®) Decmale (0-9) Valore iniziale: ELiTT
(JIPLC / Ottale (0-7) Valore finale: - Ultima seguenza
(O Esadedmale (0F) Prefisso: :l Ripristina impostazioni standard
() Alfanumerico Suffisso: I:I
() Carattere di testo Blocco: I:I
Opzioni Sequenza formattata
Fase: Duplica ogni valore: | 1 | | ||
Incremento a blocco: Ripeti:

Ignora marcatore: ljl
Anteprima
Anteprima: primo, seconda, ...ultimo

1
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Primo e secondo contatore

Esistono due contatori. Con il primo contatore possono essere utilizzate tutte le funzioni. Il
secondo contatore & un sottocontatore del primo contatore.

Il passaggio al secondo contatore € possibile solo se il primo contatore € stato opportunamente

immesso.

Seleziona la casella di controllo "Attivo" per utilizzare il secondo contatore.

Esempio:

Funzicne di riempimento automatico

|| 1. Contatore v |
Sistema Immissione
() Dedmale (0-9) Valore iniziale:
(OPLC [ Ottale (0-7) Valore finale:
() Esadedmale (0F) Prefisso:

Suffisso:

() Carattere di testo Blocco:

L

‘Funzione di riempimento automatico

|2. contatore v| M
Sistema Immissione
(®) Dedmale (0-9) Valore iniziale:
(CIPLC [ Ottale (0-7) Valore finale:
(O Esadedimale (0-F) Prefisso:
() Alfanumerico Suffigso:
Carattere di testo Blocco:

L

] Illq I.'ZH LK) ,3,ﬂ|,, ,'H, IIEH ] HSH 1] I?Iq i Ialql ! Islql .110,‘1 ! I)IlH ..H%“l |.qu| Ill‘;lq ] Il'slq ! ,iﬁq Illi‘?lq .,lﬁﬂl. .||9H| ﬁﬂﬁ Ilq]lq fTks)
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Esempio 1

Si deve siglare una MultiCard nel modo seguente:

Il valore iniziale deve essere 1 e il valore finale deve essere 3. Prima del valore si dovra contare
un blocco a partire dal valore 0. Prima di ogni numerazione (blocco e valore iniziale) si dovra
inserire una P, dopodiché una S. Si dovra saltare un campo, cioé tra i campi siglati ci dovra
essere un campo libero. Ciascun campo dovra essere rappresentato due volte di seguito. Inoltre
i valori di imputazione del blocco dovranno iniziare con 0 ed essere aumentati di 2 cioe 0, 2, 4, 6.

1. Contatore -
Sistema Immissione oK
(®) Dedmale (0-9) Valore iniziale:
Annulla
(CJPLC [ Ottale (0-7) Valore finale: =
() Ezadecimale {0-F) Prefisso: Ijl Guida in linea. ..
() Alfanumerico Suffisso: LItima seguenza
O Carattere di testo Blocco: III Ripristina impostazioni standard
Opzioni Sequenza formattata
Fase: Duplica ogni valore: | 2 | | 0 " |
Incremento a blocco: Ripeti: EI s
Ignora marcatore: 1 marcatore selezionato
|:| Inserisci sequenza
prima del testo esistente dopo il testo esistente PO1S
|:| Campi progetto
Prefisso; Contatore: i Suffisso;
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Risultato:
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Esempio 2

Formato di siglatura per PLC

Si devono siglare irelé 4, 5 e 6. Ciascuno di questi relé ha cinque ingressi (=I), che devono
essere numerati da 0 a 4. La numerazione dovra iniziare con 14.0 fino a 14.4, dopodiché da 5.0 a

15.4 e infine da 16.0 a 16.4.

1. Contatore
Sistema
() Dedmale (0-9)
(@) PLC [ Ottale (0-7)
() Esadedimale (0F)
() Alfanumerico
() Carattere di testo

Opzioni

|:| Inserisd sequenza

Immissione

Valore iniziale:
Valore finale:
Prefisso:
Suffigso:

Blocoo:

Fase: Duplica ogni valore:
Incremento a blocco: Ripeti:

Ignora marcatore:

oK
Annulla
Guida in linea...

LItima seguenza

JLLL

Ripristina impostazioni standard
Sequenza formattata
o |

[y

Anteprima
1 marcatore selezionato

.

prima del testo esistente dopo il testo esistente 14.0
|:| Campi progetto
Prefisso; Contatore: i Suffisso;
Risultato:
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Numerare in avanti e numerare all'indietro

Al posto della numerazione automatica i valori di conteggio possono essere numerati in avanti e
allindietro (incrementati, decrementati) anche attraverso un‘apposita funzione.

Esistono due possibilita:

® riconoscimento automatico del valore di conteggio selezionando due campi di testo
("Riconoscimento automatico del valore di conteggio")

® proseguimento del valore di conteggio con valore standard (vedere "Proseguimento del
valore di conteggio con valore standard")

o C'é un riconoscimento modello che prende in considerazione solamente i valori
di conteggio di un testo.
Esempio: "A-10x" dopo una numerazione in avanti diventa "A-11x"

o Il segno preliminare negativo di un numero € interpretato come carattere di testo
e non viene ulteriormente considerato.

o Le funzioni Numera in avanti e Numera all'indietro riempiono sempre il
successivo campo di testo. In caso di piu campi di testo su un marcatore, questi
vengono riempiti uno dopo l'altro.

Il passo della funzione puo essere impostato attraverso le opzioni (vedere il capitolo
"Impostazioni di base").
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Riconoscimento automatico del valore di conteggio

Se sono stati selezionati due campi di testo con numeri, allora la differenza numerica tra i due
campi viene utilizzata come valore.

Procedere come segue:
® Selezionare almeno due campi di testo con valori numerici.

® Scegliere la voce menu Inserisci > Numera in avanti oppure Inserisci > Numera
all'indietro

Esempio:

Selezionare campi di testo

Numerare in avanti due volte i valori

Proseguimento del valore di conteggio con valore standard

Se l'utente ha selezionato soltanto un campo di testo con un numero, allora per la numerazione
in avanti o all'indietro viene utilizzato un valore preimpostato. Il rispettivo passo puo essere
impostato mediante la finestra di dialogo Opzioni (vedere il capitolo "Impostazioni di base").

Procedere come segue
® Selezionare un campo di testo con valore numerico.

® Scegliere la voce menu Inserisci > Numera in avanti oppure Inserisci > Numera
all'indietro.
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Codifica colori

La codifica colori consente di evidenziare cromaticamente i numeri da 0 a 9.

g
@ :
=2

3

Le impostazioni per il colore dello sfondo e del font si impostano tramite il menu Opzioni (vedere
la sezione "Codifica colori" nel capitolo "Finestra di dialogo Opzioni").

e La codifica colori pud essere applicata esclusivamente a testi di una sola riga!

e La codifica colori pud essere applicata solo a elementi completi (non a sezioni di
testo).

e Le impostazioni della codifica colori vengono salvate nel file di progetto (ad es.
*.mpc).
Cio consente di creare file diversi con codifiche colori differenti.

Se le codifiche colori impostate nel programma sono diverse da quelle impostate per il progetto,
viene visualizzato un messaggio di avviso:

M-Print® PRO X

Le impoztazioni delle cifre di codifiza colan fel progetto non cormigpondono ai valar ztandard.
Desiderate utilizzare i valon standard nel progetta’?

s || Mo

® Scegliere Si per accettare la codifica colori impostata nel programma.
® Scegliere No per mantenere i valori impostati nel progetto.
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Sincronizzazione del contenuto

E possibile associare agli elementi di testo altri elementi di testo (cosiddette fonti di dati).

A guesto scopo procedere come segue:

® Fare clic sull'elemento di testo a cui si desidera associare una fonte di dati (ad es. CAMPO
DI TESTO 2).

® Aprire la finestra di dialogo delle proprieta (vedere il capitolo "Finestra Proprieta")

® Nel campo Fonte di dati immettere il nome di campo della fonte di dati (ad es. CAMPO DI
TESTO 1).

® Selezionare la voce di menu Modifica > Sincronizza contenuti.

| contenuti del CAMPO DI TESTO 1 verranno trasferiti al CAMPO DI TESTO 2.
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Ordine, ordine guidato

Mediante I'assistente all'ordinazione & possibile ordinare via e-mail vari tipi di marcatore dal
progetto attualmente aperto.

Ordine guidato

Awvio del programma | Indirizzo | Elenco ordini | Infarmazione aggiuntiva | Opzioni posta
() Richiesta d'offerta ) ordine
Posi,.. M. dordine sta,.. M. dordine ska...  Prodotto Cont...  CQuanki...  Titolo del tipo di marcatore
Copia Aggiungi posizione. .. Elimina posizione Eliminare tutte le posizioni
Salva come predefinito Catica predefinito [ Invia ] [ Annulla ] [ Salva ] [ Starmpa

(X

Richiamare I'ordine guidato mediante il menu Strumenti > Ordine....

® Selezionare la voce di menu Strumenti > Ordine...
® Eseguire le necessarie impostazioni nelle relative schede
Salva come predefinito

Le impostazioni della scheda attiva vengono salvate come predefinite.

Durante I'ordinazione occorre specificare un indirizzo di consegna interno al
paese da cui viene spedito 'ordine.
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Funzioni di filtro

Filtro nel campo

Il filtro consente di visualizzare gli elementi dopo aver applicato un determinato testo di filtro.
Selezionare nel menu Visualizza > Filtro > Filtro... per richiamare la finestra di dialogo dei filtri.

Esempio:
Prima del filtro:

Impostazione

del filtro:
Itilizzare la presente finestra di dialogo per limitare la visualizzazione
dei cartellini di modo che essi corrispondano alle impostazioni di Filkra,
Condition
Filtro nel campo: Tukti i carmpi di kesto w
() Inizia con (%) Contiene
Testo di Filkro: 1]
Frmuoe [ Applica ]
Risultato:
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Filtro di overflow

La voce di menu Visualizza > Filtro > Filtro di overflow consente di filtrare i campi
visualizzando solo quelli con testo eccedente. Questi campi sono raffigurati con triangoli rossi.

Il filtro di overflow pud essere richiamato tramite la voce di menu Formato > Adatta dimensioni
font... (vedere capitolo "Istruzioni generali", sezione "Adatta dimensioni font").

In essi € possibile diminuire o accorciare le dimensioni dei caratteri.

6 Il filtro di overflow non puo essere applicato alle strisce a modulo continuo né ai
tubi flessibili a contrazione continui. Puod essere invece utilizzata I'opzione
"Adatta lunghezza marcatore" (vedere capitolo "Istruzioni generali", sezione
"Adatta lunghezza marcatore").

Rimuovi filtro

Tramite la voce di menu Visualizza> Filtro > Rimuovere il filtro pud essere risolta una
rappresentazione filtrata (ad es. Filtro di overflow).
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Acquisizione della licenza

La procedura di acquisizione della licenza consente di ottenere un utilizzo illimitato del
programma in conformita alla chiave software in proprio possesso.

Per acquisire la licenza richiamare il menu Guida > Chiave di licenza....

Selezionare la chiave di licenza in proprio possesso e seguire le istruzioni.

Codice di licenza M-Print PRO

M-Prink FRO Py, 3.3, 2. &

L]

Weidmueller consente Futilizza illimitata dellT™-Print PRO per 30 giorni a partire dalla data di installazione,
Enkra il kermine suddetto sard necessario effettuare ['attivazione del prodotta,

Per attivare il prodotto, inserire la chiave software {contenuta su C0-ROM o presso il distributore del software)
nel campo seguente e cliccare su Akkiva,

Se il tuo computer non & collegato a Internet, clicca su "Atkiva® & segui le
istruzioni che appaiono nella fineskra,

Chiave software: Aktiva,.,

Dopo aver ricevuka la mail di aktivazione, inserire la chiave della licenza nel campo sequente e cliccare su Ok,

EEESEESEE LS EE LSS SRS

Mumero di serie: |

Copyright () 2005 Weidmdiller Interface GmbH & Co. KG
kKlingenbergstraffe 16, D-327558 Detmold
Tukki i diritki riserwvati.

I ok ] [ annulla
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Inserimento multiplo

E possibile inserire i campi di testo, di codice a barre e di immagine piu volte dagli appunti.

Inserimento multiplo

Mumera di ripetizioni: | g $| [ Ik l

annulla
1,2,3,..,1,2,3,...

O 1,1,2,2,3,3, 0000

Per inserire piu volte richiamare la voce menu Modifica > Inserimento multiplo....

Inserisci interruzione di riga

Questa funzione consente di inserire in un secondo momento delle interruzioni di riga nei
contenuti dei campi di testo.

A tale scopo selezionare le voci di menu Modifica > Inserisci interruzione di riga....

Inserisci interruzione di riga

(%) Mella posizione del caratter III

{:} In base a sottostringa;

Soktostringa: |
Opziani
Posizione interruzione '@' prima
) dopo
Inserisci in: () Tipo di marcatore attuale

() Tutki i tipi di marcakare

Insetisci ] [ Chiudi
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Modifica Excel

Il contenuto di campi di testo esistenti pud essere modificato anche in Excel.
Selezionare le voci di menu Modifica > Avvia modifica Excel.

E possibile ora modificare in Excel i contenuti e tutte le formattazioni supportate.

Per applicare i contenuti, chiudere Excel oppure selezionare nel programma le voci di menu
Modifica > Chiudi modifica Excel.

Per rendere disponibili campi aggiunti a posteriori (testo, codice a barre) per
I'ulteriore lavorazione sul materiale continuo, occorre impostare la proprieta
"Ordine di riempimento" nelle proprieta del campo (vedere capitolo "Interfaccia
di programma”, sezione "Dimensioni e posizione").
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Morsetti multipiano
Mediante questa funzione & possibile ordinare nuovamente i dati selezionati in base a un passo
predefinito.
A tale scopo selezionare la voce menu Modifica > Morsetto multipiano.

Se non risulta selezionato alcun marcatore, il nuovo ordinamento sara applicato a tutti i

marcatori.

Esempio:

Valori predefiniti: | Selezione del morsetto Selezione del morsetto
multipiano 2 = morsetto a due multipiano 3 = morsetto a tre
piani conduttori
Ordinamento: 1,3,5,7,9 Ordinamento: 1,4,7,10
in secondo piano: 2,4,6,8, in secondo piano: 2,5,8

in secondo piano: 3,6,9
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Scale

Scale e scale arrotondate possono essere inserite come nuovi elementi (vedere il capitolo
"Inserire una scala").

Valore iniziale e finale stabiliscono l'intervallo di valori della scala. Le distanze dei trattini della
scala (distanza grande / piccola) si riferiscono sempre all'intervallo di valori.

Proprieta della scala

Le scale sono contrassegnate dalle seguenti proprieta:

1 Punto zero della scala (punto zero della scala a sinistra, punto zero della scala in
alto)

2 Lunghezza scala
3 Altezza scala
L'altezza della scala corrisponde all'altezza dei trattini grandi della scala.
4  Valore iniziale (il valore iniziale e il valore finale stabiliscono l'intervallo di valori
della scala)
Valore finale
Trattino scala grande
Trattino piccolo della scala
Distanza trattino grande della scala (Distanza grande)
Distanza piccolo trattino grande della scala (Distanza piccola)
10 Distanza della dicitura

© 00 N O O
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1 Punto zero della scala (centro della scala a sinistra, centro della scala in alto)

2 Angolo iniziale (vedere anche il capitolo "Scala arrotondata")

3 Angolo finale

4  Altezza scala
L'altezza della scala corrisponde all'altezza dei trattini grandi della scala.

5 Valore iniziale (il valore iniziale e il valore finale stabiliscono l'intervallo di valori
della scala)

6 Valore finale

7 Trattino scala grande

8 Trattino piccolo della scala

9 Distanza trattino grande della scala (Distanza grande)

10 Distanza piccolo trattino grande della scala (Distanza piccola)
11 Distanza della dicitura

Un'ulteriore spiegazione delle proprieta & presente nella sezione "Inserire una scala".
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Scala arrotondata

Una scala arrotondata ha un arco di cerchio come linea di base.
La scala viene disposta lungo I'arco di cerchio in senso orario. Il punto zero si trova in alto.

0
315 45

270 90

225 135
180

La dicitura tangenziale fa si che le diciture tangenziali vengano disposte tangenzialmente alla
linea di base (vedere "Esempio 1" nella sezione "Esempi di scale").

58 e Istruzioni generali Istruzioni per l'uso



Punti d'appoggio

L'andamento dei valori di una scala puo inoltre essere definito da punti.
Un punto indica la posizione esatta di un valore sulla scala.
Tra i punti I'andamento dei valori € lineare.

Stitzstellen der Skala

01. Abstand (mm) 10
01, Wert 4000000

Ok ] [ Abbrechen

Aggiungi punti
Aggiunge un nuovo punto nella finestra.

& Elimina punto
Elimina un punto selezionato.
Distanza La distanza del punto dall'inizio della scala.
Valore Valore della dicitura del punto. Se il valore della dicitura viene

visualizzato, dipende dalla distanza scelta della dicitura della scala.

In caso di scala diritta il valore dovrebbe trovarsi nel campo visibile
dell'elemento e in caso di scala arrotondata tra angolo iniziale e angolo
finale.
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Esempio:

La scala superiore non contiene nessun punto.
Nella scala inferiore alla distanza di 10 mm & stato stabilito un punto con valore = 4.

Alla distanza scelta di 2 il punto viene anche dotato di dicitura. L'intervallo prima e dopo il punto
e suddiviso linearmente.

60 e Istruzioni generali Istruzioni per l'uso



Esempi di scale

Esempio 1:

La figura mostra una scala circolare con le seguenti proprieta:

Raggio scala

Angolo iniziale

Angolo finale

Centro della scala a sinistra
Centro della scala in alto
Altezza scala
Allineamento della dicitura
Valore iniziale

Valore finale

Distribuzione dei valori
Trattino scala grande
Trattino piccolo della scala
Distanza della dicitura
Dimensione carattere

\
P

5mm

225 (oppure -135)
135

10 mm

10 mm

0,8 mm
tangenziale
0

100

lineare

10

2

20

3
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Esempio 2:

1+ 0 20 40 60 80 100
oo b

La figura seguente mostra una scala con andamento lineare dei valori e le seguenti proprieta:

Lunghezza scala 20 mm
Punto zero della scala a sinistra 2mm
Punto zero della scala in alto 5mm
Altezza scala 1,5mm
Valore iniziale 0
Valore finale 100
Distribuzione dei valori lineare
Trattino scala grande 10
Trattino piccolo della scala 2
Distanza della dicitura 20
Dimensione carattere 4
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Esempio 3:

La figura seguente mostra una scala con andamento logaritmico dei valori e le seguenti

proprieta:

Lunghezza scala 20 mm

Punto zero della scala a sinistra 2mm

Punto zero della scala in alto 5mm

Altezza scala 1,5 mm

Valore iniziale 2

Valore finale 100
Distribuzione dei valori logaritmico
Trattino scala grande automaticamente
Trattino piccolo della scala automaticamente
Distanza della dicitura automaticamente
Base della scala logaritmica 2

Dimensione carattere 3
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Strisce a modulo continuo

Le strisce a modulo continuo sono materiale su bobina, ovvero materiale a modulo continuo, che
puo essere stampato.

Rispetto agli altri tipi di marcatori, qui € I'utente che stabilisce come deve apparire il layout.

Per inserire una striscia a modulo continuo selezionate il corrispondente marcatore dal catalogo

prodotti.
A seconda del marcatore aperto si apre una finestra di dialogo di base o una finestra di dialogo
ampliata.
Modifica tubo flessibile a contrazione in strisce continue >

Lunghezza marcatore Siglatura lato posteriore

(®) Lunghezza dinamica marcatore (®) Nessuno

{(_JLunghezza fissa marcatore Come il lato anteriore (THM MultiMark Twin)

Litilizza modello Diverso dal lato anteriore (THM MultiMark Twin)

Inserisc marcatore

Mumero di elementi:
Lunghezza minima per elemento; mm
10

Lunghezza totale degli element: M

Posizione incollaggio
Prima del marcatore selezionato
Dopo marcatore selezionato

(®) Dopo 'ultimo marcatore
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Inserisci marcatore su striscia continua

Dimensioni del marcatore

Incolla su striscia n.:

Mumero di elementi:

Lunghezza per elemento;

Dicitura
Mumero delle righe:
Riga 1:
Riga 2:
Riga 3:
Riga 4:
Modella

Utilizza modello

Posizione incollagaio

Prima del marcatore selezionato

Lunghezza marcatore

mirm Lunghezza marcatore:

Righe dicitura di uguale altezza

) Lunghezza dinamica marcatore
(®) Lunghezza fissa marcatore

[[] stesso layout per tutte le strisce

0 ram

Altezza Tipo di dicitura
15 | mm Elemento di testo ~
0 15 | mnn
0 15 | mm
a 15 | mm

Dopo marcatore selezionato

(®) Dopo l'ultimo marcatore
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A seconda del marcatore € possibile visualizzare le seguenti sezioni:

Incolla su striscia n:

Numero della striscia a modulo continuo su cui viene creato il marcatore (vedere capitolo
"Istruzioni generali", sezione "Materiale continuo con diverse strisce").

Nelle etichette a modulo continue con una sola striscia, il campo non ¢ disponibile.

Numero di elementi / lunghezza di ogni elemento
Il numero di elementi moltiplicato per la lunghezza di ogni elemento determina la
lunghezza totale degli elementi.

Piastrina terminale
Distanza presa in considerazione per una piastra terminale alla fine di uno o piu
morsetti.

Lunghezza marcatore

In caso di una lunghezza dinamica del marcatore il marcatore viene generato con i
valori selezionati. Una volta eseguito il iempimento con testo (tastiera, importazione,
ecc.), la lunghezza del marcatore si adatta (si riduce/aumenta) dinamicamente al
contenuto del campo.

In caso di una lunghezza fissa del marcatore, il marcatore viene generato con i valori
selezionati.

La lunghezza del marcatore € costituita dalla lunghezza totale degli elementi pit quella
della piastrina terminale.

Nota: Non & possibile modificare a posteriori il marcatore in relazione a questa
opzione. La lunghezza del marcatore puo tuttavia essere adattata a posteriori (vedere
capitolo "Istruzioni generali", sezione "Adatta lunghezza marcatore").

Stesso layout per tutte le strisce
Nelle etichette a modulo continuo con piu strisce, tutte le strisce avranno il layout
selezionato. Vedere il capitolo "Materiale continuo con diverse strisce".

Siglatura lato posteriore
Selezione per stampa sul retro.

Nota: Non & possibile modificare a posteriori il marcatore in relazione a questa
opzione.

Nota: Alcune opzioni sono selezionabili solo in presenza di determinate condizioni!

Numero di righe di dicitura

Numero di righe di dicitura per ogni marcatore

In genere si utilizzano 1 - 3 righe perche l'altezza della striscia € limitata. L'altezza
totale di tutte le righe non deve essere maggiore dell'altezza della striscia.

Righe dicitura di uguale altezza
Le altezze delle righe della dicitura vengono calcolate automaticamente.

Riga ...
Riga della dicitura sul marcatore

Campi
Numero di campi (per esempio campi di testo) da visualizzare nella riga.
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Altezza
L'altezza della riga.
L'altezza totale di tutte le righe non deve essere maggiore dell'altezza della striscia.

Tipo di dicitura
e possibile scegliere tra:

Elemento di testo: la riga € costituita da elementi di testo che possono essere
dotati di dicitura.
Elemento di collegamento Elemento di collegamento grafico

Posizione incollaggio
Nuovi marcatori aggiunti possono essere integrati alla fine della striscia, o prima o
dopo la posizione corrente.

Incolla
Inserisce le impostazioni scelte come marcatore. Fino a che non si chiude la finestra di
dialogo, si possono aggiungere altri marcatori.

Elemento di collegamento
Sono presenti i seguenti elementi di collegamento grafico che possono essere modificati tramite
la finestra delle proprieta:

T_ Tipo: Inizio
- Tipo: Giunzione
_T_ Tipo: Giunzionea T

_T Tipo: Fine

Materiale continuo con diversi campi di testo

Per rendere disponibili campi aggiunti a posteriori (testo, codice a barre) per l'ulteriore
lavorazione sul materiale continuo, occorre impostare la proprieta "Ordine di riempimento” nelle
proprieta del campo (vedere capitolo "Interfaccia di programma”, sezione "Comportamento").

Utilizza modello

Un modello dal catalogo prodotti pud essere aggiunto a un materiale infinito gia creato tramite la
casella di controllo “Utilizza modello®, se corrisponde al layout esistente.

Per mostrare la finestra di dialogo selezionare la voce del menu Inserisci > Marcatore.

Dopo aver aggiunto un altro modello, tutti gli elementi vengono trasformati in
campi singoli per motivi tecnici. L'importazione o l'incollaggio di dati copiati non &
pit possibile.
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Materiale continuo con diverse strisce

In caso di materiale continuo avente una pluralita di strisce, gli elementi su ciascuna striscia possono essere
creati e siglati indipendentemente dalle altre strisce.

Vi sono diverse possibilita:

e Solo la prima striscia viene siglata
e Piu di una striscia viene siglata
e Piu di una striscia viene siglata. Tutte le strisce hanno lo stesso layout

Solo la prima striscia viene siglata
Se viene siglata solo la prima striscia, tutte le altre etichette - come copia - vengono stampate con lo stesso
contenuto.

11 I1Iu| [} I2|U| 11 IBIU| 11 I10| 11 I$IU| |

EII:II 11 |5IUI [ |4PI [ |3PI | 1 |2IDI | 1 |1||:|l 11
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Piu di una striscia viene siglata

Se viene siglata piu di una striscia, tutte le strisce vengono stampate come indicato nel campo di lavoro.

11 I1Iu| 11 I2|U| 11 I3IU| 11 I4in| 11 I$IU| |

EII:II [ |5IDI 11 |4PI 11 |3PI | 1 |2||:|| | | |1IDl 11

Tutte le strisce hanno lo stesso layout

11 I1Iu| 11 I2|U| 11 IBIU| 11 Iﬂn| 11 I$IU| |

E.'I:I.I 1) .IE.II:I.l 1! .I4PI 11 |3PI | 1 |2||:|| | | |1IDl 11
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Esempi di striscia a modulo continuo

Nell'esempio in una striscia a modulo continuo vengono inserite tre diverse impostazioni di
marcatore.

Impostazione 1:

Inserisci marcatore su striscia continua >
Dimensioni del marcatore Lunghezza marcatore
Incolla su striscia n.: () Lunghezza dinamica marcatore
Murnero di elementi: (® Lunghezza fissa marcatore:
Lunghezza per elemento: | &0 mm [ stesso layout per tutte le strisce
[ piastra terminale m mm Lunghezza marcatore: &0 mm
Dicitura
Numero delle righe: [ Righe dicitura di uguale altezza
Campi Altezza Tipo di dicitura
Riga 1: | 1| 60|n'rn |Elementnr.ih$ln v|

Riga 2: 0 60 | mm | w |
Riga 3: 0 60 | mm | w |
Riga 4 0 60 | mm | w |

Modello
Utilizza modello EI
Posizione incollaggio
(I Prima del marcatore selezionato () Dopo marcatore selezionato (®) Dopo 'ultimo marcatore
o] o
Risultato 1:
4 STRIP1/60mm | box

I I I I I I I I I I I I I I I I e i e

T N N T A A A

LR
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Impostazione 2:

Inserisci marcatore su striscia continua *
Dimensioni del marcatore Lunghezza marcatore
Incolla su striscia n.: () Lunghezza dinamica marcatore
Mumero di elementi: (®) Lunghezza fissa marcatore
Lunghezza per elemento: mm [] 5tesso layout per tutte le strisce
[Jriastra terminale mm Lunghezza marcatore: 60 mm
Dicitura
Mumero delle righe: [ righe dicitura di uguale altezza
Campi Altezza Tipo di dicitura
Riga 1: | 2| 30 | mm Elemento di testo
Riga 2: | g | 30 |rrr|'| |

Riga 3: 0 30 | mm |
Riga 4: 0 30 | mm |

Madello
Utilizza modello EI
Posizione incollaggio
(I Prima del marcatore selezionato () Dopo marcatore selezionato (®) Dopo 'ultimo marcatore

Risultato 2:

s

STRIP1/60mm | [

e I T T O T T T e e W M W M Y < I M 2 e W W e A e W

T T e S T T T
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Impostazione 3:

Inserisci marcatore su striscia continua x

Dimensioni del marcatore Lunghezza marcatore

Incolla su strisda n.: (O Lunghezza dinamica marcatore

Mumero di elementi: (®) Lunghezza fissa marcatore

Lunghezza per elemento: mm [ 5tesso layout per tutte le strisce

[Jriastra terminale mm Lunghezza marcatore: 30 mm
Dicitura
Mumero delle righe: [Jrighe dicitura di uguale altezza
Altezza Tipo di dicitura
Riga 1: | lUlmm |Elerner1todtesto Vl
Riga 2: | 25 | mm Elemento di testo
Riga 3: | 25 | mm |
Riga 4: 4] 5 | mm |
Modello
Utilizza modello El
Posizione incollaggio
() Prima del marcatore selezionato () Dopo marcatore selezionato (®) Dopo ['ultimo marcatore
e ] [ owa
Risultato 3:
q STRIP1/60mm | (33

e I I I I R I

T T T P T
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Protezione del documento

Mediante la protezione dei documenti € possibile proteggere il layout di un file di programma
dalle modifiche.
In tal modo, come nel caso di un modulo, € possibile intervenire solo sui contenuti.

Si prega di tenere presente le seguenti caratteristiche della protezione dei documenti:

® vale per tutti gli elementi per i quali € impostata la caratteristica "Bloccato” (vedere capitolo
"Interfaccia del programma”, sezione "Comportamento")

® protegge tra le altre le caratteristiche "Bloccato”, "Stampabile" e "Con protezione da
scrittura”

® impedisce la cancellazione, lo spostamento e I'aggiunta di elementi

Impostazioni protezione del documento

Agendo sulla voce di menu "Strumenti -> Impostazioni protezione del documento..." &
possibile tra I'altro prevedere le seguenti impostazioni:

Impaostazioni protezione documento ]&

Password attuale:

@) Imposta protezione documento

Immetti password: |
Conferma password:

Visualizza password

Rimuowi protezione documento

Ok ] | annulla

Password attuale:
La password attuale deve essere immessa in caso di modifica della password stessa o
di rimozione della protezione del documento.

Impostare la protezione del documento
Fissare una nuova password per la protezione del documento.
La password precedente sara sovrascritta.

Rimuovi la protezione del documento
Annulla una protezione del documento presente in precedenza. E necessario
immettere la password attuale.
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Attivare la protezione del documento

Per attivare la protezione del documento procedere come segue;

® Creare un file di progetto e impostare la proprieta "Bloccato" per tutti i campi da proteggere
su "Si" (vedere capitolo "Interfaccia del programma”, sezione "Comportamento™).

® Selezionare la voce di menu Strumenti > Impostazioni protezione del documento... 0

A

L

fare clic sul simbolo

® Se non € ancora stata assegnata alcuna password, si aprira la finestra di dialogo di
impostazione per la protezione del documento

Impaostazioni protezione documento ]ﬁ

Password attuale:

@ Imposta protezione documenta

Immett password: |
Conferma password:

Visualizza password

Rimuowi protezione documento

oK ] | Annulla

® Digitare una nuova password e fare clic su OK.
Ora la protezione del documento € attivata.

L'avvenuta attivazione della protezione del documento viene visualizzata

&

L5

® nella barra dei simboli con il simbolo attivato

® dopo il numero della versione (vedere capitolo "Interfaccia del programma').

Disattivare la protezione del documento

Per disattivare la protezione del documento procedere come segue:
® Aprire un file di progetto protetto.
® Selezionare la voce di menu Strumenti > Impostazioni protezione del documento... 0

&

L5

fare clic sul simbolo

® Sjapre una finestra di dialogo per la richiesta della password.

Successivamente all'immissione della password, la protezione del documento € disattivata fino
alla chiusura del fine di progetto.
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Rimuovi la protezione del documento

Per rimuovere la protezione del documento procedere come segue:

® Aprire un file di progetto protetto.

® Selezionare la voce di menu Strumenti > Impostazioni protezione del documento... 0

&

L5

fare clic sul simbolo

® Sj aprira la finestra di dialogo delle impostazioni relative alla protezione del documento

Impaostazioni protezione documento ]ﬁ

Password attuale:

(@ Imposta protezione documento

Immetti password: |
Conferma password:

[ visualizza password

~) Rimuovi protezione documento

OK ] [ Annulla

® Digitare la password attuale, selezionare "Rimuovi protezione del documento" e fare clic su
OK.

Ora la protezione del documento € rimossa.
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Adatta dimensioni font

a1i6 | |Se, dopo linserimento del testo, i campi di testo presentano un triangolo
A5 _w- . r0ssO0, cio significa che il testo non rientra nello spazio previsto dal campo.
In questo caso il testo non verra né visualizzato né stampato
completamente.

Viene adattata automaticamente la grandezza dei caratteri dei campi di testo con eccedenza.

Il filtro di overflow puo essere richiamato tramite la voce di menu Formato > Adatta dimensioni
font... oppure automaticamente ad opera del programma dopo un'importazione o prima di una
stampa.

La finestra di dialogo viene visualizzata solo se sono presenti campi di testo dotati di overflow.

Adatta dimension font ﬁ

Alcuni campi sono dotati di text overflow.,
Annulla
Filtro di averflow

_ Adatta dimensioni font in tutt | campi

@ Modifica dimensioni font solo nei campi con overflow

Applicare il filtro di overflow
Vengono visualizzati solo i campi di testo con text overflow (vedere capitolo "Istruzioni generali”,
sezione "Filtro di overflow" e sezione "Rimuovi filtro").

Il filtro di overflow non pud essere applicato alle strisce a modulo continuo né ai tubi flessibili a
contrazione continui.
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Adatta lunghezza marcatore

La finestra di dialogo per I'adattamento della lunghezza del marcatore pud essere richiamata
tramite la voce di menu Formato > Adatta lunghezza marcatore....

Questa opzione permette di ingrandire
- dinamicamente i marcatori affinché i contenuti siano visualizzati su una riga
- dinamicamente i marcatori in modo tale da sfruttare la larghezza di campo in modo ottimale.

Adatta lunghezza marcatore e S
Lunghezza campa minima: 10 mm
Lunghezza massima del mm

Ridurre la larghezza del campo

POk I Annulla

Lunghezza marcatore minima

Lunghezza minima su cui viene ingrandito il marcatore (anche se il campo di testo contiene
meno caratteri).

In combinazione con "Ridurre la larghezza del marcatore”, vengono ridotti i campi troppo ampi.

Se il contenuto del campo e "0" o vuoto, viene ignorato.

Lunghezza marcatore massima
Lunghezza minima a cui viene ingrandito il marcatore.

Se il contenuto del campo é "0" o vuoto, viene ignorato.

Ridurre lalunghezza del marcatore

Riduce automaticamente i marcatori che sono piu lunghi del relativo testo (su una sola linea).
Dopodiché il testo riempie completamente il campo. Il marcatore non diviene tuttavia piu piccolo
della lunghezza minima del campo.

La lunghezza del marcatore pud essere adattata solo in presenza di strisce a
modulo continuo e tubi flessibili a contrazione continui.
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Adatta stringhe

Er234565 Se, dopo l'inserimento del testo, i campi di testo presentano un triangolo
L 788 | |rosso, il testo non sara visualizzato su una sola riga, ma su piu righe, non
essendo piu sufficiente il campo di testo.

Sussistono le seguenti possibilita di adattamento:

- Adatta lunghezza marcatore.
Vedere capitolo "Istruzioni generali", sezione "Adatta lunghezza marcatore".

- Adatta stringhe.

La finestra di dialogo per I'adattamento automatico delle stringhe pud essere richiamata tramite
la voce di menu Formato > Adatta stringhe....

Questa opzione consente di ridurre la spaziatura nelle stringhe selezionate
- dinamicamente affinché i contenuti siano visualizzati su una riga

Adatta stringhe lﬁ

Riduci la spaziatura caratteri
(7 Riduci la spaziatura di tutte le stringhe

(@) Riduci la spaziatura solo nei campi con overflow

e

Una spaziatura caratteri adattata pud essere ripristinata tramite la finestra di dialogo “Adatta tipo
di carattere”. Vedere capitolo "Istruzioni generali", sezione "Adatta tipo di carattere".
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Adatta tipo di carattere

La finestra di dialogo per I'adattamento del tipo di carattere pud essere richiamata tramite la voce
di menu Formato > Tipo carattere....

Tipo di carattere X
Tipo di carattere Stile carattere Dimensioni: I oK |
Arial 10
ABBvoice Medium S 2 " Annulla
Agency FB 3
Algerian i F
Arabic Transparent Grassetto Corsive| |5
S e v
Effetti
Colore font: K
[ sottolineato [ Barrare
[ Apice -~
Offzet: a | %
[(pedice
Alineamento
O orizzontale [ verticale [ orientamento
|:| Spaziatura caratteri |:| Interlinea
00 2 Reset w0 S Reset
Anteprima
o
ms =
-
<3

Pedice / Apice
La spaziatura caratteri in apice o pedice pud essere inoltre modificata tramite il campo

“Spaziatura”.

Spaziatura caratteri
Possibilita di impostazione della spaziatura caratteri per i testi selezionati.

La spaziatura caratteri puo essere modificata anche con le seguenti opzioni:

- Aumenta / riduci spaziatura caratteri
Vedere il capitolo “Interfaccia del programma”, sezione “Formatta testo®.

- Adatta stringhe.
Vedere capitolo "Istruzioni generali", sezione "Adatta stringhe".

Tramite il pulsante “Ripristina“ tutti i testi selezionati vengono impostati a una spaziatura caratteri
del 100%.
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Altezza riga
Possibilita di impostazione dell’altezza riga per i campi di testo selezionati.
L’altezza riga puo essere modificata anche con le seguenti opzioni:
- Aumenta / riduci altezza righe
Vedere il capitolo “Interfaccia del programma”, sezione “Formatta testo®.

Tramite il pulsante “Ripristina“ tutti i campi di testo selezionati vengono impostati a un'altezza
riga del 100%.
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Riempimento campo di testo

Riproduce le righe presenti in un campo di testo fintantoché il campo di testo non sara riempito
senza overflow.

Riempimento manuale

La funzione pud essere richiamata tramite la seguente voce di menu: Incolla > Riempimento
campo di testo.

Vengono riempiti solo i campi di testo selezionati.

Esempio:

Riempimento automatico

Il iempimento automatico del campo puo essere impostato tramite la proprieta "Riempi campo di
testo". Vedere il capitolo ,Personalizzazione delle proprieta“.

Il campo di testo viene popolato automaticamente dopo varie azioni.

Esempio:

- dopo un'importazione

- dopo la copia/sostituzione
- ecc.
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Editor file di riferimento

File mpr

| file di riferimento (*.mpr) vengono utilizzati per I'importazione con il filtro vk. Vedere il capitolo

,Jmportazione VK“.

Aprire I'editor file riferimento mediante il menu Strumenti > Editor file riferimento.

E vk-reference -- Editor file di riferimento — O *
File Modifica Visualizza Finestra Guida
DEE 6@ QA d @k
Editor file di riferimento
PI"'tOp"iEté Alias Mumero materiale MNome della variante -
t
re.a o - 0001 | DEK 1609801044 DEK 5/5 MC ME'WS
Ultima medifica
Versione o002 | CC 1131920000 CC13/17 K MC ME GE
0003 | SM 12486710000 SM 18/9.5 K MC ME GR
oo | TEMP Typelabel,mpt v
£ >

E possibile aprire e modificare i file di riferimento (*.mpr) o creare nuovi file.

Alias

L'alias ¢ il riferimento utilizzato per assegnare il materiale durante l'importazione. Vedere il

capitolo ,Colonna di riferimento®.

Gk

Il carattere
numero di caratteri.

pud essere utilizzato come segnaposto per nessun carattere o per qualsiasi

Esempio: Con "DEK*“ vengono rilevate tutte le occorrenze di DEK nella colonna di riferimento.

Numero materiale / Nome variante
| dati possono essere inseriti manualmente o selezionati dal catalogo prodotti.

Fare doppio clic sul rispettivo campo per aprire il catalogo prodotti. Vedere il capitolo ,Catalogo

prodotti‘.

o

Quando si selezionano i modelli (*.mpt), vengono salvati solo i nomi dei file,
non i numeri di materiale.
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File Ipr

| file di riferimento (*.Ipr) vengono utilizzati per importare le proprieta avanzate dei marcatori per

'LPC-Tool. Vedere il capitolo “Imposta proprieta avanzate marcatori: LPC*.

LPC-Tool consente i seguenti campi di informazione:
e Informazioni
e Prodotto

e Riferimento da 1 ariferimento 6

Aprire I'editor file riferimento mediante il menu Strumenti > Editor file riferimento.

Pr
=]

i File Modifica
NS H ¥R Qldep

Editor file di riferimento

oprieta

Creator
Ultirma madifica
Versicne

Informazieni
Prodotto:

Riferimente 1
Riferimente 2
Riferimente 3
Riferimente 4
Riferimento 3
Riferimento &

E Ipc-tool-reference-file.lpr

Visualizza Finestra Guida

o X

ISB
2025-09-02 12:43:04
1

Ipr: Info
Ipr: Product
Ipr: Category

Ipr: Manufacturer
Ipr: Picture

4173-reference-filelpr =

- O x

Infarmazieni - lpr: Info | Prodotte: - lpr Product

Riferimento 5 - lpr: Picture

TS 35X15/2.3 2M/...
T53547.5/5X18 2.,
PRO TOP1 120W ...
5C5 24VDC P1SIL..
CD-BO 100X120 ...
CD-HF 75X75 5/7...
VPU ACIIT R 75/ ..
TFIP 24-240VUC ..,
3RT2017-1BB41

3RV2011-1JAT0

0270100000
1879090000
2466870000
2300930000
2589500000
2389830000
2391620000
2898330000
3RT2017-1BB41
3RV2011-1JAT0

0270100,jpg
0514500,jpg
2466870,jpg
2500080.pg
2500980,jpg
2589720.jpg
2591620,jpg
2892330,pg
3IRT2017.jpg
3RV2011.jpg

E possibile aprire e modificare i file di riferimento (*.Ipr) o creare nuovi file.

Pr

odotto

La colonna "Prodotto" & il riferimento utilizzato durante l'importazione per eseguire
l'assegnazione alle righe di importazione. Vedere il capitolo “Imposta proprieta avanzate
marcatori: LPC*.

Diciture campi
Tramite le diciture campi nella finestra delle proprieta € possibile inserire un alias per le
intestazioni delle colonne.

Questo alias viene visualizzato nei seguenti punti:

e Importazione dati guidata
Vedere il capitolo “Imposta proprieta avanzate marcatori: LPC*.

Istruzioni per l'us
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Imposta proprieta avanzate marcatori X

Selezionare le colonne con le proprietd avanzate.

Proprieta avanzate marcatori

Stabilire |a fonte di dati per i campi.

Utilizza file di riferimento: | wuch-4173eference-fieJpr @ |
Proprieta: *  Colonna:
Informazioni - lpr: Info: |Infcrmaaone -lpr: Info ~ |

Prodotto **) -lpr: Product:

Informazione - |
Prodotto - lpr: Product
Riferimento 1 - lpr: Category

A

Riferimento 1 - Ipr: Category:

Rifermento 2 O Riimento
Riferimento 3: O g:fg:z:m gi :E: :inL:f:Ether
Riferimento 4 - lpr: Manufacturer: fErimen g
Riferimento 5 - pr: Picture: Riferimento 5 - Ipr: Picture w
Riferimento &: O »

*) Se selezionato, vengono utilizzati i dati del file di riferimenta.

**) Assegnazione del file di importazione al prodotto di riferimento nel file lpr.

e LPC-Tool
Vedi manuale LPC-Tool.

Ipr: Product Ipr: Info
0270100000 TS 35X15/2.3 2M/CU/BK
Ipr: Category Riferimento 2
4008190105136
Riferimento3 Ipr: Manufacturer
Weidmdller
lpr: Picture Riferimento 6

0270100 jpg
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Casella di gruppo

Le caselle di gruppo (marcatori di gruppo) sono campi di testo che possono essere creati tra pil
marcatori.

La funzione & disponibile per i materiali seguenti: MultiCard (selected), MultiMark Siglatura di
morsetti (Pitched Strip)

|I3|U| '.I |I|I|I4;G||

a .G02

....................................................

G 01 |

1123456 7 % 91011121314 15 16

Casella di gruppo per selezione
Aggiunge caselle di gruppo ai marcatori selezionati.

La funzione puo essere richiamata tramite la seguente voce di menu: Incolla > Casella di
gruppo per selezione

Esempio:
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Copia pagina

Fai clic con il tasto destro del mouse sulla scheda di una pagina.
Verra visualizzato il seguente menu di scelta rapida:

Inserisci pagina - Pagina 03

Mumero di copie:

(O) Prima Pagina 01

(") Prima Pagina 03
(®) Dopo Pagina 03

Copia pagina

I|1I4?I | |1F|FI | |1F?II |1I1|FI | |1ID?I IquI [ |EPI [

Inserisci pagina...

Copia pagina
La pagina selezionata viene copiata.

Inserisci pagina ...
Seleziona la posizione di incollaggio di una pagina copiata e il numero di copie.

86 e Istruzioni generali Istruzioni per I'uso



Interfaccia del programma

Introduzione

A seconda della configurazione, l'interfaccia del programma si compone di elementi diversi.

-
M-Print® PRO - [SM 27/27 K. MC NE WS] Elﬁu
5 File Modifica Visualizza Inserisci Forma Formato Strumenti  Finestra Guida 1 =X
e E i E A B X SRR 0 E 0% S AR R E g
‘B Arial - 10 'IXA'IﬂAEIEIEIBIHHXZX’IEEIEEI@I@3
»

HME®OO /O & ks + H
(e E B
M-Print® PROv. 9.140 10 |
Esplora progetti x4 Pagina iniziale | CC15/27 MMWS 3 DEK565MCNEWS .~ SM 27/27 KMCNEWS | Pox
L§ Eéﬁ | \J t - | +§ - 11 ILI0| Il I%0| 11 I3I0|I | I‘ﬁo | II5I0| [} Islol Il I?Ic'" 1l ISIO [} I9I0| | IH0I0| | IHLI0| |
o5 cciszrmmws - o =8
=4 Pagina 01 =z
DEK 5/6.5 MC NE WS - PROJECT | MARKER
Pagina 01 =N I5a |
Pagina 02 =
i[5 Pagina 03 o N
-5 SM27/27 KMC NEWS - | |2 —
e e - —
| = |
Proprieta x F 12 |
El Awvio del programma - E —
Nome MARKER @ e 11 |
B Dimensioni & posizione _
Siristra 0 s B
In alto o _: —
Destra 27 =
Inferiore 27 = 7
| arnhezza 77 Sia _
o=
g
T DDl lnfurmazmmi Pagina m—
Per aprire la Guida, premere F1 | Q  Marcatore: 1/12 Colonna: 1/6 Riga: 1,2 |7 |

1 Barre dei menu

La barra dei menu consente di accedere alle funzioni principali del programma.
Le singole voci di menu possono essere attive o inattive.

2 Barre degli strumenti

E possibile eseguire i comandi pitl importanti del menu anche attraverso i simboli
della barra degli strumenti.
Le barre degli strumenti possono essere spostate e agganciate.

3 Registro

| registri si trovano al di sotto delle barre degli strumenti.
Facendo clic sul registro, il relativo tipo di marcatore viene portato in primo piano.
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4 Righello

| bordi superiore e sinistro del campo di lavoro ospitano due righelli, che
consentono di rilevare i valori relativi alla posizione e alla distanza.

5 Esplora progetti
Esplora progetti € normalmente visualizzato nella parte sinistra dell'interfaccia
utente.
Possiede una struttura a directory e consente di gestire il progetto (vedere la
sezione "Finestra Esplora progetti").

6 Finestra Proprieta
La finestra "Proprieta” consente di visualizzare ed eventualmente modificare le
proprieta di vari elementi (ad es. campi di testo, immagini o codici a barre) (vedere
a questo proposito il capitolo "Finestra Proprieta™).

7  Campo di lavoro
Il campo di lavoro si trova nella parte destra dell'interfaccia utente.

Consente di rappresentare ed elaborare il tipo di marcatore attualmente
selezionato.

8 Griglia dei dati
La griglia dei dati visualizza in forma tabellare il contenuto degli elementi del
marcatore "Campo di testo" e "Codice a barre" consentendone I'elaborazione.
(Vedere anche il capitolo "Finestra Griglia dei dati").

9 Barra di stato
La barra di stato si trova nella riga piu bassa dell'interfaccia utente.
Essa visualizza:

® | livello attivo (ad es. livello del marcatore, livello libero ecc.)

® il numero dei marcatori disponibili, delle colonne, delle righe del livello attivo
® |a posizione del cursore negli assi X e Y e l'unita di misura (ad es. mm)
[ ]

lo stato delle funzioni CAP, NUM e SCRL
Le funzioni attive vengono visualizzate in nero.

10 Numero della versione
Mostra la versione attuale del programma.
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11 Aree del marcatore
Settori stampabili dei tipi di marcatore.
Ogni area del marcatore (abbreviata: marcatore) possiede normalmente un
elemento di testo specifico del documento (vedere la sezione "Campg").

Le aree del marcatore si trovano al livello del marcatore

12 Livello del progetto
Il livello del progetto possiede normalmente un elemento di testo specifico del
documento, il cosiddetto "marcatore di progetto” o anche "identificazione
progetto”.

Elementi
La denominazione "elemento" si riferisce a campi di testo, forme (linea, rettangolo, ellissi, scale),
immagini (figure) e codici a barre.
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La barra dei menu

In questa sezione vengono descritte le funzioni principali dei singoli menu.

Menu File

| Nuova..,

_3 Apri...

H Salva
Salva con nome...
Includi immagini e salva con nome...

O Chiudi

Importa...

Importazione batch...

Stampa...
Commuta modalita

Imposta tipo di marcatore...

Invia a...

Esci

Nuovo
Con questa voce di menu & possibile creare un nuovo file.

Apri

Apre un file gia esistente. L'immissione di un nome file pud essere impostata tramite una
"Finestra di dialogo Opzioni" (vedere capitolo "Finestra di dialogo Opzioni", sezione "Ambiente",
sezione "Generale").

Salva
Salva un file elaborato.

Salva con nome...
Con questa voce di menu & possibile salvare un file indicandone il nome.

Incorpora immagini e salva con nome
Incorporare le immagini presenti nel file di programma e salvarle specificando il nome file.

Chiudi
Chiude un file.

Importa...
Con questa voce di menu € possibile inserire dati di formato diverso.

Importazione batch
E possibile importare dati esterni tramite Script.
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Stampa...
Con questa voce di menu viene visualizzata la finestra di dialogo per la stampa dei tipi di
marcatori.

Passa al modo plotter
Commuta nel Modo plotter (vedere la sezione "Modo plotter").

Commuta modalita di stampa
Passa alla modalita plotter. Vedere il capitolo ,Modo di stampa®“.

Imposta tipo di marcatore...
Con questa voce di menu é possibile calibrare il tipo di marcatore (vedere la sezione
"Adattamento offset della stampante").

Invia a...
Con questa voce di menu é possibile inviare il progetto attuale via e-mail.

File recente
In questo campo vengono mostrati gli ultimi file aperti.

Esci
Con questa voce di menu & possibile chiudere il programma.

Istruzioni per l'uso Interfaccia del programma e 91



Menu Modifica

1#) | Annulla

| Ripeti
& | Taglia

i 53 | Copia

1E4 | Incolla

11"A  Incolla solo testo

| Inserimento multiplo...
B | Duplica

Duplicati di marcatori

i

Avvia modifica Excel

Trova..,
Sostituisci...

Inserisci interruzione di riga...

Sincronizzare contenuto

+t

Seleziona
Elimina

Modifica tipo di marcatore..,

Elimina tipo di marcatore

S

Copia formato

Ordina marcatori...

b
—

Capovolgi marcatore

Morsetto multipiano...

Mo
B

Annulla

Annulla l'ultima azione effettuata.

Ripristina

Ripristina le fasi annullate. Il ripristino riguarda solo le funzioni di base e non puod essere

nuovamente annullato.

Taglia

Con questa voce di menu € possibile tagliare uno o pit elementi evidenziati.

Copia

Con questa voce di menu € possibile copiare uno o pit elementi evidenziati.

Incolla

Con questa voce di menu é possibile inserire il contenuto degli appunti in un campo selezionato.

Inserire elementi
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Con questa voce di menu & possibile inserire un elemento copiato in un campo selezionato
(ad es. un simbolo).

Incolla solo testo
Solo le informazioni di testo degli appunti vengono incollate (se I'elemento di destinazione puo
visualizzare il testo). La formattazione degli elementi rimane invariata.

Inserimento multiplo
Con questa voce di menu € possibile inserire pill volte un elemento copiato (vedere la sezione
"Inserimento multiplo").

Duplica
Con questa voce di menu & possibile duplicare un elemento evidenziato e collocarlo (con un
leggero scostamento) sull'elemento evidenziato.

Duplicati di marcatori
Duplica un marcatore selezionato con tutti gli elementi e lo inserisce sul marcatore seguente.

Raggruppa
Riunisce gli elementi (o i gruppi) selezionati in un nuovo gruppo (vedere la sezione

"Raggruppa").

Separa
Separa il raggruppamento del gruppo selezionato.

Avvia modifica Excel
Questa voce di menu avvia I'elaborazione di Excel (vedere la sezione "Modifica Excel").

Chiudi modifica Excel
Questa voce di menu termina I'elaborazione di Excel.

Cerca

Apre la finestra di dialogo di ricerca. || marcatore attuale viene esaminato in base al criterio di
ricerca indicato.

E' possibile la ricerca su piu righe. Questa viene effettuata solo nel livello corrente.

Sostituisci

Richiama la finestra di dialogo di ricerca e sostituzione.

Il marcatore attuale viene esaminato in base al criterio di ricerca indicato.

E' possibile la ricerca e la sostituzione su piu righe. Questa viene effettuata solo nel livello
corrente.

Inserisci interruzione di riga
Apre una finestra di dialogo che consente di inserire delle interruzione di riga (vedere la sezione
"Inserisci interruzione di riga").

Sincronizzazione del contenuto
Sincronizza tutti i campi per i quali sono presenti delle fonti di dati (vedere la sezione
"Sincronizzazione del contenuto").

Seleziona
Questa voce di menu consente di selezionare gli elementi mediante diverse modalita (ad es.
Tutti i campi (pagina attuale) o Tutti i campi (tutte le pagine)).

Elimina
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Tramite questa voce di menu sono disponibili diverse opzioni per eliminare gli elementi (ad es.
campo di testo, rettangolo, pagine, marcatori vuoti, duplicati di marcatori, ecc).

Modifica tipo di marcatore...
Con questa voce di menu € possibile cambiare il tipo di marcatore.
Se possibile, i contenuti vengono applicati.

Elimina tipo di marcatore
Con questa voce di menu & possibile cancellare il tipo di marcatore.

Copia formato
E possibile copiare la formattazione, il carattere, il colore ecc. trasferendoli su un altro elemento.

Ordina marcatori...
Apre la finestra di dialogo che consente di ordinare i marcatori. Qui & possibile selezionare i
marcatori in base a diversi criteri di selezione.

Capovolgi marcatore
Questa funzione consente di ruotare la sequenza dei marcatori selezionati.

Morsetto multipiano

Apre la finestra di dialogo Morsetto multipiano.

Mediante questa funzione € possibile ordinare nuovamente i dati selezionati in base a un passo
predefinito (vedere il capitolo "Morsetti multipiano™).
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Menu Visualizza

Barra degli strumenti L

#4 Progetto

=y Livell

|fﬁ' Proprieta

EZ  Tabela di caratteri
"D Simbol

] Griglia dei dati

Fittro ’

| Barra di stato

Visuzlizza pagina iniziale

Ripristina predefinite
Zoom ¥

|E=_: Selezione del campo documento

Griglia L

%] Attivare l'orientamento Ctrl+ MAIUSC+O

Barre degli strumenti
Questa voce di menu contiene le seguenti voci di sottomenu:

Predefinito
La barra degli strumenti Predefinita non puo essere disattivata.

Layout
Per il posizionamento degli elementi (ad es. rotazione, allineamento).

Formatta testo
Contiene le funzioni per la formattazione del testo, ad es. il tipo e le dimensioni del carattere,
il colore.

Bordi e riempimenti
Contiene le funzioni per la formattazione del testo, ad es.
lo spessore della linea o il colore del riempimento.

Elemento:
Campo di selezione di tutti gli elementi che possono essere inseriti, ad es. campi di testo,
immagini e codici a barre.

Finestra della barra di alloggiamento
Questa voce di sottomenu richiama una finestra che consente di visualizzare diverse finestre
di modifica, come "Proprieta" e "Livelli", e di attivare o disattivare Esplora progetti.
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THM MMP
Consente di impostare marche di taglio. Vedere il capitolo: “THM MMP”.

Barra del titolo
Con questa voce € possibile attivare o disattivare la barra del titolo recante il nome e la
versione del programma.

Personalizza...
Questa voce di menu richiama una finestra di dialogo che consente di personalizzare la
visualizzazione sullo schermo dei pulsanti dei simboli, come pure di crearne di nuovi.

Progetto
Attivazione o disattivazione di Esplora progetti.

Livelli
Attivazione o disattivazione della finestra "Livelli".

Proprieta
Attivazione o disattivazione della finestra "Proprieta".

Tabella di caratteri
Attivazione o disattivazione della finestra "Tabella di caratteri".

Simboli
Attivazione o disattivazione della finestra dei simboli.

Griglia dei dati

Attivazione o disattivazione della griglia dei dati.

Questa tabella serve ad immettere dati. | dati sono visualizzati simultaneamente sui marcatori
(vedere il capitolo "Finestra Griglia dei dati").

Filtro
Qui e possibile filtrare i marcatori attuali in base a determinati criteri in modo che sia mostrata
solo la soluzione filtrata (vedere la sezione "Funzioni di filtro").

Barra di stato
Attivazione o disattivazione della barra di stato.

Visualizza pagina iniziale
Attivazione o disattivazione della pagina iniziale nel campo di lavoro.

Ripristina predefinite
Ripristina le impostazioni predefinite.
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Zoom
Questa voce di menu contiene le seguenti voci di sottomenu:

Ingrandisci
Ingrandire I'area di disegno visualizzata

Rimpiccolisci
Rimpiccolire I'area di disegno visualizzata

Grandezza standard
Ripristina la grandezza di visualizzazione dell'area di disegno

Selezione Campo di documento
Selezionando un marcatore vengono selezionati tutti i marcatori.

Griglia
Questa voce di menu contiene le seguenti voci di sottomenu:

Visualizza

Questa voce di menu consente di collocare un reticolo sul tipo di marcatore.
E quindi possibile allineare degli elementi alle linee della griglia

(vedere il capitolo "Allineamento di elementi sulla griglia™).

Allinea sulla griglia
Con questa voce € possibile fissare gli elementi alle linee della griglia.

Commuta I'orientamento
Nella rappresentazione ruotata tutti gli elementi sono mostrati ruotati di 90°. Gli elementi (ad es.
codici a barre o testi) restano elaborabili nella rappresentazione WYSIWYG.
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Menu Inserisci

'q—i.

5 Muova pagina

Marcatore...,

Calcola

B =

Campao...

Campo di testo

Rettangolo

Linea

Ellisse

EONOO®R

Immagine

Codice a barre
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Scala
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Tipo di marcatore...

Mumera all'indietro
2z  Mumerazione automatica...
Sequenza di testo predefinita...

Riempimento campo di testo

Inverti ordine testo

Inverti ardine testo - Campo successivo

Campo di testo circolare

Rettangolo arrotondato

Scala arrotondata

Elemento di collegamento

Casella di gruppo

Casella di gruppo per selezione

Tipo di marcatore...

Mediante questa voce del menu di scelta rapida & possibile inserire un nuovo tipo di marcatore.

Viene visualizzato il catalogo dei prodotti per la selezione.

Nuova pagina

Aggiunge una nuova pagina al tipo di marcatore attuale.

Marcatore...

Aggiunge al tipo di marcatore un numero di marcatori da definire.

Per inserire strisce a modulo continuo vedere il capitolo "Strisce a modulo continuo”.

Numera in avanti

Numera in avanti il valore numerico di un marcatore o di elemento di testo e poi lo riporta sul

marcatore o sull'elemento di testo successivo.

e Il contenuto del campo di testo di destinazione verra in questo modo
sovrascritto!
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Numera all'indietro
Numera all'indietro il valore numerico di un marcatore o di elemento di testo e poi lo riporta sul
marcatore o sull'elemento di testo successivo.

e Il contenuto del campo di testo di destinazione verra in questo modo
sovrascritto!

e La numerazione all'indietro avviene solamente nell'intervallo numerico positivo!

Numerazione automatica...
Questa voce di menu consente di numerare automaticamente i marcatori (vedere il capitolo
"Numerazione automatica").

Sequenza di testo predefinita...
Aggiunge una sequenza di testo predefinita. Vedere a questo proposito il capitolo "Inserimento di
una sequenza di testo predefinita”.

e Le sequenze di testo predefinite sono possibili solo per gli elementi di testo.

Riempimento campo di testo
Riproduce le righe presenti in un campo di testo fintantoché il campo di testo non sara riempito
senza overflow. Vedere il capitolo "Riempimento campo di testo".

Inverti ordine testo

| caratteri del testo contrassegnato vengono invertiti. | testi possono anche essere scambiati in
sequenza sulla base di un modello di ripartizione selezionabile. Vedere il capitolo ,,Sostituzioni di
testo®.

Tasto di scelta rapida: Alt+Shift+T

Esempio: ABCD -> DCBA

Inverti ordine testo - Campo successivo

| caratteri del testo contrassegnato vengono immessi invertiti nel campo successivo. | testi
possono anche essere scambiati in sequenza sulla base di un modello di ripartizione
selezionabile. Vedere il capitolo ,Sostituzioni di testo®.

Tasto di scelta rapida: Alt+Shift+R

Esempio:
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Campo
Consente di inserire delle funzioni di campo (ad es. data del sistema o numero di pagine).

Campo di testo
Aggiunge un campo di testo.

Campo di testo circolare
Aggiunge un campo di testo circolare.

Rettangolo
Aggiunge un rettangolo.

Rettangolo arrotondato
Aggiunge un rettangolo con bordi arrotondati.

Linea
Aggiunge una linea.

Ellisse
Aggiunge un’ellisse.

Immagine
Aggiunge un’immagine.

Codice a barre

Questa voce di menu richiama un sottomenu, che consente di aggiungere un codice a barre del
tipo visualizzato (ad es. Code 39, Code 2/5 Industrie, EAN13) (vedere la sezione "Inserimento di
un codice a barre").

Scala
Aggiunge una scala (vedere la sezione "Inserire una scala").

Scala arrotondata
Aggiunge una scala circolare (vedere la sezione "Inserire una scala").

Elemento di collegamento
Aggiunge diversi elementi di collegamento. Vedere il capitolo “Strisce a modulo continuo”.

Casella di gruppo
Aggiunge una casella di gruppo. Vedere il capitolo ,Casella di gruppo*“.

Casella di gruppo per selezione
Aggiunge caselle di gruppo ai marcatori selezionati. Vedere il capitolo ,Casella di gruppo®.
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Menu Forma

A" Ructa a sinistra kil
Sk Rucota a destra Chrl+R
Fuata...
Sposka...
Allineamento r

Questo menu consente di allineare, ruotare e spostare gli elementi, come pure di adattarne la
larghezza e l'altezza.

Spostamento di una forma

® Selezionare le voci di menu Forma > Sposta....

Verra visualizzata la finestra seguente.

Sposta rz|
reeene o |
OF[ Ok
Sinistra {:} {:} Destra
O il
Distanza I:I mm

® Selezionare, facendo clic sul corrispondente pulsante di opzione, la direzione in cui si
desidera spostare I'elemento.

® |ndicare di quanti millimetri (pollici, um, cm) si desidera spostare I'elemento.
L’unita di misura visualizzata si orienta in base alle impostazioni configurate nella finestra
"Opzioni".

® Confermare i dati immessi con OK.
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Menu Formato

Tipo di carattere...

Adatta dimensioni font...
Adatta lunghezza marcatore...
Adatta stringhe...

I codifica colori

Tipo di carattere
Tramite questa voce di menu € possibile aprire la finestra di impostazione del tipo e della
grandezza dei caratteri. Vedere capitolo "Istruzioni generali", sezione "Adatta tipo di carattere".

Adatta dimensioni font
Viene adattata automaticamente la grandezza dei caratteri dei campi di testo con eccedenza
(vedere capitolo "Istruzioni generali", sezione "Adatta dimensioni font").

Se la finestra di dialogo non viene visualizzata, o non sono soddisfatte le condizioni, o & stata
deselezionata la visualizzazione della finestra di dialogo (vedere capitolo "Finestra di dialogo
Opzioni", sezione "Ambiente", sezione "Generale").

Adatta lunghezza marcatore

La lunghezza del marcatore puo tuttavia (in presenza di strisce a modulo continuo e tubi flessibili
a contrazione continui) essere adattata automaticamente (vedere capitolo "Istruzioni generali",
sezione "Adatta lunghezza marcatore").

Adatta stringhe
La spaziatura caratteri delle stringhe pud essere ridotta automaticamente. Vedere capitolo
"Istruzioni generali”, sezione "Adatta stringhe".

Codifica colori
Inserisce la codifica colori per i campi di testo selezionati (vedere il capitolo "Codifica colori").
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Menu Strumenti

Catalogo prodotti...
Sequenza di testo predefinita...
Anyaglista...
-ﬁ Ordine...
Editor dei simboli plotter...
Layout 4
Editor file di riferimento...
Caonvertitore formato file...

Convertitore marcatore per morsetti..,

_,J Protezione documento...

Impostazioni protezione documento..,

Amministrazione stampante 4

Opzioni..

Catalogo prodotti
Apre la finestra "Catalogo prodotti”, che consente ad esempio di aggiungere al progetto attuale
un nuovo tipo di marcatore.

Sequenza di testo predefinita...

Questa voce di menu consente di definire una sequenza di testo, che pud essere inserita
in seguito mediante Incolla > Sequenza di testo predefinita... (vedere anche il capitolo
"Impostazione di una sequenza di testo predefinita”).

e Le sequenze di testo predefinite sono possibili solo per gli elementi di testo.

Distinta materiali...

Apre una lista di tutti i materiali da Esplora progetti.

Vedere il capitolo ,Finestra Esplora progetti“. La lista pud essere memorizzata, copiata negli
appunti, o stampata.

Ordine...
Mediante I'assistente all’ordinazione € possibile ordinare via e-mail i tipi di marcatore dal
progetto attualmente aperto (vedere il capitolo "Ordine, ordine guidato").

Plotter Symbol Editor...
Con questa voce di menu si richiama I'editor di simboli plotter (vedere sezione "Explorer simboli /
Editor simboli plotter").

Layout
Il menu Layout puo essere utilizzato solamente se si dispone di una licenza speciale.
Per ricevere la licenza e il relativo manuale utente, rivolgersi al creatore del programma.

Editor file di riferimento...
Creazione e adattamento dei file di riferimento *.mpr. Vedere il capitolo ,Editor file di
riferimento®.

Convertitore di formato di file...
Conversione di file tra vecchio e nuovo formato.
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Sono disponibili i formati seguenti:

Password ZIP | AES | SHA-Hash
A partireda VvV 9.2 X X Livello di sicurezza massimo
V9.0 X Livello di sicurezza medio

Vecchie versioni

Livello di sicurezza minimo

e I livelli di sicurezza per I'apertura e il salvataggio dei file del programma possono
essere impostati. Vedere il capitolo ,Sicurezza“.
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Convertitore marcatore per morsetti...
Consente di convertire progetti con marcatori per morsetti al design corrente.

Protezione del documento...

Attiva o disattiva la protezione del documento. Se non & ancora impostata alcuna password per
la protezione del documento, si aprira la finestra di dialogo delle impostazioni (vedere capitolo
"Protezione del documento").

Impostazioni protezione del documento...

Mediante la finestra delle impostazioni della protezione del documento € possibile impostare una
nuova password o rimuovere la protezione del documento (vedere capitolo "Impostazioni
protezione del documento").

Amministrazione stampante

® Esplora stampanti...
Apre — se installato — Esplora stampanti per le stampanti condivise. Vedere il capitolo
"Esplora stampanti".

® Monitor di stato...
Apre — se installato — il Monitor di stato per le stampanti condivise. Vedere il capitolo
"Monitor di stato".

® Effettua correzione stampante...
Con questa voce di menu & possibile eseguire la correzione della stampante (vedere la
sezione "Correzione della stampante™).

® Correggere I'ingresso materiale...
Con questa voce di menu & possibile correggere I'ingresso materiale.

® Calibrazione...
Consente di adattare la stampante al tipo di marcatore selezionato (vedere il capitolo
"Adattamento offset della stampante").

Opzioni

Questa voce di menu consente di aprire la finestra "Opzioni", nella quale & possibile definire
diverse impostazioni personali, ad es. l'unita di misura, il colore delle linee della griglia ecc.
(vedere il capitolo "Finestra di dialogo Opzioni").
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Menu Finestra

Sovrapponi
Affianca
Disponi icone

Chiudi bukka

1 Pagina iniziale
5 E5G 817 MC NELTRAL

Sovrapponi
Selezionando questa voce di menu i tipi di marcatore aperti e la pagina iniziale saranno disposti
in sovrapposizione.

Affianca
Selezionando questa voce di menu i tipi di marcatore aperti e la pagina iniziale saranno disposti
'uno sopra laltro.

Disponi icone
Questa voce di menu consente di ridurre tutte le finestre alla dimensione del simbolo.

Chiudi tutto
Questa voce di menu consente di chiudere tutti i tipi di marcatore. Se il file non e ancora stato
salvato, il programma chiedera se si desidera eseguire questa operazione.

Menu Guida

Guida in linea

M-Print® PRO in Internet
Werifica update...
Aggiungi modulo...

System Information... F12

Informazioni su M-Print® PRO...

Guidain linea
Mediante questa voce di menu & possibile accedere alla Guida online.

Programma in Internet
Mediante questa voce di menu e possibile accedere con il browser predefinito alla pagina web
del programma.

Verifica aggiornamenti...
Cerca in rete gli aggiornamenti del software.

Aggiungi modulo...
Possibilita di sbloccare funzioni specifiche del programma tramite una chiave software, una
chiave di licenza o una chiave modulo.

Informazioni su...
Mostra il numero di versione e le informazioni sul software di terze parti utilizzato.
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Shortcut keys

Function Shortcut keys
Importar MAIUSC+AIt+I
Importacion por lotes MAIUSC+AIt+G
Imprimir Ctrl+P
Deshacer Ctrl+z
Restablecer Ctrl+Y

Cortar Ctrl+X

Copiar Ctrl+C

Pegar Ctrl+Vv

Pegar solo texto Ctrl+MAIUSC+AIt+V
Insertar elementos Ctrl+V
Introduccion mdltiple Ctrl+M

Duplicar Ctrl+D
Duplicados de marcador Ctrl+MAIUSC+AIt+D
Agrupar Ctrl+G
Desagrupar Ctrl+MAIUSC+G
Iniciar edicion con Excel F5

Cerrar edicion con Excel® Ctrl+F5

Buscar Ctrl+F
Reemplazar Ctrl+H

Insertar salto de linea Ctrl+MAIUSC+F

Sincronizar contenido

Ctrl+MAIUSC+Y

Girar marcador

Ctrl+F9

Pasar a Alineacion Ctrl+MAIUSC+0O
Inserisci - Marcadores Ctrl+l
Incrementar valor MAIUSC+F8
Disminuir valor MAIUSC+F7
Funcion de autollenado F8

Insertar secuencia de texto predefinida F9

Invertir el orden del texto Umsch+Alt+T
Invertir el orden del texto - Campo siguiente MAIUSC+AIt+R
Girar a la izquierda Ctrl+L

Girar a la derecha Ctrl+R

System Information F12
Interruzione di riga Ctrl+Enter
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Barre degli strumenti

Questo capitolo illustra gli elementi principali delle barre degli strumenti.

Molti dei simboli standard, quali Salva, Formatta ecc., hon vengono descritti nel dettaglio.

Predefinito
La barra degli strumenti "Predefinita” rimane sempre visibile.

i e | S H - ] Ga kB XS o4 B[] 100 G | [ Bl IS

Descrizione dei simboli:

R, Chiudi file
[ d Chiude il progetto aperto. A volte viene visualizzato un messaggio di
richiesta di conferma del salvataggio del file.

Modo di stampa
V|

Passa alla modalita plotter. Vedere il capitolo ,Modo di stampa®“.

Commuta l'orientamento

La raffigurazione del campo di lavoro passa da una visualizzazione
orizzontale a una verticale.

Non possibile nel caso delle strisce a modulo continuo.

o Duplica
Duplica gli elementi selezionati.

E Raggruppa

Riunisce gli elementi (o i gruppi) selezionati in un nuovo gruppo (vedere la

sezione "Raggruppa").

It Separa
Separa il raggruppamento del gruppo selezionato.
15 Numerazione automatica
Apre la finestra di dialogo della numerazione automatica (vedere il capitolo
"Numerazione automatica").
o Riempimento campo di testo
= Riproduce le righe presenti in un campo di testo fintantoché il campo di testo
non sara riempito senza overflow. Vedere il capitolo "Riempimento campo di
testo".
o Inverti ordine testo
11 | caratteri del testo contrassegnato vengono invertiti.

Tasto di scelta rapida: Alt+Shift+R
Esempio: ABCD -> DCBA
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[} || B Avvia/Chiudi modifica Excel
| contenuti dei campi di testo e di codice a barre possono essere elaborati
anche in Excel (vedere il capitolo "Modifica Excel").

= ||= |Commutatra livelli attivi
Consente di passare dal livello del progetto a quello del marcatore.
La commutazione puo avvenire automaticamente (vedere il capitolo
"Visualizza" nel capitolo "Finestra di dialogo Opzioni").

=} Mostra/Nascondi selezione del campo documento

Selezionando un elemento (ad es. un testo o un'immagine) gli elementi ad
€ss0 appartenenti vengono caratterizzati da quelli dell'altro marcatore (non
disponibile per un campo singolo).

"Mostra" I'esempiO'

“

~“

T
T,

S Blocca elemento
Impedisce che I'elemento selezionato subisca delle modifiche di
formattazione. | contenuti (ad es. il testo) possono essere ulteriormente
modificati (vedere anche il capitolo "Blocco di un elemento™).

Al Ordina marcatori...
Apre la finestra di dialogo che consente di ordinare i marcatori.

& Sincronizzazione del contenuto
Sincronizza gli elementi che dispongono di una fonte di dati (vedere il
capitolo "Sincronizzazione del contenuto").

g Ordine
Apre la finestra di dialogo Ordine guidato (vedere il capitolo "Ordine, ordine
gquidato™).

£ Protezione del documento

Protegge il file dalle modifiche di layout o elimina la protezione del
documento (vedere capitolo "Protezione del documento").

Supporto

Offre la possibilita di avviare TeamViewer.
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Layout

E possibile attivare o disattivare la barra degli strumenti "Layout" selezionando la voce di menu
Visualizza > Barre degli strumenti > Layout.

ey R =il

| simboli della barra consentono di
- disporre
- allineare
- ruotare
- adattare le dimensioni degli elementi selezionati
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Formatta testo

E possibile attivare o disattivare la barra degli strumenti "Formatta testo" selezionando la voce di
menu Visualizza > Barre degli strumenti > Formatta testo.

TroAral - 10 - A JIEEEE BT U Bx x| EEEFEZ RRERFE A D
Descrizione dei simboli:

® Arial - Seleziona tipo di carattere
Consente di selezionare il tipo di carattere per il testo o gli elementi di testo
evidenziati.

10 - |Seleziona dimensioni
Consente di selezionare le dimensioni del testo o degli elementi di testo
evidenziati.

A Aumenta dimensioni carattere
Consente di aumentare le dimensioni del carattere del testo o degli elementi
di testo evidenziati.
Facendo clic sul simbolo una volta si aumentano le dimensioni di un grado.

- Riduci dimensioni carattere
Consente di diminuire le dimensioni del carattere del testo o degli elementi di
testo evidenziati.
Facendo clic sul simbolo una volta si diminuiscono le dimensioni di un grado.

A¥ A¥  Aumentare / riduci spaziatura caratteri
La spaziatura caratteri per gli elementi di testo selezionati viene aumentata o
ridotta. Sussiste anche la possibilita di adeguare dinamicamente la
spaziatura caratteri. Vedere capitolo "Istruzioni generali”, sezione "Adatta
stringhe”.
= 1= Aumentare/riduci altezzarighe
L'altezza delle righe per gli elementi di testo selezionati viene aumentata o
ridotta.

B Formatta testo in grassetto
Consente di formattare in grassetto il testo o gli elementi di testo evidenziati.

I Formatta testo in corsivo
Consente di formattare in corsivo il testo o gli elementi di testo evidenziati.

u Sottolinea testo
Consente di sottolineare il testo evidenziato o il contenuto di elementi di
testo.

v Testo barrato

Consente di barrare il testo evidenziato o il contenuto di elementi di testo.
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Apice

2, Consente di convertire in apice il testo evidenziato o il contenuto di elementi
di testo. Vedere capitolo "Istruzioni generali", sezione "Adatta tipo di
carattere”.

o Pedice
Consente di convertire in pedice il testo evidenziato o il contenuto di elementi

di testo. Vedere capitolo "Istruzioni generali”, sezione "Adatta tipo di
carattere".

Allinea a sinistra

Centrato

Allinea a destra

Allineamento verticale in alto

Allineamento verticale centrato

Allineamento verticale in basso

Imposta I'orientamento testo a 0°

Imposta l'orientamento testo a 90°

Imposta I'orientamento testo a 180°

Imposta l'orientamento testo a 270°

Modifica colore testo
Consente di selezionare il colore di un testo selezionato o del contenuto di
elementi di testo.

=

Codifica colori

La codifica colori impostata viene applicata all'elemento di testo selezionato
(vedere il capitolo "Codifica colori").
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Bordi e riempimenti

Se la barra degli strumenti non ¢ visualizzata sullo schermo, selezionare le voci Visualizza >
Barra degli strumenti > Formatta testo.

ik —-—a-=-1

Tramite la finestra "Proprieta” & possibile anche modificare il colore e il modello di riempimento
(vedere sezione "Bordi e riempimenti").

Descrizione dei simboli:

- Colore linea

Quando si traccia una nuova linea, questa viene visualizzata nel colore
selezionato.

Se si desidera modificare il colore delle linee esistenti, &€ necessario
dapprima evidenziarle, dopodiché selezionare il colore desiderato.

Spessore linea

Quando si traccia una nuova linea, questa viene visualizzata nello spessore
selezionato.

Per poter modificare lo spessore delle linee esistenti € necessario prima di
tutto evidenziarle.

Tipo di linea

Quando si traccia una nuova linea, questa viene creata in base al tipo
selezionato.

Per poter modificare il tipo delle linee esistenti &€ necessario prima di tutto
evidenziarle.

-~ Colore riempimento
Consente di modificare il colore di riempimento degli elementi selezionati.

Motivo riempimento
Consente di modificare il motivo di riempimento degli elementi selezionati.
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Elementi

E possibile attivare o disattivare la barra degli strumenti "Elementi" selezionando la voce di menu
Visualizza > Barre degli strumenti > Elementi.

Descrizione dei simboli:

Seleziona

Strumento che consente di selezionare gli elementi.
Puo essere utilizzato anche in combinazione con i tasti CTRL e MAIUSC.

Selezione multipla
(vedere il capitolo "Selezionare gli elementi").

Campo di testo
Tracciare con il mouse un campo di testo sul marcatore.

Y, Campo di testo circolare
Tracciare sul marcatore con il mouse un campo di testo circolare.

@ Creazione di rettangoli/quadrati
Tracciare con il mouse un quadrato sul marcatore.

O Crea rettangolo arrotondato / quadrato
Tracciare con il mouse sul marcatore un rettangolo con bordi arrotondati.

Creazione di linee
Tracciare con il mouse una linea sul marcatore.

N

Creazione di cerchi/ellissi
Tracciare con il mouse un'ellisse sul marcatore.

0l

Inserimento di un'immagine

Tracciare con il mouse una cornice sul marcatore e selezionare
unimmagine.

Il programma supporta i formati grafici BMP, EMF, GIF, ICO, JPG, PNG,
WMF e TIFF.

114 e Interfaccia del programma Istruzioni per l'uso



-
T
(]

s

_+

]

@

Inserimento di un codice a barre

Tracciare con il mouse un campo di codice a barre sul marcatore.
Il programma supporta i seguenti tipi di codice a barre:
- Code 39

- Code 128

- Code 2/5 Industrial

- Code 2/5 Interleaved

- EAN13

- EANS

- EAN128

- UPC-A

- UPC-E

- Codice QR

- Matrice dati

- MicroPDF417

Nella finestra "Proprieta" & possibile adattare il tipo di codice a barre
(vedere la sezione "Contenuto™).

Tracciare con il mouse sul marcatore una scala diritta. Per ulteriori
impostazioni si apre una finestra di dialogo (vedere il capitolo "Inserire una
scala™).

Tracciare con il mouse sul marcatore una scala circolare. Per ulteriori
impostazioni si apre una finestra di dialogo (vedere il capitolo "Inserire una
scala™).

Trascinate sul marcatore un elemento di collegamento con l'ausilio del
mouse. Nella finestra "Proprietd" potete adeguare il tipo di collegamento.

Casella di gruppo
Tracciare con il mouse un campo di testo sui marcatori di materiale
continuo. Vedere il capitolo ,Casella di gruppo*.

E possibile impostare la posizione e le dimensioni esatte degli elementi
nella finestra "Proprieta” (vedere capitolo "Finestra Proprieta").

Il capitolo "Funzioni utilizzate di frequente" fornisce indicazioni ulteriori su
come inserire gli elementi.
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Finestra della barra di alloggiamento

E possibile attivare o disattivare la barra degli strumenti "Finestra della barra di alloggiamento”
selezionando le voci di menu Visualizza > Barre degli strumenti > Finestra della barra di

alloggiamento.

imasze all

Descrizione dei simboli:

i

=

Ly

o

| &

Mostra/Nascondi Esplora progetti

Vedere anche il capitolo "Finestra Esplora progetti".
Mostra/Nascondi livelli

Vedere anche il capitolo "Modifica di un livello".
Mostra/Nascondi proprieta

Vedere anche il capitolo "Finestra Proprieta".
Mostra/Nascondi tabella di caratteri

Vedere anche il capitolo "Inserimento di caratteri speciali".

Mostra/Nascondi simboli

Vedere anche il capitolo "Explorer simboli / Editor simboli plotter".

Mostra/Nascondi griglia dei dati
Vedere anche il capitolo "Finestra Griglia dei dati".
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THM MMP

E possibile attivare o disattivare la barra degli strumenti "THM MMP" selezionando la voce di
menu Visualizza > Barre degli strumenti > THM MMP.

BEEBER

Descrizione dei simboli:

Marca di taglio prima

Impostare la marca di taglio a sinistra del campo di selezione (vedere
Capitolo "Stampa", sezione "Impostare marche di taglio").

Marca di taglio dopo

Impostare la marca di taglio a destra del campo di selezione (vedere
Capitolo "Stampa", sezione "Impostare marche di taglio").

B Rimuovere tutte le marche di taglio

Tutte le marche di taglio vengono rimosse (vedere Capitolo "Stampa",
sezione "Impostare marche di taglio™).

E Inviare comando di taglio

Inviare un comando di taglio immediato alla stampante assegnata (solo per
THM MMP, THM MultiMark, THM MultiMark Plus, THM MultiMark Twin,
THM Plus M)

La funzione €& disponibile per le stampanti seguenti: THM MMP, THM MultiMark,
THM MultiMark Plus, THM MultiMark Twin, THM Plus M
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Finestra Esplora progetti

Per attivare o disattivare la finestra, selezionare nella barra dei menu la voce Visualizza >
Progetto.

Se é stato aperto un progetto, quest’ultimo verra riportato in Esplora progetti assieme ai relativi
sottoprogetti. Per ciascun sottoprogetto vengono visualizzati i singoli tipi di marcatore. Sotto ai
tipi di marcatore sono visibili le pagine relative.

Negli alberi directory di Esplora progetti & possibile visualizzare, facendo clic con il pulsante
sinistro del mouse sui simboli "+" e "-", le strutture secondarie delle directory, oppure disattivarle
per una migliore visione d’insieme:

Esplora progetti x

[Ea

=

|||TE:|.

= }_I Muovo progetto

o

=3 Pagina 0l

Premendo x sul blocco numerico della tastiera &€ possibile aprire in una sola

volta tutti i sottolivelli di una scala gerarchica.

Descrizione dei simboli:

=

I||TET

Inserisci nuovo sottoprogetto
Vedere anche il capitolo ,,Aggiunta di un sottoprogetto*.

Inserisci nuovo tipo di marcatore
Vedere anche il capitolo ,Assegnazione di un tipo di marcatore a un
sottoprogetto®.

Spostatipo di marcatore o sottoprogetto
Consente di trascinare I'elemento selezionato sullo stesso livello

Spostatipo di marcatore o sottoprogetto

Consente di trascinare I'elemento selezionato tra tutti i livelli e gradi
gerarchici.

Espandi / Riduci

Consente di visualizzare o nascondere tutti i gradi gerarchici dall'elemento
selezionato in poi.
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Menu di scelta rapida

Selezionare un oggetto in Esplora progetti e fare clic con il pulsante destro del mouse.

Si apre il menu di scelta rapida.

Il menu di scelta rapida contiene tutte le funzioni attive per un determinato oggetto. Possono
essere eseguite soltanto le funzioni raffigurate in nero.

Muovo progetto

Inserisci nuowvo tipo di marcatare

Stampa...

Copia pagina
Inserisci pagina...

Sposta pagina...

Elimina questa pagina

Elimina pagine....

Modifica tipo di marcatore...

Visualizza 4

Chiudi file

Copia
Tramite questa voce del menu di scelta rapida & possibile copiare un tipo di marcatore
selezionato oppure un sottoprogetto.

Incolla
Evidenziare il progetto o il sottoprogetto in cui il tipo di marcatore copiato o il sottoprogetto
devono essere incollati.

Nuovo progetto
Con questa voce di menu di scelta rapida & possibile creare un nuovo progetto.

Inserisci nuovo tipo di marcatore
Mediante questa voce del menu di scelta rapida & possibile inserire un nuovo tipo di marcatore.
Sul navigatore apparira il nuovo tipo di marcatore inserito.

Inserisci nuovo sottoprogetto
Con questa voce del menu di scelta rapida é possibile inserire un sottoprogetto al di sotto del
progetto oppure di un altro sottoprogetto.
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Stampa
Con questa voce di menu viene aperta la finestra di dialogo per la stampa del tipo di marcatore.

Rimuovi filtro
Vedere il capitolo ,Funzioni di filtro“.

Copia pagina / Inserisci pagina...
Copia la pagina corrente. Quando si inserisce la pagina, € possibile selezionare la posizione e il
numero di copie. Vedere il capitolo ,Copia pagina®“.

Sposta pagina...
Sposta la pagina corrente tramite una finestra di dialogo di selezione.

Elimina questa pagina
Consente di evidenziare la pagina che deve essere eliminata.

Elimina pagine
Questa finestra di dialogo consente di selezionare le pagine da eliminare.

Elimina tipo di marcatore

Selezionando questa voce del menu di scelta rapida & possibile eliminare il tipo di marcatore
selezionato, che non apparira quindi pit sul navigatore. che non apparira quindi piu sul
navigatore.

Elimina sottoprogetto
Selezionando questa voce del menu di scelta rapida & possibile eliminare il sottoprogetto
evidenziato. Il sottoprogetto eliminato non apparira piu sul havigatore.

Modifica tipo di marcatore
Con questa voce di menu & possibile cambiare il tipo di marcatore.

Aggiungi all’elenco ordini
Selezionando questa voce del menu contestuale 'articolo contrassegnato pud essere aggiunto
nella propria lista di ordinazione (vedere la sezione "Ordine, ordine guidato™").

Visualizza
Qui e possibile cambiare il tipo di vista scegliendo tra quelle disponibili (vedere paragrafo "Menu
Vista").

Chiudi file
Il progetto attivo viene chiuso. Se non é stato salvato, viene visualizzato un messaggio di
richiesta di conferma del salvataggio del progetto.
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Finestra Proprieta

Le proprieta dei differenti elementi (per esempio campo di testo, immagine, codice a barre o
scala) sono riportate nella finestra "Proprieta”.

® Per attivare o disattivare questa finestra di dialogo, selezionare la voce di menu Visualizza >
Proprieta.

i 8] | W | R

Titolo del tipo di marc...  SM 2727 MELTRAL WS

Tipo di marcatare Sk 2727
Stampante

Comezione ¥ [X] 100
Corezione %[%) 100.00

Informazione aggiuntiva

Informazione aggiuntiva
|nformazioni aggiuntive sul ipo di cartellino.

Per impostare la vista della finestra delle proprieta € necessario utilizzare i pulsanti dei simboli:

Visualizza le proprieta in base alle categorie.

i Visualizza le proprieta in ordine alfabetico.

Le proprieta impostate vengono salvate come predefinite per l'oggetto
selezionato.

Le proprieta di campi "bloccati" NON possono essere impostate come
predefinite. Occorre dapprima sbloccarle (vedere la sezione

"Comportamento").

I:E'. Tutti i livelli e tutti gli elementi che si trovano su detti livelli saranno visualizzati
sotto forma di struttura ad albero.

Ulteriori informazioni sono reperibili nel capitolo "Proprieta del marcatore".
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Proprieta del marcatore

Facendo clic sul nome di un marcatore in Esplora progetti ne vengono visualizzate le relative
proprieta.

(&) | b | H

Titolo del tipo di marc... S 2727 WEUTRAL WS

Tipo di marcatare SM 27427
Stamparnte

Correzione # (%) 100
Comezione %) 100,00

|nformazione agaiuntiva

Informazione aggiuntiva
|nformazioni aggiuntive sul ipo di cartellino.

Titolo del tipo di - Titolo del tipo di marcatore
marcatore - Il nome puo essere modificato.

Tipo di marcatore |l tipo di marcatore selezionato.
Se viene selezionato qui un altro marcatore, il programma tentera
di applicarne i contenuti (vedere anche "Menu Modifica").

Stampante La stampante assegnata al tipo di marcatore (vedere capitolo
"Assegnazione della stampante a un tipo di marcatore")

Correzione Le correzioni alla stampante che sono state salvate.

Modalita progetto Indica se la modalita progetto € stata selezionata o meno. (vedere
anche il capitolo "Finestra di dialogo Opzioni").
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Visualizzazione delle proprieta

Per visualizzare la finestra delle proprieta selezionare le voci di menu Visualizza >

Proprieta.

Fare clic sull’elemento di cui si intende modificare le caratteristiche.

Haome

Sinistra

I alto
Desztra
Inferiore
Larghezza
Altezza

Speszore inea
Caolore linea

Tipo dilinea

Colore nempimento
b ativo riermpimento

Orientamento
Bloccato
Stampabile
Protetto da scrittura
Ordire dei tab

Raffigurazione
Testo

Fonte di dat
Codifica colari

Onentamento

Impozta 'orientamenta del testo zelezionato, del codice a barre o

degli elementi grafici.

TEXTBO=Z

18513
3.408
2354
14,254
5027
10,843

0.001

I 000000
[ ]Senza
] FFFFFF
[ ]Senza

]
Mo
Si
Mo
1

Campo specifico del docu...

Mo

La finestra delle proprieta visualizza proprieta diverse a seconda dell'elemento

selezionato.

Le proprieta bloccate (in grigio) risultano non disponibili per I'oggetto selezionato
oppure non accessibili. Per sbloccare impostare la proprieta "Bloccato” su "No"

(vedere la sezione "Comportamentao").
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Personalizzazione delle proprieta
La finestra "Proprieta" & suddivisa nelle seguenti categorie, che verranno approfondite di seguito:

— Generale

— Dimensioni e posizione
— Bordi e riempimenti

— Comportamento

— Campo

— Contenuto

Generale

bropriets_—_——__x
(40 | & R

Mare TEXTEO=1

I Y R e

Avvio del programma

Nome - I nome dell'elemento evidenziato.
- I nome puod essere modificato.
- I nome viene utilizzato anche per I'attribuzione delle colonne durante
l'importazione di file (vedere il capitolo "Fase 7: Associazioni di campo").
- I nome viene utilizzato anche come titolo delle colonne della griglia dei
dati.

@ I nome non pud contenere caratteri speciali né spazi!
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Dimensioni e posizione

40 | | H:

Sinistra

I alto
Destra
Infenore
Larghezza
Altezza

6.077
B.317
1613
14.254
10,054
7.937

Dimensioni e posizione

In questa categoria & possibile indicare le dimensioni dell'elemento e la sua posizione.

® |’impostazione delle dimensioni avviene a partire dal punto zero, posto nell’angolo sinistro

della MultiCard o dell'etichetta.

® | 'unita di misura viene impostata nella finestra di dialogo delle opzioni (vedere il capitolo

"Finestra di dialogo Opzioni").

Per altre possibilita di spostamento di un elemento consultare la sezione "Spostamento degli

elementi".
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Bordi e riempimenti

(40 | &R

Speszore lin.. 0,001

Colore linea [ 0000...
Tipo dilinea [ - Tratt..
Colore riernpi... [ FFOO...
Fotivo riemp... Inclin...

Bordo [ ]

Bordo e riempimento

In questa categoria & possibile definire lo spessore, il colore, il tratto e i tipi di linea dell’'oggetto

evidenziato.
Con i seguenti elementi possono essere visualizzati singoli bordi (a sinistra, a destra, in alto, in

basso): campo di testo, rettangolo, immagine.
Per i codici a barre & possibile impostare un'ulteriore spaziatura interna.
Nell'impostazione del colore & possibile anche immettere direttamente il valore relativo al colore.

E possibile definire il valore relativo al colore come segue: RRVVBB (rosso, verde, blu)
Immettere il valore esadecimale.

Esempio: FFO00O é rosso.

Colore riemnpimento [ FFo000
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Comportamento

4 | & R
= s
Mame B&RCODET
-
+
Orientamento 1]
Bloccato Mo
Adatta dimensi...  Si
kostra testo Si
Stampabile Si
Frotetto da scri... Mo
Ordine dei tab 1
Ordine direm... 1
= L
Comportamento
Orientamento - Orientamento dell'elemento con scatti di 90 gradi.
- Solo per campi di testo, immagini e codici a barre
- Proprieta specifica del documento
Bloccato - Blocco dell'elemento

- Gli elementi bloccati non possono piu essere modificati.

- Eccezione: i contenuti dei campi di testo sono ancora modificabili.
- Le proprieta degli elementi bloccati non possono essere impostate
come predefinite.

- Il blocco puo essere ulteriormente protetto grazie alla protezione
del documento (vedere capitolo "Protezione del documento")

Adatta dimensioni - Il contenuto viene adattato alle dimensioni del codice a barre o del
campo grafico o, al contrario, visualizzato nelle sue dimensioni
originarie
- Vedere I'esempio
- Solo per immagini e codici a barre

Mostra testo - Mostra o nasconde il testo in chiaro di un campo di codice a barre
- Solo per codici a barre

Stampabile - L’elemento viene stampato o meno assieme al progetto.
Protetto da - Il contenuto & bloccato e non pud essere modificato.
scrittura - Solo per campi di testo, immagini e codici a barre

Istruzioni per l'uso Interfaccia del programma o 127



Ordine dei tab

Interlinea

Spaziatura
caratteri

Ordine di
riempimento

Carattere
personalizzato

Esempio:

- Ordine di tabulazione mediante il quale i campi vengono
selezionati con la pressione del tasto TAB.

- Sono consentiti valori da 1 a x

- | campi che presentano lo stesso ordine di tab vengono
selezionati in base all'ordine di creazione.

Vedere il capitolo ,Adatta tipo di carattere®.

Vedere il capitolo ,Adatta tipo di carattere®.

| campi aggiunti a posteriori (testo, codice a barre) vengono resi
disponibili tramite un valore unico per 'ulteriore lavorazione su
materiale continuo (ad es. ad es. importazione, griglia dei dati,
modifica Excel).

Utilizzare le proprieta del carattere personalizzato per la
componente testo del codice a barre.

La funzione non puo essere combinata con I'impostazione ,Usa
libreria codici a barre versione 1”.

Vedere il capitolo ,Adatta tipo di carattere®.

Codice a barre

Adatta dimensioni:
Si

La visualizzazione del campo del codice a
barre viene commutata in orizzontale. |
numeri appaiono piu vicini.

Adatta dimensioni:
No

La distanza tra i numeri resta immutata; non
tutti i contenuti vengono pero visualizzati.

Immagine

Adatta dimensioni:
Senza

L'immagine viene visualizzata nelle sue
dimensioni originarie.

Adatta dimensioni:
Proporzionale

L'immagine viene adattata alle dimensioni
del campo grafico e in determinati casi
deformata.

Adatta dimensioni:
Rettangolo

L'immagine viene adattata alle dimensioni
del campo grafico. Le proporzioni restano
inalterate.
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Campo

Nella categoria "Campo" € possibile definire il tipo di campo.

H -&.:

(4 | & R
+ Py
+.
+
+

Raffigurazione Campo specific. ..
+

w

Campo

E possibile selezionare i seguenti tipi di campo:

Campo singolo - Un campo singolo non ha alcuna relazione con alcun altro
campo.
- Ogni campo singolo dispone di una propria formattazione e di un
proprio contenuto.
- Se in un campo singolo vengono apportate delle modifiche,
queste valgono esclusivamente per quel campo.
- Il contrario di un campo singolo & un campo di documento.

Campo di - E presente in tutte le aree del marcatore.
documento - Mostra identici contenuti di testo e identiche proprieta di
posizione e formattazione in tutte le aree del marcatore.

Campo specifico - E presente in tutte le aree del marcatore.
del documento - Mostra proprieta di posizione e formattazione identiche in tutte le
aree del marcatore.
- Puo pero disporre in ciascuna area del marcatore di testi specifici
(differenti) con relativa formattazione.
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Esempio:

Campo singolo

Campo di
documento

Campo specifico
del documento
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Contenuto

| contenuti dei singoli elementi.

Proprieta =
= &
IEE(2 | | R
+.
+.
+
+
+
Testa
Codifica color Mo
Riempimentoc... Mo
Contem#io

Testo - Il contenuto di testo dell'elemento.
- Si applica solo a campi di testo e codici a barre.

Fonte di dati - Il nome dell'elemento che viene utilizzato come fonte di dati per la
sincronizzazione (vedere il capitolo "Sincronizzazione del
contenuto").

- Si applica solo a campi di testo e codici a barre.
Codifica colori - Ai numeri immessi viene applicata la codifica colori impostata

(vedere "Codifica colori").
- Si applica solo a campi di testo.
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Tipo - Per le immagini: il modo in cui 'immagine viene inserita.
- Percorso: l'immagine viene inserita come riferimento su un file
immagine
- Integrata: l'immagine viene integrata nel progetto
- vedere anche il capitolo "Salvare un'immagine su file" e
"Estrarre immagini dai file"
- Per codici a barre: il tipo di codice a barre scelto

(per esempio Codice 39, Codice 128, Codice 2/5 Industrial,
Codice 2/5 Interleaved, EAN13)
- Si applica solo a figure e codici a barre.
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File - Se viene inserita un'immagine di tipo "Percorso”, essa viene
selezionata tramite "File".
- Si applica solo a figure.

Punto di - Indica I'angolo di inizio del testo. O corrisponde alla posizione
ancoraggio iniziale "In alto" (ore 12).
- Si applica solo a campi di testo circolari.
Valori di scala Una descrizione delle proprieta della scala € presente nel capitolo
"Proprieta della scala".
Riempimento Riempire il campo di testo automaticamente dopo un'importazione.

campo di testo Vedere il capitolo "Riempimento campo di testo".
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Selezionare gli elementi

R

Fare clic su questo simbolo nella finestra "Proprieta” per selezionare gli

elementi in modo mirato.

Verranno visualizzati tutti i livelli e tutti gli elementi che si trovano su detti livelli in forma di
struttura ad albero.

il 4 | bd | [

£Z Livello progetto
[E] PROGETTO

PROJECT
=1
PROJECT

PROJECT

PROJECT

H-H-H

PROJECT
=

PROJECT

£Z Livello marcatore

=

Il BarCoDEL

TEXTEON1

MARKER
=1

Ml BarcoDEL

TEXTECH®1

MARKER
=

Ml BarcoDEL

TEXTEON1

MARKER
=

Esempio:
La figura mostra pagina 1 a livello dell'identificazione progetto con otto aree relative. Viene

inoltre visualizzato il livello del marcatore con un’area sul quale sono presenti un codice a barre
e un campo di testo.

Se si fa clic sul codice a barre, questo risultera attivo nell’area del marcatore del campo di lavoro

e potra essere modificato.

Questa modalita di selezione & disponibile per gli elementi che si sovrappongono.
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Il campo di lavoro

All'avvio dell'applicazione nel campo di lavoro viene normalmente visualizzata la pagina iniziale
(menu Visualizza > Visualizza pagina iniziale).

Dopo l'apertura di un progetto o di tipo di marcatore nel campo di lavoro vengono invece
visualizzati questi ultimi.

Menu di scelta rapida del campo di lavoro

Posizionare il cursore sul campo di lavoro e premere il pulsante destro del mouse.
Verra visualizzato il seguente menu di scelta rapida:

z2z Imserisci nuova pagina
Gz | Inserisci bipo di marcatore. .

Madifica kipo di marcatore., .

Seleziona livello L

Wisualizza r

Inserisci nuova pagina
Viene aggiunta una nuova pagina al tipo di marcatore visualizzato nel campo di lavoro.

Inserisci tipo di marcatore

Questa voce del menu di scelta rapida consente di inserire un nuovo marcatore. Viene
visualizzato il catalogo dei prodotti, all'interno del quale & possibile selezionare il tipo di
marcatore o il modello (template) da inserire.

Modifica tipo di marcatore...
Questa voce consente di modificare il tipo di marcatore visualizzato scegliendone uno dal
catalogo dei prodotti. Se possibile, i contenuti vengono applicati.

Elimina questa pagina
Consente di evidenziare la pagina che deve essere eliminata.

Seleziona livello
Consente di passare a un altro livello (ad es. livello libero, livello del progetto).

Visualizza
Consente di scegliere tra viste diverse nella finestra della barra di alloggiamento (vedere la
sezione "Menu Visualizza").

Proprieta livello
Questa voce del menu di scelta rapida consente di adattare le proprieta del livello (ad es. colore,
blocco).
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Livelli

Le pagine di un tipo di marcatore sono suddivise nei seguenti livelli:

- Livello bloccato

- Livello libero

- Livello del marcatore
- Livello del progetto

- Livello dello sfondo

In linea di massima una pagina é costituita da quattro o cinque livelli. La pagina di una MultiCard
contiene tutti e cinque i livelli. Per tutti gli altri tipi di marcatore (ad es. etichette, formati di tessere
magnetiche ecc.) decade il livello del progetto, mentre rimangono gli altri quattro livelli.

Livello dello sfondo

Il livello dello sfondo serve da supporto visivo. Esso pud essere modificato per quanto riguarda il
colore ed & possibile inserire elementi a piacere (testi e figure). E possibile utilizzare I'intera area
di questo livello. Il livello dello sfondo & sempre il livello piu basso, di default non viene stampato
e risulta bloccato. Esso & inoltre un livello predefinito e non puo essere eliminato.

Livello del progetto

Il livello del progetto conente di inserire testi o figure nell’'area definita nel layout. Il livello del
progetto & sempre il secondo livello. Esso viene stampato di default e non risulta bloccato. Non
puod essere eliminato.

Livello del marcatore

Il livello del marcatore ¢ il terzo livello. Su questo livello avviene la siglatura vera e propria dei
cartellini MultiCard oppure delle etichette. Nelle aree definite nel layout € possibile disporre a
piacere testi, forme (linee, rettangoli ecc.), grafici e codici a barre. Il livello di marcatore viene
stampato di default. Non pud essere eliminato.

Livello libero

Il livello libero corrisponde alle dimensioni totali della pagina. Qui infatti € possibile posizionare a
piacere testi e figure. Il livello libero si trova sempre al di sotto del livello del settore bloccato.
Diversamente dagli altri livelli, esso puo essere duplicato e i livelli liberi inseriti possono essere
eliminati. Detti livelli possono anche essere spostati uno sotto I'altro. Tutti i livelli liberi possono
essere riuniti in un unico livello libero. Deve essere sempre presente almeno un livello libero.
Non puo essere eliminato. | livelli liberi possono essere stampati.
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Livello bloccato

Sul livello bloccato possono essere creati elementi (rettangolo, linea, ellisse, scala) che coprono
il contenuto degli altri livelli, che cosi non sono visibili e non vengono stampati. Questo livello &
sempre il piu alto. Il livello bloccato non puo essere eliminato.

Nel livello bloccato € possibile ad esempio collocare un cerchio sulla posizione di un foro o di un
LED, in modo da non poter stampare questo settore.

Finestra Livelli

In questa finestra vengono visualizzati tutti i livelli di un tipo di marcatura (vedere anche il
capitolo "Modifica di un livello").

® Per attivare o disattivare questa finestra di dialogo, selezionare la voce di menu Visualizza >
Livelli.

e ]|

Livello bloccato
Livello libero
Livello marcatore
Livello progetko
Livela di sfonda

ARIRIDID]
Rl [l [l Rl

Nella finestra "Livelli" & disponibile la seguente barra degli strumenti:

S G S 1

| pulsanti possono essere utilizzati solamente per i livelli liberi.

Facendo clic su questo simbolo & possibile inserire nuovi livelli liberi.

» Facendo clic su questo simbolo & possibile cancellare il livello libero
selezionato.

Facendo clic su questo simbolo & possibile spostare il livello evidenziato di

una posizione verso l'alto.

Facendo clic su questo simbolo & possibile spostare il livello evidenziato di

una posizione verso il basso.

z| Facendo clic su questo simbolo, tutti i livelli liberi vengono ridotti ad uno
solo. Questa procedura non puo essere annullata.

® Fare clic sul livello che si desidera modificare e premere il simbolo corrispondente.
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Proprieta livello

E possibile modificare le impostazioni dei livelli tramite la finestra "Proprieta livello".

Facendo doppio clic sul nome di un livello nella finestra "Livelli" si aprira la finestra "Proprieta

livello™:
Proprieta livello f'5_<|
Momne livello: | Livello marcatore |
Colari:
Colore bordo: [ ] Standard - Colore riempimento: [ ] Standard -
|:| Trasparente
Qpzioni:
Yisibile Stampabile [ ]Bloccato Riguadro di evidenziazior
[ Imposta come predefinito ] [ K, l [ annulla

Qui sara possibile modificare il nome del livello selezionato, il colore del bordo e il colore del
riempimento.

Sara inoltre possibile impostare I'eventuale visibilita di un livello e I'eventuale possibilita di
stampa dello stesso. Sara anche possibile definire I'eventuale blocco del livello e la sua
possibilita di elaborazione.

Definire le impostazioni desiderate e confermare con OK.

Con il pulsante Imposta come predefinito le impostazioni effettuate verranno
salvate e impostate come predefinite all’apertura di un nuovo tipo di marcatore.
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Finestra Griglia dei dati

Per attivare o disattivare questa finestra di dialogo, selezionare la voce di menu Visualizza >
Griglia dei dati.

La griglia dei dati mostra il contenuto dei campi di testo e di codice a barre consentendone
I'elaborazione (inserimento, modifica, copy/paste).

|:| 11 I1ID| 11 I2ID| [ I3I0| 11 I4ID| [ ISID| [ I6ID| 11 I?Inl 11

=

’J PROIECT I MARKER. TEXTECx1 BARCODEL

PROJECT MARKER @ TExXTBOX1 [123

IFII || |?IDI || |6IDII | |5IDII | |4PI || |3PI | | |2IDI | | |1IDI 1|

Per rendere disponibili campi aggiunti a posteriori (testo, codice a barre) per
l'ulteriore lavorazione sul materiale continuo, occorre impostare la proprieta
"Ordine di riempimento" nelle proprieta del campo (vedere capitolo "Interfaccia
di programma”, sezione "Dimensioni e posizione").

@

Definizione della larghezza della griglia dei dati

Esistono diversi modi per impostare la larghezza della griglia dei dati:

] Imposta la larghezza attuale come predefinita per:
- il tipo di marcatore visualizzato
- l'intero programma

Salva progetto Quando si salva un file di progetto, in esso vengono salvate le
lunghezze delle tabelle dei tipi di marcatore aperti.
Tali lunghezze vengono rese nuovamente disponibili all'apertura
del file di progetto.

Vengono salvate anche le larghezze delle colonne e le altezze delle righe scelte.
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Menu di scelta rapida della griglia dei dati

Mediante il menu di scelta rapida della griglia dei dati & possibile richiamare diverse funzionalita
generali del programma.

#u Busschneiden Skrg+¥
Ee Kopieren Skrg+C
|4 Einfligen Skrg+V
Alle auswahlen Strg+4a
5;\ Automatische Mummerierung., ., Fa
Yordefinierte Textsequenz einfigen. .. Fa

Yordefinierte Textsequenz speichern. .,

Zeige Element im Layout

Einfligen r

Lischen r

Per visualizzare ed evidenziare un campo della griglia dei dati nel campo di
lavoro, fare clic con il pulsante destro del mouse sul campo e selezionare nel
menu di scelta rapida Mostra elemento nel layout.

Altezza delle righe e larghezza delle colonne della griglia dei dati

L'altezza delle righe e la larghezza delle colonne possono essere definite in base all'altezza e
alla larghezza ottimali del contenuto della tabella.

A tale scopo evidenziare le righe o le colonne interessate, fare doppio clic sull'intervallo
dell'intestazione della riga o della colonna per impostare il valore ottimale.

PROJECT MARKER [¢==] TEXTBOXL TEXTEBOX2

| (&= |

Le larghezze delle colonne e le altezze delle righe scelte possono anche essere salvate
("Definizione della larghezza della griglia dei dati").
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La pagina delle informazioni

Ad ogni tipo di marcatore viene associata anche la visualizzazione di una pagina delle
informazioni.

Nel caso in cui la pagina delle informazioni non fosse visualizzabile, potete richiamarla e attivarla
tramite la Finestra di dialogo Opzioni (vedere sezione "Ambiente" all'interno del capitolo
"Finestra di dialogo Opzioni").

Pagina iniziale/ DEK 5/5 MC-10 NEUTRAL WS |

Generale

Maome della variante:

Descrizione:

Ordine n. zero:

Ordine n. stampa speciale:

EAM:

Percorzo di configurazione:

Infarmazione:

DEK 5/% MC-10 NEUTRAL

Largh.: Brom, &lt.: Brmm; per

1603201044

1603810000

4008190337111

M « » M Informazioni A Pagina 01

nr

A seconda del prodotto & possibile visualizzare le seguenti sezioni:

Layout del prodotto

Ordina ordine

Le dimensioni del tipo di marcatore.

Percorso di configurazione

Fate clic sul pulsante E] per aprire il percorso che conduce al file del prodotto
(*.mcf) del tipo di marcatore.

Determinazione se la sequenza di classificazione deve avvenire in N-Order o in
W-Order.
L'impostazione di base viene determinata attraverso il file del prodotto.
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Impostazioni THM / TwinMark
Se é assegnata una stampante PrintJet (vedere "Assegnazione della stampante a
un tipo di marcatore") in questo contesto sono visualizzati i livelli di riscaldamento
e /o la qualita di stampa per la stampante. In questa sede € possibile impostare i
valori anche per la variante del prodotto.

La qualita di stampa della PrintJet ADVANCED/CONNECT pu0 essere anche
impostata in generale accedendo alla Finestra di dialogo Opzioni (vedere "PrintJet
ADVANCED", ,PrintJet CONNECT").).

Selezionare il livello di riscaldamento della PrintJet...

Fare clic su questo pulsante per regolare i livelli di riscaldamento della stampante

PrintJet.
Imposta nscaldamento Printlet S
Livello riscaldamento PIAPIC: [ - ]

riscaldamento PrintJet PRO:

Qualita [Heaﬁng 1 "]
Premiurm: [Heating 1 *]
riscaldamento PrintJet II: [Heaﬁng 100 *]

Ripristina i valori di configurazione ]

0]4 ] [ Annulla

Per la regolazione di fino della stampante PrintJet ADVANCED/COONECT ¢
possibile selezionare il campo a discesa "Livello di riscaldamento PJA/PJC":

-- Molto meno calore

- Meno calore
Standard Valore standard
+ Piu calore

++ Molto piu calore

Vedere anche il capitolo "Finestra di dialogo Opzioni", sezione "PrintJet
ADVANCED", sezione "PrintJet CONNECT", sezione "Generale".
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Seleziona fascicolazione...

Fare clic su questo pulsante per personalizzare il fascicolatore delle stampanti
seguenti: PrintJet CONNECT

Seleziona livello di riscaldamento / fascicolazione

[] attiva fascicolazione on

Ripristina i valori di configurazione

QK Annulla

Attiva fascicolatore

Casella di controllo non selezionata:
vengono applicate le impostazioni della configurazione.

Casella di controllo selezionata:
Il fascicolatore puo essere attivato o disattivato.

Impostazioni PrintJet MINI

Seleziona potenza di fissaggio...

Clicca su questo pulsante per le seguenti impostazioni:: Tempo di fissaggio,
Intensita di fissaggio

Seleziona potenza di fissaggio X
PrintJet MINI

Tempo di fissaggio: Predefinito w~
Intensitd di fissaggio: Predefinito w

Ripristina i valori di configurazione

Annula

Vedere anche il capitolo "Finestra di dialogo Opzioni", sezione "PrintJet MINI",
sezione "Generale".
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Impostazioni THM / TwinMark

Se un materiale continuo € assegnato a una stampante THM (vedere
"Assegnazione della stampante a un tipo di marcatore"), diversi parametri di
stampante potranno essere adattati al materiale.

Impostazioni L
Velodta (mm/s): [Smndard (75) 'l
Temperatura: [Sbndard (12) "]
Profondita di perforazione: [S'ﬁndard (MA) "l
Taglio prima del lavoro di [Smndard (Mo} "]
Modalith di strappo [Smndard (MA) "]
Trasporto di ritorno: [Smndard (Ottimizzato) 'l
Posizione di stampa (mm): i} 0 D

Ripristina i valori di configurazione l
[ Ok ] l Annulla ]

Nella voce dell'elenco "Standard” si utilizzano le impostazioni di stampa della
Finestra di dialogo Opzioni. Il valore standard viene visualizzato tra parentesi.
Tutti gli altri valori selezionati hanno la precedenza sulle impostazioni di stampa
generali della stampante THM (vedere "Finestra di dialogo Opzioni", sezione
"Stampante THM").

Nelle seguenti stampanti per materiale continuo € possibile adeguare la posizione
di stampa: THM MMP, THM MultiMark, THM MultiMark Plus, THM MultiMark LPC,
THM MultiMark Twin, THM Plus M. Vedere capitolo "Impostazione della posizione

di stampa".
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Prime fasi

Introduzione

Il presente capitolo & riservato agli utenti che dimostrano una buona conoscenza di Windows.

Di seguito sono illustrate punto per punto le fasi necessarie per realizzare facilmente una

siglatura professionale dei diversi tipi di marcatore.

Fase 1: Avvia programma

® Fare doppio clic sul simbolo del programma presente sul desktop.

%

(0]

® Awviare M-Print® PRO mediante Start — Programmi — Weidmiller — M-Print® PRO.

Fase 2: selezionare un tipo di marcatore

All'avvio dell'applicazione viene visualizzata la finestra "Catalogo prodotti":

Ordine n. stampa spediale:
Ordine n. zero:

EAN:

N. d'ordine stampa spediale del diente:

Classe dinfiammabilita UL 94: ¥-2, Alogeni: Mo

1609810000
1609801044

4003190397111

Informazione: Paaina Intemet del prodatto
Apri ultimo progetto Apri progetto... Apri ultimo modello

Catalege prodotti s
Categoria  Tipo di marcatore  Cerca  Strumenti
FEEe 3|4 B =2 k&
Catalogo: (@) Modello: () Variante:
£ Dekafix A | | Lista varianti 4
DEK 5/5 MC NE WS ~
DEK 5/5 MC NE GE
DEK 5/5 MC NE RT
DEK 5/5 MC ME BL
DEK 55 MC MNE GN
DEK 55 MC MNE GR
DEK 5(5 MC NE OR.
o DEK 5/6.5 PLUS DEK 55 MC NE VI
513,1 DEK 5/7.5 DEK 5/5 MC MNE BR.
----- =13.'| DEK 5/8 N DEK 5/5 MC NE SW v
Descrizione: Siglatura di morsetti, Weidmueller, lungh.x largh.: 5 x 5 mm, Passo in mm: 5,00, Materiale: poliammide 66,

Seleziona prodotto

Chiudi catalogo

® Selezionare il tipo di marcatore desiderato nella sezione "Catalogo" posta sulla sinistra dello
schermo, scegliere la versione nella parte destra e premere il pulsante Seleziona prodotto.
Verra aperto il tipo di marcatore desiderato.
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Fase 3: dotare di dicitura un marcatore

® Selezionare, facendo clic con il pulsante sinistro del mouse, il marcatore nel quale si
desidera inserire del testo.

N

Pagina iniziale CC 15/27 K MC NEUTRAL Ws | P x

ol A ARl el Al s eel e e el e sl el el el heel, 2o, Ale

1 |1|1P| | |1|0P| | |9P\ ] |8P| ) |?|?| 1 |6|U| ] |5|0| ] |4P\ ] |3P| ) |%0| 1 |1|U| ]

14 4 » o *Pagina 01

® Per accedere al marcatore successivo premere il tasto INVIO o selezionare il marcatore
desiderato.
:A_1 T Se, dop_o‘ I’inse_rimento (_jel testo, i ca}mpi di testo pres_,entan(_) un triangolo
rosso, cio significa che il testo non rientra nello spazio previsto dal campo.
P ¥n questo caso il testo non verra né visualizzato né stampato
—___completamente. Sara dunque necessario ridurre il testo o farlo adattare
automaticamente dal programma (vedere il capitolo "Adatta dimensioni
font" nel capitolo "Menu Formato").

alﬁaiﬁse’ dopo I’inserimentq d_eI tes_to, i campi di testo presentano un t_riangolo
rosso, il testo non sara visualizzato su una sola riga, ma su piu righe, non
|_789 -essendo piu sufficiente il campo di testo.
Sussistono le seguenti possibilita di adattamento:
- Adatta lunghezza marcatore.
Vedere capitolo "Istruzioni generali”, sezione "Adatta lunghezza
marcatore".
- Adatta stringhe.
Vedere capitolo "Istruzioni generali”, sezione "Adatta stringhe".

148 o Prime fasi Istruzioni per l'uso



Fase 4: salvare un file

Dopo avere immesso tutti i dati salvare il file:
® Selezionare nella barra dei menu la voce File > Salva.
® |mmettere nella finestra successiva il nome del file e premere il pulsante Salva.
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Fase 5: stampare un tipo di marcatore

Selezionare nella barra dei menu la voce File > Stampa....
Selezionare una stampante dall'elenco delle stampanti e fare clic su Assegna.
Nella finestra visualizzata di seguito selezionare il tipo di stampante (stampante/plotter).

Nella finestra di dialogo seguente potete determinare se devono essere assegnate tutte le
varianti del prodotto alla stampante. Selezionate "No" per assegnare solo la variante
selezionata.

® Scegliere dall'elenco un tipo di marcatore e fare clic sul pulsante Stampa (vedere anche il
capitolo "Stampa").

o
Zr Stampa progetto (Nuovo progetto) @
Stampante
Generic [ Text Only S ——
Assegna stampante per CC 15/80 Assegna
Mumero di copie Duplica marcatori
Numero di copie: 155 Numero duplicati: 15
[7] cambia ordine di stampa ﬂﬂﬂﬂ [¥] ordinato
Lavori
(@) Tuttii tipi di marcatori E—'Zil
() Tipo di marcatore: CC 15/60 115

") Pagine singole

Carteliini selezionati

Tipo Titolo del tipo di marc...  Pagine Mumero di copie  Stampante riscaldamento  Qualité
CC 15/60  CC 15/60 K MC NELT... 1 1 Generic [ Te...

4 T 3

[ visualizzare la finestra del messagaio per il cambio del tipo di marcatore

[T 5enza fissaagio (solo Printlet ADVANCED)

[ Stampa l [ Annulla ]

e Se non é stata assegnata una stampante a uno o a tutti i tipi di marcatore da
stampare, la stampa potra avvenire dopo aver azionato il pulsante Stampa sulla
stampante predefinita.

Se la stampa non é stata posizionata correttamente, sara necessario calibrare la
stampante (vedere il capitolo "Impostazione della stampante a seconda del tipo
di marcatore").

Fase 6: Chiudi file

® Selezionare nella barra dei menu le voci File > Chiudi
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Elaborazione del progetto

Struttura del progetto

Un progetto (1) pud essere composto da uno o piu sottoprogetti (2). Vedere il capitolo: "Finestra
Esplora progetti”.

Detti sottoprogetti possono contenere a scelta molte MultiCard o etichette.

Un tipo di marcatore puo essere composto da diverse pagine (4) e puo contenere diversi
elementi, come ad es. testo, codici a barre, immagini e forme come linee, rettangoli ecc. Tutte le
immagini e tutti i codici a barre sono collocati nelle cartelle previste.

Una MultiCard consiste, a seconda del tipo, in un numero definito di aree del marcatore (6) e di
aree di identificazione del progetto (5), disposte in sequenza/per marginatura.

Le aree del marcatore servono principalmente alle operazioni di siglatura. Si trovano al livello del
marcatore.

Le aree di identificazione del progetto servono alle operazioni di assegnazione a un determinato
progetto. Si trovano al livello del progetto.

E possibile disporre diversi tipi di marcatore sotto un unico progetto (3).

4 E F‘aﬂina imiziale ) SM 2727 NEUTRAL Y

I 11 Illl:I 11 IEII:I 11 I3ID| 11 I4ID| 11 I5I|:|| 11 IEID| 11

ra progetki x

1 Muowo progetto
Muovo satkopragetto
7R CC 30y60 MC MEUTRAL WS
.|z Pagina 01
g SM 27127 MEUTRAL WS

]

Seite 02
Z| Seite 03

| |3PI 11 |%DI 11 |1IDI I |
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Il file attualmente aperto, ossia 'ultimo file che & stato aperto, appare al primo
posto nella sezione Apri della pagina iniziale.

Pagina iniziale |

Weidmiiller ~<_

.

1962150004.mpc
1962150003.mpc
1962150002.mpc
1962150001.mpc

< 1 i »
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Modifica del nome del progetto

Quando si apre un nuovo tipo di marcatore, si crea automaticamente una categoria di progetto a
cui viene attribuito normalmente il nome "Nuovo progetto”.
Se non viene visualizzato Esplora progetti, consultare il capitolo "Menu Visualizza".

Esplora progetti =

]

By s & ¢ +
= T Muovo progetto

=2 Pagina 01

Se si desidera modificare il nome del progetto, procedere come segue:

® Fare clic sulla categoria "Nuovo progetto”.

Fare clic su questo simbolo nella barra degli strumenti.
Se non viene visualizzata la barra degli strumenti "Proprieta”, consultare il
capitolo "Menu Visualizza".

Viene aperta la finestra "Proprieta”.

Proprieta x

R |

Muovo progetto

Generale

® Fare clic sul campo "Nuovo progetto" e sovrascrivere il nome del progetto con quello
desiderato.
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Aggiunta di un tipo di marcatore a un progetto

E possibile disporre diversi tipi di marcatore sotto un unico progetto.

Verra visualizzato il seguente menu di scelta rapida:

Posizionare il cursore in Esplora progetti e premere il pulsante destro del mouse (vedere il

capitolo "Finestra Esplora progetti").

Muovo progetto

Inserisci nuovo tipo di marcatore

Stampa...

Copia pagina
Inserisci pagina...

Sposta pagina...

Elimina questa pagina

Elimina pagine....

Modifica tipo di marcatore...

Visualizza

Chiudi file

Selezionare dal menu di scelta rapida la voce Inserisci nuovo tipo di marcatore. Seguire
le istruzioni contenute nelle finestre di dialogo successive. Il tipo di marcatore verra inserito

in Esplora progetti.

Esplora progetti x

Eada| # | L 9|+~
= '_"E_||Numr|:| progetto

=50 THM WRITE ON 18]12
Z=E Pagina 01

gl Pagina 01
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Aggiunta di un sottoprogetto

Per poter gestire meglio i tipi di marcatore di un progetto, & possibile disporre questi ultimi in
sottoprogetti.

Per inserire un sottoprogetto procedere come segue:

® Fare clic sul progetto principale, visibile al primo posto in alto, e premere il pulsante destro
del mouse.

Verra visualizzato il seguente menu di scelta rapida:

24 Copia

Muovo progetko
Jgi Inserisci nuowya bipa di marcakore

Inserisci nuova sotboprogetto

Stampa...

Elimina sotkoprogetto

Wisualizza L4

Chiudi File
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® Selezionare qui la voce del menu di scelta rapida Inserisci nuovo sottoprogetto.

Il sottoprogetto verra disposto sotto il progetto principale.

Esplora progetti x
Eagg| ¢ £ L 9 [+
= I_I Muoveo progetto

= Nuove sottoprogetto

= E—;‘,:ll THM WRITE OM 18/12

==E] Pagina 01
=5 SF 021
gl Pagina 01
=55 5F oof12
=% Pagina 01
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Assegnazione di un tipo di marcatore a un sottoprogetto

® Fare clic sul sottoprogetto e aggiungere, per mezzo del menu di scelta rapida, un nuovo tipo
di marcatore (vedere anche la sezione "Aggiunta di un tipo di marcatore a un progetto").

Se si desidera assegnare a un sottoprogetto un tipo di marcatore gia esistente, procedere come
segue:

® Fare clic con il pulsante sinistro del mouse sul tipo di marcatore che si desidera spostare.
® Tenendo premuto il pulsante del mouse, trascinare il tipo di marcatore nel sottoprogetto.

Il tipo di marcatore sara ora disposto sotto il sottoprogetto.
Esplora progetti x

By fu| ¢ 2| L 4 [+=
= i Nuove progetto
= {Ef Nuovo sottoprogetto

g Pagina 01
= E'E-!] THM WRITE QM 18112
=% Pagina 01
=15 SF Of21
=Z Pagina 01
=55 5F oof12
5 Pagina 0l
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Rimozione di un tipo di marcatore

® Fare clic sul tipo di marcatore che si desidera rimuovere e premere il pulsante destro del
mouse.

Copia

Muovo progetto

Inserisci nuovo tipo di marcatore

Stampa...

Elimina tipo di marcatore

Visualizza '

Chiudi file

® Selezionare nel menu di scelta rapida la voce Elimina tipo di marcatore.
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Rimozione di un sottoprogetto

® Fare clic sul sottoprogetto che si desidera rimuovere e premere il pulsante destro del mouse.

25| Copia

Jg,i Inserisci nuova tipo di marcatore

Inserisci nuova sotboprogetto

Stampa...

Elirina satkoprogetta

Wisualizza k

Chiudi file

® Selezionare nel menu di scelta rapida la voce "Elimina sottoprogetto".

é Verra rimosso il sottoprogetto con tutti i tipi di marcatore ivi disposti.
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Chiudi progetto

® Posizionare il cursore in Esplora progetti e premere il pulsante destro del mouse.

25| Copia

Jg,i Inserisci nuova tipo di marcatore

Inserisci nuova sotboprogetto

Stampa...

Eliriina satkoprogetta

Wisualizza k

Chiudi File |

® Selezionare nel menu di scelta rapida la voce "Chiudi file".

e Se il file non & ancora stato salvato, apparira un messaggio di avviso.
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Catalogo prodotti

Introduzione

Nel catalogo dei prodotti sono memorizzati tutti i prodotti, incluse le relative versioni, disponibili
nell’applicazione.

All'avvio del programma viene visualizzata automaticamente la finestra "Catalogo prodotti”. In
essa e possibile

® selezionare un tipo di marcatore,
® aprire l'ultimo progetto elaborato,
® aprire un progetto determinato.

La finestra "Catalogo prodotti" serve anche a organizzare i prodotti.

In questo modo ¢é infatti possibile salvare i prodotti utilizzati di frequente sotto una determinata
categoria di prodotto. A questo scopo creare una nuova categoria e aggiungere i prodotti
corrispondenti.

Il presente capitolo spiega come modificare il catalogo, come cercare un prodotto e come
eliminare prodotti e categorie.
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Apertura della finestra "Catalogo prodotti”

® Aprire il catalogo dei prodotti selezionando le voci di menu Strumenti > Catalogo prodotti.

Ordine n. stampa spedale:
Ordine n. zero:
EAN:

M. d'ordine stampa spedale del diente:

Informazione:

Classe dinfiammabilitd UL 94: V-2, Alogeni: No

1609810000

1609801044

4008190397111

Pagina Intemet del prodatto

Catalego prodotti *
Categoria  Tipe di marcatore  Cerca  Strumenti
2= 9@ 3 &% 06
Catalogo: @ Modello: O Variante:
£ Dekafix ~ | | Lista varianti
- EEE ;{g; PLLS DEK 5/5 MC NE WS
= 5‘,5 DEK 5/5 MC NE GE
| DEK 5/5 PLUS DEK 5/5 MC NERT
L DEK5/5S DEK 5/5 MC NE BL
1 DEK 5/6 DEK, 5/5 MC NE GM
4 DEK 5/6 PLUS DEK 5/5 MC NE GR.
9 DEK 5/8.5 DEK 5/5 MC NE OR
o DEK 5/6.5 PLUS DEK 5/5 MC NE VI
1 DEK 5(7.5 DEK 5/5 MC NE BR.
=1g_'| DEK 5/8 v DEK 5/3 MC NE SW v
Descrizione: Siglatura di morsetti, Weidmueller, lungh.x largh.: 5 x 5 mm, Passa in mm: 5,00, Materiale: poliammide 66,

Apri ultimo progetto Apri progetto... Apri ultimo modello Seleziona prodotto Chiudi catalogo

Nel caso in cui siano presenti delle informazioni sul prodotto, nella parte inferiore sinistra della
finestra sara visualizzata una descrizione della versione selezionata e i numeri materiali. Nella
parte inferiore destra della finestra sara invece possibile vedere una fotografia della versione
selezionata.

Facendo doppio clic sulla fotografia si aprira una finestra che riproduce il prodotto
ingrandito.

e La foto del prodotto pud differire dall'originale.

Facendo clic su Pagina Internet del prodotto verra visualizzata una scheda tecnica relativa al
prodotto presente su Internet. Questo collegamento sara visualizzato solo se € disponibile la
relativa scheda tecnica.

In questa finestra sono disponibili i seguenti pulsanti:
Facendo clic su questo pulsante viene aperto 'ultimo progetto

elaborato.
Il pulsante & disponibile solo dopo I'avvio del programma.

Apri ultimo progetto
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Apri progetto. .. Consente di aprire un determinato progetto (vedere il capitolo
"Struttura del progetto").
Il pulsante & disponibile solo dopo I'avvio del programma.

Apri ultimo modelo Aprire il modello aperto per ultimo.ll pulsante é disponibile solo
dopo l'avvio del programma.

Seleziona prodotto Con questo pulsante e possibile selezionare un determinato
prodotto.

Chiudi catalogo Chiude il catalogo dei prodotti.
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Creazione di una nuova categoria di prodotti

E possibile creare categorie personalizzate di prodotti in cui collocare tutti i marcatori utilizzati di
frequente. A questo scopo procedere come segue:

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti.

® Per aggiungere una nuova categoria, fare clic sul livello piu elevato ("Catalogo").
Per creare una sottocategoria, fare clic sulla categoria interessata. A questa verra aggiunta
la sottocategoria.

® Selezionare le voci di menu Categoria > Nuovo.

Verra cosi creata una nuova categoria.
Catalogo

H- ] Preferiti

-] MultiCard

-] MetaliCard

{7 MultiMark

-{_] Foglio

R oo cotegoria M

® |mmettere il nome desiderato per la categoria.

Ora € possibile assegnare alla categoria i prodotti desiderati (vedere la sezione "Aggiunta di un
prodotto™).
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Aggiunta di un prodotto

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti.

Verra visualizzata la finestra seguente.

v ) ¥

wenwendete D

Arbeitzplatz

Metzwerkumgeh

) configs

%] lab_ct_mte0_15%6

|#] lab_ct_mt60_16-5x5-05
|#] lab_ct_mte0_18x9

|®] lab_ct_mten_200E

|%] lab_ct_mt&0_22-G6x6-35
|%] lab_ct_mte0_25-4x12-7
|#]lab_ct_mte0_z6x10

|#] lab_ct_mt&0_30x20

|%] lab_ct_mt&0_31-75x9-53
|%] lab_ct_mte0_38-1x19-05
E] lab_ct_rata0_:

|#] lab_ct_mt&0_50-8x9-5
|#] lab_ct_mt&0_g0x15

|®] lab_ct_mt&0_g0x36

%] lab_ct_mt60_63-5x21-2

D ateiname:

%] lab_ct_mt60_71-5x49
|#]lab_ct_mb60_83-8x5-5
3 lab_eso_5_din_a4

3 lab_eso_5_poly

3 lab_eso 5 s

3 lab_eso_7_din_a4

3 lab_esa_7_paly

3 lab_eso_&_din_a4

3 lab_eso_14_6_din_a4
3 lab_eso_15_din_a4
|#]lab_et_s7-12_50-a¢
|#]lab_et_s7-300-a4-1
|#]lab_et_s7-300-a4-2
|#]lab_et_s7-300-tu-a4-2

%] lab_et_s7-400-ge-a4-1

lab_ct_mtE0_45:23

Dateityp: M-Print PRO Konfigurationsdatei [*.mef]

#

b

Fare clic sulla categoria alla quale si desidera aggiungere un prodotto.
Selezionare la voce di menu Aggiungi > Tipo di marcatore.

-

ﬂ lab_et_s7-400-ge-
|#]lab_st_s7-400-b0-,
|#]lab_et_s7-400-tu-,
|®]lab_et_s7-400-tu-,
|®]lab_Im_mt300_12x
|%]lab_Im_mt300_15x
|#]lab_Im_mt300_155
|#]lab_Im_mt300_15:5
|®]lab_Im_mt300_175
|%]lab_Im_mt300_20x
|#]lab_Im_mta00_25-
|#]lab_Im_mt300_26
|#]lab_Im_mt300_275
|®]lab_Im_mt300_30:

|%]lab_Im_mt300_S6x
>

Qui vengono visualizzati tutti i prodotti disponibili nell’applicazione, che sono stati collocati in una

cartella prevista a questo scopo.

e Il catalogo viene salvato automaticamente.

Fare clic sul prodotto desiderato e premere il pulsante Apri.
Il prodotto selezionato verra aggiunto alla categoria.

Uscire dal catalogo dei prodotti premendo il pulsante Chiudi catalogo.
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Rimozione di un prodotto

® Selezionare il prodotto che si desidera rimuovere.

® Fare clic sulle voci di menu Tipo di marcatore > Rimuovi nella barra dei menu della finestra
"Catalogo prodotti".

® || prodotto viene rimosso dal catalogo quando l'utente risponde affermativamente al
messaggio di conferma.

Il prodotto viene eliminato SOLO dal catalogo.
Esso rimane comunque presente nella directory dell’applicazione e pud essere
inserito nuovamente in qualunque momento.

Rimozione di tutti i prodotti da una categoria

Fare clic sulla categoria dalla quale si desidera rimuovere tutti i prodotti.
Selezionare le voci di menu Categoria > Vuoto.

® | a categoria viene svuotata quando l'utente risponde affermativamente al messaggio di
conferma.

| prodotti vengono eliminati SOLO da questa categoria.
Essi rimangono comunque presenti nella directory dell’applicazione e possono
essere inseriti nuovamente in qualunque momento.

Rimozione di una categoria di prodotto

® Fare clic sulla categoria e selezionare le voci di menu Categoria > Rimuovi.

® | a categoria viene rimossa quando l'utente risponde affermativamente al messaggio di
conferma.
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Ricerca di un prodotto

E possibile utilizzare la funzione di ricerca dei prodotti quando si desidera selezionare un nuovo

tipo di marcatore senza conoscerne il nome o il numero materiale.

La funzione di ricerca non puo essere utilizzata per inserire un prodotto nel catalogo (vedere a
guesto proposito "Aggiunta di un prodotto™).

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti.

Verra visualizzata la finestra per la ricerca dei prodotti;

Selezionare la voce di menu Cerca

3 Cerca X
Variante:
Risultat:
Variante /| Ordinen.zero | EAN Des
< >
Ok Annulla
[ J

Immettere nel campo "Variante" il nome del prodotto.

Dopo aver inserito almeno due caratteri tutti i prodotti con i caratteri ricercati vengono

visualizzati nell'elenco dei risultati.

F Cerca
Variante:
[cc
Risultati:
Variante /| Ordine n.zero | EAN
CC 15/45 MM W 2005570000 4050118391343
CC 15/45 MM WS 2005500000 4050118390889
CC 15/49 K MC NE GE 1131970000 4032243912124
CC 15/49 K MC NE GR 1079580000 4032248340687
CC 15/49 KMC NERT 1288380000 4050118079750
CC 15/49 K MC NE 51 1877270000 4032248467921
CC 15/49 K MC NE WS 1877220000 4032248467735
M AC AN RAC IE FE AMTSATINNNIN ANTIIVADOICCALCT
< >
ol

Evidenziare il prodotto desiderato facendo clic su di esso e confermare la selezione con OK.
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Rinominare un prodotto

Per attribuire a un prodotto del catalogo un nome diverso (ad es. interno all'azienda), € possibile
rinominare il titolo e/o il nome della variante di tale prodotto.

I nomi delle varianti cosi rinominate verranno ad esempio visualizzate nei seguenti luoghi:
- Tra le proprieta (vedere il capitolo "Proprieta del marcatore", sezione "Generale").
- Nella finestra di dialogo di stampa (vedere il capitolo "Richiamo del menu di stampa").

Per rinominare un prodotto procedere come segue:

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti.
Selezionare il tipo di marcatore.

Evidenziare il titolo o il nome della variante e premere il tasto "F2".

Attribuire un nuovo nome e applicare l'immissione con il tasto INVIO.

Il nome viene adattato quando l'utente risponde affermativamente al messaggio di conferma.
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Modelli

I modelli (template) sono tipi di marcatore adattati e salvati.
Analogamente ai tipi di marcatore, i template possono essere salvati come modelli di progetto e
utilizzati in numerosi settori (ad es. per l'importazione).

E possibile ad esempio inserire ulteriori elementi (ad es. campi di testo, campi di immagini e di
codici a barre) in un tipo di marcatore e salvare questa impostazione in un file di modello in
formato *.mpt.

Osservare le seguenti proprieta dei file di modello:
® | modelli consistono in UN SOLO tipo di marcatore
® | modelli contengono UNA SOLA pagina

Salvataggio di un modello

Aprire un tipo di marcatore e apportare le modifiche desiderate.
Richiamare il menu File > Salva con nome....
Selezionare come formato file "M-Print® PRO Template (*.mpt)".

Salvare il file nella directory predefinita per i modelli (vedere capitolo "Opzioni", sezione
"Directory") per visualizzarla automaticamente nel catalogo prodotti.

6 Se si desidera definire degli elementi ulteriori per i modelli, osservare quanto
segue:
® Se possibile utilizzare campi specifici per i singoli campi 0 campi documenti
(vedere il capitolo "Finestra Proprieta™).

® Se siintende adattare singole proprieta (colori, stili dei caratteri ecc.) degli
elementi, impostarle come "predefinite”.
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Organizza modelli in categorie

® Aprire il catalogo dei prodotti selezionando le voci di menu Strumenti > Catalogo prodotti.
® Selezionare l'area Modello.

Catalogo prodotti

Categoria  Tipo di marcatore  Cerca  Strumenti

- i Ll

Catalogo: () Modello: (@)

Se l'opzione non e visualizzata, salvare un modello nella directory predefinita. Vedere il capitolo
~Salvataggio di un modello®.

Creazione di una nuova categoria
® Per aggiungere una nuova categoria, fare clic sul livello piu elevato ("Catalogo™).

Per creare una sottocategoria, fare clic sulla categoria interessata. A questa verra aggiunta
la sottocategoria.

® Selezionare le voci di menu Categoria > Nuovo.

Verra cosi creata una nuova categoria.

-55 template_a_01.mpt
..... S template_a_02.mpt
----- j;q template_a_03.mpt
----- j;’;] template_a_11.mpt
..... e template_a_12.mpt
. _-,';'l,ltemplate_a_llmpt
----- e template_b_41.mpt
..... “r template_b_ 42 mpt
..... S template_b_43.mpt

----- i Bluova categoria

® |mmettere il nome desiderato per la categoria.

Ora ¢ possibile assegnare i modelli desiderati alla categoria. Vedere il capitolo ,Sposta modelli in
categorie®.
Sposta modelli in categorie

® Selezionare un modello con il tasto destro del mouse e trascinarlo in una categoria
desiderata (drag and drop).

® Selezionare “Sposta” nella casella di dialogo che appare.
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2 aa sposta
.%[}éj Annulla
B[ b

. template_a_01.mpt

i template_a_02.mpt
template_a_03.mpt

Esempio:
template_a_01.mpt =) {'j a
template_a_02.mpt EI r:nl O

gl template_a_01.mpt
gl template_a_02.mpt
template_a_03.mpt

EIFj'ln

template_a_03.mpt
template_a_11.mpt
template_a_12.mpt
template_a_13.mpt

template_b_41.mpt
-5 template_b_42.mpt
-5 template_b_43.mpt

template_a_11.mpt

template_a_12.mpt

template_a_13.mpt

= {‘j b

g2l template_b_41.mpt
‘ template_b_42.mpt
.5 template_b_43.mpt
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Rimozione di un prodotto
e Fare clic sulle voci di menu Tipo di marcatore > Rimuovi nella barra dei menu della

finestra "Catalogo prodotti".
o Il prodotto viene rimosso dal catalogo quando l'utente risponde affermativamente al

messaggio di conferma.

Quando si rimuove una categoria, i modelli in essa contenuti NON vengono
eliminati, ma vengono visualizzati di nuovo sotto la categoria superiore.

Ja B3 a
= - _-E':,l template_b_41.mpt
i template_b_41.mpt -" 53 template_b_42.mpt
-5 template_b_42.mpt .58 template_b_43.mpt
E-;",l template_b_43.mpt

i
o
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Ripristinare il catalogo prodotti

Se sono state inavvertitamente cancellate configurazioni dal catalogo prodotti o € stato caricato
un nuovo file di catalogo (*.mca), & possibile ripristinare il catalogo prodotti.
Contemporaneamente vengono ripristinate allo stato iniziale tutte le altre cartelle, fino alla
cartella "Preferiti". | contenuti della cartella Preferiti e i modelli vengono conservati.

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti.
® Selezionare la voce menu Strumenti > Ripristina catalogo
® Confermare la domanda di conferma di sicurezza
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Aggiornare il catalogo prodotti

E possibile aggiornare il catalogo prodotti con nuovi file di configurazione rielaborati.
A questo scopo procedere come segue:

® Aprire il catalogo dei prodotti mediante il menu Strumenti > Catalogo prodotti...

® Selezionare la voce di menu Strumenti > Aggiungere/aggiornare prodotti...

Viene visualizzata la finestra per la ricerca di configurazione:

3F Aggiungi/aggiomna prodott

eS|

Origine

Cartella di ricerca:

Searching
Current Search Folder:

| Files Found:

Files to Update:

C:\ProgramData\update_configs

2490 3

214

214 prodott (selezionato: 3) 6

4

Risultato della ricerca (prodott nuovi o aggiornati)

1 Gy

Mome file

mc_cc-m_15_45-2.mcf
mc_cc-m_15_45-2_uni.mcf
mc_cc-m_15_45.mcf
mc_cc-m_15_45_uni,mcf
mc_cc-m_15_60-2.mcf
mc_cc-m_15_60-2_uni.mcf
mc_cc-m_15_60.mcf
mc_cc-m_15_60_uni,mcf
mc_cc-m_18_52 2w 3.mcf

Percorso

C:'ProgramDatai
C:\ProgramData i
C:'ProgramDataiy
C:'ProgramDataiy
C:\ProgramData i
C:'ProgramDataiy
C:'ProgramDataiy
C:'ProgramDatai
C:'ProgramDataiy
I

-~

-

Tipo di marcatore Versione
|:| CC-M 15/45-2 20121025
[] cc-wis/45-20mi - 20121025
CC-M 15/45 20121025
5 CC-M 15/45 Uni 20121025
CC-M 15/50-2 201210325
[ ccwisfso-2umi 0 20121025
|:| CC-M 15/60 20121025
|:| CC-M 15/60 Uni 20121025
[ ccamis/s2 243 201210325
4 |
7 Applica
1 —
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A questo scopo procedere come segue:

1 Cartelladiricerca

Selezionare la cartella di ricerca nella quale sono memorizzati i nuovi file di
configurazione.

2 Cercaora

Per la ricerca dei file di configurazione fare clic su "Cerca ora" nella directory
selezionata.

3 File trovati
Numero di file trovati dopo la procedura di ricerca.

4 File da aggiornare
Numero di file nuovi o pit aggiornati.

5 Selezionare prodotti
Selezionare le configurazioni desiderate.

6 Numero di file selezionati
Nella visualizzazione é visibile il numero di file selezionati.

7 Acquisisci
Fare clic su "Acquisisci” per copiare le configurazioni selezionate nel proprio
catalogo prodotti.
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Finestra di dialogo Opzioni

Introduzione

Il presente capitolo illustra le impostazioni di base che é possibile definire mediante la Finestra di
dialogo Opzioni.

® Richiamare la finestra di dialogo Opzioni mediante il menu Strumenti > Opzioni...

Opzioni *
£3 Ambiente Avvio del programma

(3 Sostituzioni Elenco della cronelogia degli ultimi file: 4 ~
(1 Legging Unita di misura: mm ~

3 Impostazioni standard elementi
[C3 Modalita di stampa automatica
[C1 Dispositivi di output

23 Plotter

(3 Printlet MINI

(3 Printlet CONMNECT

(2 Printlet ADVANCED

(2 Printlet PRO

(23 Smart Laser RL

(1 Stampante THM

(3 Supporto

Mome_filestandard |

Min

Attivare salvataggio automatico file:

[ utilizza la modalits di progetto di default
Visualizza tutti | messaqai disattivat
Chiudi il progetto alla chiusura dellultimo tipo di cartelino
Attiva il riconosdmento overflow (mportazione, stampa)
Adatta dimensioni font
Adatta stringhe
[ attivare linterruzione di un processo di stampa (tramite riga di comanda)
[ visualizza un processo di stampa (tramite riga di comanda)
Attiva pagina info
Indudi automaticamente nuove immagini
Pagina di separazione in caso di stampa su tubi flessibili & contrazione di tipe
D Stampa immediata avanzata
Aggiorna automaticamente vista icone
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Ambiente

Le impostazioni delllambiente definiscono la vista e le impostazioni di base generali.

Generale

Avvio del programma
Elenco della cronologia degli ultimi file: 4 o

Unita di misura: mm w

Mome_filestandard |

Attivare salvataggio automatico file: Min.
[Jutilizza la modalita di progetto di default
Visualizza tutti | messaqggi disattivati
Chiudi il progetto alla chiusura dell ultimo tipo di cartellino
Attiva il riconoscimento overflow (importazione, stampa)
Adatta dimensioni font
Adatta stringhe
[] attivare linterruzione di un processo di stampa (tramite riga di comanda)
[Jvisualizza un processo di stampa (tramite riga di comanda)
Attiva pagina info
Indudi automaticamente nuove immagini
Pagina di separazione in caso di stampa su tubi flessibili a contrazione di tipe
|:| Stampa immediata avanzata
Aggiorna automaticamente vista icone

Elenco della cronologia degli ultimi file
Nel menu File e nella pagina iniziale viene visualizzato I'elenco degli file del progetto aperti di
recente.

Unita di misura
Qui viene impostata I'unita di misura utilizzata in tutto il programma (pollici, mm, cm, pm).

Nome file standard
Preimpostazione di un nome file proposto alle voci "Salva" e "Salva con nome".

Attiva salvataggio automatico file
Il file viene salvato automaticamente dopo un intervallo di tempo selezionato.

Utilizza la modalita di progetto di default

La Modalita progetto € disponibile solo per i tipi di marcatore che dispongono di un livello del
progetto.

In questa modalita, se piu marcatori di progetto presentano la stessa siglatura, vengono siglati solo
i primi.

Modalita progetto: NO
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Se a un marcatore viene attribuita (ad es. mediante la griglia dei dati) una nuova siglatura di
identificazione progetto (ad es. "P1a"), a partire da questo marcatore viene creata una nuova
identificazione di progetto (marcatore del progetto).

| |

FROECT MURKER
] P1 1
] 2
L] 3
L] 4
| 5
G
T
&
Pla 9
10
| 11
| 12
0 13

Visualizza tutti i messaggi disattivati
Le caselle di controllo "Non ripetere piu la domanda" o "Non visualizzare piu questo messaggio”
consentono di disattivare alcune finestre di dialogo.

® Apponendo qui un segno di spunta e facendo clic su Applica & possibile visualizzare di nuovo
TUTTE le finestre di dialogo.
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Chiudi il progetto alla chiusura dell’ultimo tipo di marcatore

Se ¢ visibile un segno di spunta, il progetto viene chiuso alla chiusura dell’ultimo
registro (vedere "Interfaccia del programma").

In caso contrario € possibile aprire nuovamente le schede mediante la struttura del
progetto.

Attiva il riconoscimento overflow (importazione, stampa)

Se e visibile un segno di spunta, dopo una importazione o prima della stampa il
programma verifica automaticamente se siano raffigurati tutti i caratteri di un campo.
In caso di esito negativo, i campi vengono raffigurati come segue (vedere anche
':Adatta dimensioni font", "Adatta stringhe"):

PECOERG
Ve HLl g

Attivare l'interruzione di un processo di stampa (tramite riga di comando)

Se é applicato il segno di spunta, durante la stampa di un file attraverso la riga di
comando (vedere "Prompt della riga di comando") il processo di stampa pud essere
interrotto mediante una finestra di dialogo.

Visualizza un processo di stampa (tramite riga di comando)

Se e applicato il segno di spunta, durante la stampa di un file attraverso la riga di
comando (vedere "Prompt della riga di comando") il processo di stampa pud essere
visualizzato.

Attiva pagina delle informazioni
Accanto ai numeri di pagina viene visualizzata anche una pagina informativa sul layout
del tipo di marcatore.

Includi automaticamente nuove immagini

Quando si inserisce un nuovo elemento immagine, l'immagine viene incorporata
automaticamente invece di essere collegata attraverso un percorso.

Quando si inoltrano file di programma, tutte le immagini di origine sono presenti
automaticamente.

Per togliere successivamente da un file le immagini integrate e salvarle, vedere il
capitolo "Estrarre immagini dai file".

Pagina di separazione in caso di stampa su tubi flessibili a contrazione di tipo
HSS

In presenza di piu processi di stampa su tubi flessibili a contrazione di tipo HSS
inserisce automaticamente una pagina di separazione (vuota).

Stampa immediata avanzata
Se ¢ visibile un segno di spunta, in caso di stampa immediata & possibile selezionare il numero
di copie. Vedere il capitolo ,Stampa rapida“.
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Visualizza

Impostazioni griglia

Dimensioni griglia: 2 mm
Spostamento griglia X: 0 mm
Spostamento griglia : 0 mm

Caolore griglia: :l E

Livello / Progetto

Visualizzare solamente solo il primo marcatore di un progetto

Muostra visualizzazione dati all'avvio

[ selezione automatica del livello nel quale & stato selezionato un oggetto

Visualizza overflow e interruzione di riga

Attiva modifica impostazioni stampante

@ Mai ) Sempre 1 Solo questa sessione

Impostazioni griglia
Le impostazioni per la griglia (vedere il capitolo "Menu Visualizza").

Visualizza solo il primo marcatore di un progetto
Se un marcatore di progetto presenta contenuti identici, viene mostrato solo il primo
contenuto.

Mostra griglia dei dati all'avvio
All'awvio del programma viene sempre visualizzata la griglia dei dati.

Selezione automatica del livello nel quale € stato selezionato un oggetto

Se ¢ visibile un segno di spunta, & possibile passare automaticamente dal livello del
progetto al livello del marcatore e viceversa facendo semplicemente clic con il mouse.
In caso contrario € necessario eseguire la commutazione mediante la barra degli
strumenti predefinita (vedere il capitolo "Barre degli strumenti").

Visualizza overflow e interruzione di riga

| campi il cui contenuto non pud essere visualizzato completamente o che contengono
un'interruzione di riga automatica vengono contrassegnati come segue (vedere
(I:apitolo "Fase 3: dotare di dicitura un marcatore"):

A116 | ‘n234se;
A5 _ .| | 788

Attiva modifica impostazioni stampante
Stabilisce se il pulsante "Impostazioni ..." & selezionabile nella finestra di dialogo di
stampa (vedere "Stampa", sezione "Richiamo del menu di stampa").
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Lingua dell'applicazionecambiare lingua dell'applicazione

Dopo aver installato i setup della MUI (Multilingual User Interface) pud essere selezionata una
diversa lingua dell'applicazione tramite il campo di selezione.

lingua dell'applicazione

Seleziona lingua: ITALIAMO b ]

Se nel campo di selezione non fosse selezionabile alcuna altra lingua, €
necessario installare language pack aggiuntivi tramite il setup.
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Avvio del programma

|Utente con privilegi avanzati®

Mome del utente con privilegi avanzati: P

Seleziona profilo utente con privilegi avanzati...

E necessario disporre dell'autorizzazions di amministratore del computer per
poter eseguire questa operazione,

* Per applicare le modifiche & necessario riavviare il programma.

Avvio del programma

(®) Apri catalogo

() Apri |ultimo progetto

(i visualizza finestra di dialogo Apri file

() Mantieni finestre chiuse

Utente con privilegi avanzati

Durante la configurazione, & possibile inserire il nome utente di Windows di un utente
nel campo "Superuser”. Tutte le impostazioni del programma effettuate da questo
utente (impostazione dei percorsi, calibrazione delle stampanti, ecc.) vengono recepite
come impostazione centrale per tutti gli altri utenti registrati.

Impostazioni individuali del programma di tutti gli altri utenti:
e Llingua dell'applicazione.
Vedere il capitolo “Llingua dell'applicazione®.

Il pulsante pud essere utilizzato per selezionare un altro superuser.
Nota: E necessario disporre dell'autorizzazione di amministratore del computer per
poter eseguire questa operazione. |l processo viene eseguito per ogni utente al riavvio

del programma.

Nota: Un nuovo profilo deve sempre essere aggiunto tramite il pulsante "Seleziona
profilo utente con privilegi avanzati...".

!3 Seleziona profilo utente con privilegi avanzati X

Elenco dei profili:

User Name /| Nome file

Lser app_settings_User,xml

Seleziona profilo utente con privilegi avanzati.. .

Avvio del programma
Con questa voce € possibile istruire il comportamento all'avvio del programma.
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Importa

Estensioni file

Estensione file File script
THK

TXY

HLS

JHLSY

m
il

Aggiungi... Maodifica... Attribuisd file

o

Striscia a modulo continua

Lunghezza marcatore predefinita: mm

{®) Lunghezza fizsa marcatore

() Lunghezza dinamica marcatore

Maostra la schermata iniziale dellimportazione guidata
[IMostra 'assistente dimportazione (tramite linea di comanda)
[Jimportazione del testo di progetto nei marcatori

[ utilizzare I'assistente E-Plan ampliato

[ utilizza nome elementa con WMEX

[Jimpartazione su due lati (THM MultiMark Twin)

[] compatibilita UTF-8

[ "] Dopo limportazione rimuovi gli & capo alla fine della riga

Estensioni file
Qui e possibile collegare varie estensioni di file a un file script.

Quando il programma apre il file (ad es. dalla riga di comando), il file script viene eseguito
automaticamente.

Attribuisci file

| file possono essere aperti automaticamente con l'ausilio del mouse dal programma. A
tal fine & necessario aggiungere l'estensione del file (ad es. ".xIs") alla lista e fare clic
sul pulsante "Associa file".

In tal modo tutte le estensioni dei file vengono registrate sul programma.

Striscia a modulo continuo

Le strisce a modulo continuo devono essere ulteriormente specificate attraverso
un’altra finestra di dialogo quando vengono aperte dal catalogo. Vedere il capitolo
»otrisce a modulo continuo®.

Se si selezionano le strisce a modulo continuo durante un‘importazione, questa
finestra di dialogo aggiuntivo non pud essere visualizzata. Per I'importazione vengono
invece usati come predefiniti i valori qui visualizzati. Vedere il capitolo ,Fase 3:
Selezione del progetto e delle varianti®.

Mostra la schermata iniziale dell'importazione guidata

Mostra l'assistente d'importazione con XML

| file XML possono essere importati oppure aperti dalla riga di comando (vedere il
capitolo "Prompt della riga di comandao").

Se & visibile un segno di spunta, durante l'apertura mediante riga di comando viene
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visualizzato l'assistente d'importazione. Altrimenti l'importazione viene eseguita tramite
le impostazioni predefinite o un file script (vedere il capitolo "Importazione di file").

Importazione del testo di progetto nei marcatori
Se e visibile un segno di spunta, i testi che dovrebbero essere aggiunti al livello del
progetto, vengono invece aggiunti alle aree del marcatore.

Utilizza I'assistente E-Plan ampliato

Se ¢ visibile un segno di spunta, durante lI'importazione di file WEXx con l'assistente
d'importazione viene visualizzata anche la pagina contenente i delimitatori.

Nei file WEX i delimitatori sono normalmente fissati e non dovrebbero essere
modificati.

Utilizza nome elemento con WMEX
Se la casella € selezionata, quando si aprono i file *.wmex vengono utilizzati i nomi
degli elementi.

Importazione su due lati (THM MultiMark Twin)
Se la casella e selezionata, & possibile importare sia sul lato anteriore che sul lato
posteriore.

Compatibilita UTF-8
Codifica dei caratteri personalizzata, se i caratteri speciali non vengono visualizzati
correttamente.
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Directory

Directory

Apri file: | imDataWeidmueler\M-Print PRO\datah, @ |
Salva file: | imDataWeidmuellerM-Print PRO \data', e} |
Importa: [ | ultima directory utlizzata @
Catalogo: | sta\Weidmueller \M-Print PRC\productst, @
Simbaoli: | iataiWeidmueller M-Print PROsymbaolsh @
Immagine: | Data\Weidmueller YM-Print PROYmages), Ey |
LPC Immagine: | WeidmueleriM-Print PROYpcproducts’, Ey |
Modelli: | ta W eidmueller M-Pring PRO \templates, e |
Scripts: [1 | ultima directory utlizzata @

Impostazioni directory avanzate

Impostazioni di programma

Esporta... Importa...
Directory
| settori visualizzati vengono cercati per impostazione predefinita nelle directory
impostate.

La directory "LPC Immagine" & valida solo per la modalita LPC standalone. Vedere il
capitolo “Stampa LPC*.

Impostazioni directory avanzate
Se e visibile un segno di spunta, alcuni percorsi standard possono essere
deselezionati. Viene invece utilizzato I'ultimo percorso utilizzato nell'area.

Impostazioni di programma

Le impostazioni di programma che sono state modificate possono essere salvate
(esportate) e/o caricate (importate).

E possibile ad esempio applicare ad altri posti di lavoro delle impostazioni adattate in
base a criteri interni della ditta.

Impostazioni di programma che possono essere salvate sono ad esempio:

- Aggiornamento

- spostamento della griglia durante la duplicazione (vedere "Visualizza")

- humerazione automatica (ultimi valori della finestra di dialogo)

- Importa

- assistente d'importazione (ultimi valori della finestra di dialogo)

- assegnazione della stampante a determinati tipi di marcatore (vedere "Assegnazione
della stampante a un tipo di marcatore")
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- Gruppi di stampanti

- adattamento di valori predefiniti a determinati tipi di marcatore

- calibrazione delle impostazioni della stampante (ad es. correzione della stampante,
dilatazione del materiale, impostazioni per il tipo di marcatore)
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Amministrazione

Trasferisc impostazioni stampante

Trasferisce le impostazioni da un dispositivo di output a un altro dispositive
compatibile,

Trasferisd impostazioni stampante. ..

Trasmettere le impostazioni di stampa

Fare dic su “trasmettere le impostazioni di stampa®, per rendere disponibili le
impostazioni attuall per lastampa da parte di altri utenti di guesto computer,

- Esegui la correzione della stampante. ..
- Correggere lo scorrimento del materiale.. .
- Calibrazione stampanteplotter

Gli utenti possono decidere se vogliono applicare queste impostazioni,

trasmettere le impostazioni di stampa

Proteqgai impostazioni di stampa
Vecchia password: |

MNuova password: | |

Conferma nuova passwoard: | |

Trasferisci impostazioni stampante

Trasferisce le impostazioni da un dispositivo di output a un altro dispositivo compatibile.
Se una stampante deve essere sostituita, le assegnazioni dei materiali possono essere
trasferite. Vedere il capitolo ,Assegnazione della stampante a un tipo di marcatore®.

Trasferisci impostazioni stampante *
Dispositivo di origine: Printer 1 ~
Dispositivo di destinazione: Printer 2 (new) ~

[ impostazioni stampante {ad es. Calibratura)

D Assegnazione materiale

Applica Annulla

Trasmettere le impostazioni di stampa
Vedere il testo descrittivo nella finestra di dialogo.

Proteggi impostazioni di stampa

Per proteggere le impostazioni calibrate della stampante da eventuali modifiche, &
possibile definire una password.

Prima di ogni tentativo di modifica dei valori della stampante viene visualizzata una
richiesta di conferma della password.

Dopo linstallazione NON viene richiesta alcuna password.
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Menu Amministrazione

Le singole voci menu possono essere nascoste oppure possono essere aperte con una
protezione mediante password.

Meni Administration™®

FERK 2
Menueintrage Status
Verfiigbar -/
Diatei-=Offnen Werfiighar |
Datei-=Speichem Verflgbar
Datei->Speichem unter Verflgbar
Datei-=Bilder einbetten und speiche... Geschitzt
Datei-=Schlieben Verflgbar
Datei-=Importieren Micht verfUgbar
Datei-=Stapelimpart Verflgbar
Datei->Drucken Verflgbar
Datei-=Plot Modus umschalten VerfUgbar

Datei-=Markieretyp einmessen Verflgbar 18

* Um die Anderungen zu Obernehmen ist ein Meustart des Programms
erforderlich.

& Imposta tutti disponibili
Tutte le voci menu sono visualizzate e possono essere richiamate.

= Impostatutti protetti
Tutte le voci menu sono visualizzate, perd possono essere richiamate solo dopo
aver inserito una password.

B, Impostatutti non disponibili
Tutte le voci menu non sono visualizzate e non possono essere richiamate.

Istruzioni per l'uso Finestra di dialogo Opzioni ¢ 191



% Imposta password
Si apre una finestra di dialogo per impostare o modificare una password.
Dopo l'installazione NON viene richiesta alcuna password.

Nota: se si assegna una protezione mediante password per singole voci menu,
€ necessario proteggere anche la voce menu "Impostazioni -> Opzioni" in modo
da rendere impossibile la reimpostazione illecita della password.

Reimposta password

Fare clic su | digitare la password corrente e lasciare vuoti i campi per la
nuova password. Applicare l'immissione con OK.

Stato

Disponibile: La voce menu viene visualizzata.

Non disponibile:  La voce menu non viene visualizzata.

Protetto: La voce menu viene visualizzata, ma viene aperta solo dopo

aver inserito una password.

Aggiornam entoDefinizione delle impostazioni per l'aggiornamento.

Cercare aggiornamenti

{#) Mon eseguire il controllo aukomatico degli aggiormamenti
{:} ercare aggiornamenti ad ogni avwvio di programma
{:} Cercare aggiornamenti ogni:

Giorni

Cercare “eaggiornarmenti...
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Codifica colori

Definizione delle codifiche colori per i numeri da 0 a 9 (vedere anche "Caodifica colori").

Cifre della codifica colari

Sfonda Tipo di carattere

Reset

L4 ]

o
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Campi
Si stabiliscono le diverse impostazioni dei campi, per esempio settimana del calendario.

Impostazione setiimana n™

Prima settimana dellanno: |ISD 8501 e |
Prefisso: Formato settimana numero: Suffisso:
| [ ~| Lo ] fer ~ | |

Mumerazione pagine
[=] attiva numerazione delle pagine (MultCards)
Formato: @ Pagina ###F
() Pagina #&# di #5%

Posizione: (®) Primo identificatore progetto

() Ogni identificatore progetto

Attiva numerazione delle pagine (MultiCards)
Per il materiale appena aggiunto viene inserita una numerazione di pagina al livello libero.
Questo vale solo per le MultiCard.

Esempio:

L Illnl 1 I%Ul 11 I3Icl [ I4i0| L I5|CI| L IEIcl 1 I?Inl 11 Ialnl [ IglcI | I]Tnlnl | Illllnl | Il

lin

lagn

JI | 1 |?IUL 1| |Elull | |5IUI 11 |4PI 11 |3PI 11
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Impostazioni di base

Si stabiliscono diverse impostazioni di base.

Duplizieren
Verschiebung X: 2 mm
Verschiebung 2 mm

Werte automatisch Hoch-Herunterzahlen

Hochzahlen 1
Herunterzahlen 1
Duplica

| valori dello scostamento dell'oggetto duplicato (vedere il capitolo "Menu Modifica").

Numerare in avanti / numerare all'indietro
Imposta i valori predefiniti per numerare in avanti o all'indietro (vedere il capitolo
"Numerare in avanti e numerare all'indietro").
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Sicurezza

| livelli di sicurezza per I'apertura e il salvataggio dei file del programma possono essere

impostati.
Sicurezza
Versione file in fase di salvataggio: Versione 9.2 ~
versione file all'apertura; Formato »=9.2 w

Se |a versione del file non & univoca (ad es. manca la SHA):

Visualizza messagai di errore

[ apri file non univec

Rianvviare M-Print® PRO e tuthi i moduli avviati (ad es. monitor di stato), per
accettare le modifiche.

Versione file in fase di salvataggio:

® Versione 9.2 — Livello di sicurezza massimo
| file vengono salvati come segue:

® con crittografia AES ,
® con SHA-Hash

L'apertura di questi file non & piu possibile nelle versioni del programma inferiori a V 9.0.

® Versione 9.0 — Livello di sicurezza medio
| file vengono salvati come segue:

® con crittografia AES

L'apertura di questi file non & piu possibile nelle versioni del programma inferiori a V 9.0.

® Vecchio formato — Livello di sicurezza minimo
| file vengono salvati come segue:

® formato ZIP protetto da password

Versione file all’apertura:

® [Formato >= 9.2 — Livello di sicurezza massimo
| file possono essere aperti con le seguenti versioni del programma:

® versione 9.2
® (o versioni pit recenti

® Formato >= 9.0 — Livello di sicurezza medio
| file possono essere aperti con le seguenti versioni del programma:

® Version 9.0, 9.2
® (o versioni piu recenti

® Vecchi file — Livello di sicurezza minimo
Tultti i file vengono aperti.
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e | file di programma possono essere convertiti tra le diverse versioni.
Vedere il capitolo ,Menu Strumenti®.

Visualizza messaggi di errore
Viene visualizzato un messaggio di errore quando si aprono file danneggiati (ad es. file vecchi o
file manipolati con specifiche SHA mancanti o errate).

Apri file non univoci
| file che non sono univoci possono comunque essere aperti (se la fonte & nota, per esempio).

Nota: Per cambiare le impostazioni di sicurezza, avviare il software "come amministratore".
Devono essere disponibili i diritti di accesso (lettura/scrittura) alla seguente directory:
,ProgramFiles\misc”
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Sostituzioni

Sostituzioni di testo

Sostituisc
¥ |
Cerca Sostituisd
<br= Yin
rin Yin
r Yin
in Yin

Inverti ordine testo

Utilizza le funzioni avanzate per invertire l'ordine del testo

Simbali di divisione | |

Sostituisci

Quando si incolla del testo dagli appunti o dopo l'importazione dei dati, i caratteri definiti in
guesto elenco vengono sostituiti | caratteri definiti in questo elenco vengono sostituiti come
ultimo passo di un'importazione di dati. La stringa di caratteri "\r\n" nella colonna "Sostituisci"
genera un vero e proprio ritorno a capo automatico (CRLF) nel risultato dell'importazione.

Inverti ordine testo

Attiva la funzione estesa per invertire I'ordine del testo. | testi vengono scambiati in sequenza
sulla base di un modello di ripartizione selezionabile. Vedere il capitolo ,Menu Inserisci®.

| testi vengono scambiati solo al primo modello di ripartizione trovato.

Esempio: Simboli di divisione "|"

l 123]ABC 1 ABC|123 ]
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Sostituzioni di immagini

Sostituisd

1] 7] ] (][]

Cerca Sostituisd

D Incorpora immagini sostituite

Quando vengono sostituite delle immagini viene inserito un percorso immagine in un oggetto
immagine. Se limmagine si trova nella directory predefinita dei simboli (vedi "Directory"), &
sufficiente inserire il nome del file.

Esempio:

|m| S <« shared » symbols v &

shared -

filter
GRAPHIC1

scripts

symbaols
templates
=] temp

Tipo

File
g Forte di dati

Sostituisci

[l ] ] 1

Cerca Sostituisci
. .
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Logging

Attivare il logging per questo modula

File di log:

Livello di logging: Errori b

Durata: 5 == | Giornoji

Rigvviare M-Print® PRO, per accettare le modifiche,

La funzione di logging puo essere impostata per i seguenti moduli:
e M-Print® PRO

Monitor di stato

Servizio Monitor di stato

LPC-Tool

Durata:
Per ridurre al minimo le dimensioni del file, i dati di pit vecchia data vengono eliminati dal file di

log.

Impostazioni standard elementi

Attraverso le impostazioni predefinite degli elementi si possono stabilire determinate proprieta
per la creazione degli elementi (per esempio campo di testo, rettangolo, immagine, codice a
barre). Queste impostazioni vengono salvate localmente sul computer.
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Tipo di carattere

Tipo di carattere™®
Font:

Dimensioni:
Colore font:
Grassetto:
Corsivo:
Sottolineato:

Barrare:

Anteprima

(Predefinito)

| (Predefinito)

(Predefinito)
(Predefinito)
(Predefinito)

(Predefinito)

(Predefinito) e

AaBbCcDd1234

Utilizza font config

* Per applicare le modifiche & necessario riavviare il programma.

Tipo di carattere:

Selezionare qui il tipo di carattere che viene utilizzato come carattere privilegiato

durante I'aggiunta di nuovi tipi di marcatore a un progetto. Non vengono utilizzati i tipi
di carattere definiti nei file di configurazione.
Questa impostazione viene applicata solo al riavvio del programma.

Utilizza tipo di carattere della configurazione
Ripristina il tipo di carattere selezionato mediante "Tipo di carattere".
Vengono percio utilizzati i tipi di carattere dei tipi di marcatore man mano aggiunti.
Questa impostazione viene applicata solo al riavvio del programma.
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Elementi

Per i diversi elementi (per esempio campo di testo, rettangolo, immagine, codice a barre) ci sono

differenti proprieta e le relative proprieta predefinite possono essere modificate.

In genere sono proprieta come lo spessore del tratto o proprieta delle linee e di riempimento.

Property

Strichstarke
Linienfarbe
Linienart
Fiilfarbe
Fillmuster

Ausrichtung

Farblcodierung

Value

0,001

I cooooo
] Ohne
[ FFFFFF
] ohne

0

Mein

Le modifiche apportate alle proprieta predefinite dopo essere state applicate sono disponibili per

tutti i nuovi elementi aggiunti. Non & necessario riavviare.

Ripristina

Ripristina allo stato iniziale la proprieta predefinita dell'elemento scelto.

Con il codice a barre c'e la possibilita di adattare automaticamente la distanza interna

se viene cambiato il tipo di marcatore.

Adattamento automatico della distanza interna quando si cambia tipo di marcator

[

Spaziatura interna

Le caratteristiche standard degli elementi sono lette nella condizione di fornitura
di cui ai file del prodotto del catalogo dei prodotti. Questi valori del prodotto

possono divergere dai valori visualizzati in queste finestre di dialogo.
Solo se i valori sono modificati e memorizzati mediante questa finestra di
dialogo opzioni, hanno la precedenza in sede di rappresentazione degli

elementi.
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Dispositivi di output

Normalmente ad ogni tipo di marcatore va assegnata una stampante o un plotter.

Assegnazione

Nell'elenco visualizzato e stabilita un'associazione tra le stampanti collegate e le rispettive
modalita d'uso:

e Come stampante
L’apparecchio viene sempre assegnato come stampante se nella finestra di dialogo & scelto

"Assegna".

e Come plotter
L’apparecchio viene sempre assegnato come plotter se nella finestra di dialogo & scelto

"Assegna".

e ChiediPer ogni assegnazione di questo apparecchio viene presentata la finestra di dialogo
"Assegna stampante".

e Non utilizzare

Assegnazions
Apparecchio Assegnazione
Microsoft Print to PDF Come stampante
Microsoft XPS Document Writer  Come MCP Plus
MPIS1Fa42 Chiedi
MPIBCEZDD Mon utilizzare

[Jutilizza stampante Windows

Aggiorna dispositivo di output

Salva statiztiche di stampa

File:

[ apri file dopo stampa

Riavviare Monitor di stato, per accettare le modifiche.

Utilizza stampante Windows

Questa opzione consente di visualizzare nell’elenco tutte le stampanti del sistema
operativo e di selezionarle nella finestra di dialogo di stampa. In caso contrario,
I'elenco contiene solo stampanti che possono essere utilizzate internamente.
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Salva statistiche di stampa

Attivare questa opzione per salvare un protocollo di stampa. Ogni singola stampa espande il file
di registro.

Questo file di registro pud essere visualizzato anche nel monitor di stato. Vedere il capitolo
»Monitor di stato processi di stampa“.

Esempio:

Position Order No. Blank Variant Name

= I S N

=
=]

1131920000 CC 15/17 K MC NE GE
1131920000 CC 15/17 K MC NE GE
1131920000 CC 15/17 K MC NE GE
1131920000 CC 15/17 K MC NE GE
1876590000 CC 15/17 K MC NE
1266120000 CC DIA 30/3.5 MC NE
1856700000 ESG 10/17 MC NE WS
1877590000 SM 22/22 K MC NESI
1323750000 SM DIA 60-22 K MC
1016030000 DMC 12/27 MC NE
1609801044 DEK 5/5 MC NE WS
1046340000 DEK 5/6.5 PLUS MC
1609880000 WS 15/5 MC NE WS
1927510000 WS 12/5 PLUS MC NE

Marker Type Title

CC 15/17 K MC NE GE
CC 15/17 K MC NE GE
CC 15/17 K MC NE GE
CC 15/17 K MC NE GE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE
WS 12/5 PLUS MC NE

Page Count Number Of Markers Custom Order

e i e R R R i i i

No.Custom Print No.Custom Print

1876600000

1876600000

1876600000 1
1876600000 1
1927520000 1
1927520000 1
1927520000 1°
1927520000 1
1927520000 1°
1927520000 1
1927520000 1°
1927520000 1
1927520000 1
1927520000 1

‘Weidmueller Order Output Device Output Date

08.12.202113:50
08.12.202113:51

' 08.12.202113:50
' 08.12.202113:51
' 08.12.202114:03
' 08.12.202114:03
' 08.12.2021 14:03
' 08.12.202114:03
' 08.12.2021 14:03
' 08.12.202114:03
' 08.12.2021 14:03
' 08.12.202114:03
' 08.12.2021 14:03
' 08.12.202114:03
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Plotter

Impostazioni per il plotter collegato.

Generale

Impostazioni generali per il Modo plotter e per la velocita del plotter.

Avvio del programma
Avviare con Plot Mode

@ Sempre
() Quando l'ultimo modo & stato il Modo Flot

velocita Plotter: Standard
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Chiedi

Se si desidera modificare un'associazione (Come stampante/Come plotter) stabilita nella finestra
di dialogo di stampa, procedere come segue:

® Modificare I'associazione relativa alla stampante direttamente qui.

oppure

® Modificare l'associazione relativa alla stampante in "Chiedi".
® Aprire un tipo di marcatore che si desidera stampare.

® Selezionare la voce di menu File > Stampa...

® Selezionare Assegna nella finestra di dialogo di stampa.

Verra aperta una finestra di dialogo in cui € possibile eseguire I'assegnazione:

Indicare la stampante

{E} Come stampante
O | Come MCP Plusfip-2: v |

Piastra di supporto MultiCard

Impostazioni del plotter per MultiCard.

Anteprima

Plokter: |'|,'|,Is|:u|:uusrv1'l,HF' Color LaserJet « | Informazione:
Si prega di modificare i walori
Pennino: |Nessun penning w | % e fino a quando viene
raggiunto in punto zero del
1 | 1350 | vi | 11es0 & | [plotter.
Stampare il puntozero ] [ Punti zero aggiunkivi ...
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Piastra di supporto SF 4-6

Impostazioni del plotter per piastre di supporto SlimFix per I'acquisizione delle grandezze 4-6.

Ankeprima
( - - O . 7
L L 3
. . -

Plotter: |'l,'l,Is|:nI:nusrv1'l,HF' Color Laserlet - & | Infarmazione:

Si prega di modificare i valori
Pernino: |Nessun PEMMIRD w | % e ¥ fino a quando viene

raggiunto in punto zero del
s | 1370 % | v | 11e9s 5| |plotter.

Stampare il puntozero ]

Prova il pennino

[ Punki zero aggiunktivi ...

Opzioni di scrittura per il pennino del plotter.

Imposta posizione di prova scrittura

@ Mon provare i| pennino

() Posizione standard del plotter

() Posizione adattata (solo per MultiCard) § Posizione standard del platter per

etichette

Linea 1

Linea 2

Linea 3

Al

¥R

Al

n2

Al

n2

i) bl i

mrn

mm

mrn

mrn

mrn

mrn
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PrintJet Mini

Generale
Impostare le opzioni di stampa per la PrintJet MINI selezionata.

Potenza di fissagaio

Potenza di fissaggio regolabile {pagina informativa)

Azzeramento impostazioni individuali

Nota di carattere generale:
La qualita di stampa della PrintJet MINI puo essere determinata dai seguenti fattori:

1. Attraverso il file del prodotto (vedi "Aggiunta di un prodotto™)
L'impostazione di base avviene tramite il file del prodotto oggetto della fornitura (*.mcf)

2. Mediante i livelli di riscaldamento regolabili.
Porre un segno di spunta su "Livello di riscaldamento regolabile (pagina delle informazioni)"
e riprendere le impostazioni della finestra di dialogo delle opzioni.
Aprire un prodotto e assegnarlo a una stampante PrintJet MINI (vedere il capitolo
"Stampare", sezione "Assegnazione della stampante a un tipo di marcatore").
Passare alla pagina delle informazioni del prodotto (vedi capitolo "Interfaccia del
programma”, sezione "La pagina delle informazioni").
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Amministrazione

Amministrazione della PrintJet MINI.

Selezionare stampante: WMEPIM20250310 ~

Accesso remoto

Apri collegamento desktop remoto

File di supporto

Crea file di supporto. ..

Aggiornare il software della stampante

Aggiornare il file:

Avviare 'aggiornamento della stampante

Accesso remoto

Selezionare una stampante PrintJet MINI collegata e fare clic su "Aprire il collegamento desktop
remoto..." per collegarsi al computer della stampante.

File di supporto

Il file di supporto contiene informazioni sulla versione del programma installata. In caso di
problemi serve da aiuto per il supporto.

Selezionare una stampante PrintJet MINI collegata e fare clic su "Creare il file di supporto..." per
creare un file di supporto.

Aggiornare il software della stampante

Per aggiornare il software della stampante vi preghiamo di fare clic sul pulsante "Awvia
l'aggiornamento della stampante".
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PrintJet CONNECT

Generale

Impostare le opzioni di stampa per la PrintJet CONNECT selezionata.

Selezionare stampante: PIC w

Qualits di stampa

Tutte le impostazioni necessarie per il driver della stampante Weidmueller
PrintJet COMMECT vengono configurate automaticamente.

Selezionare qualitd di stampa...

Misurazione automatica
Misurazione automatica nella stampante

(®) Calibra solo il primo marcatore

D Imposta tutti | marcatori
Azzeramento impostazioni individuali

Livello di riscaldamento [ Fasdcolazione

Livello di riscaldamento [ fascicolazione regolabile (pagina Infa)

Azzeramento impostazioni individuali

Selezionare qualita di stampa

Per adeguare la qualita di stampa della PrintJet CONNECT, all'interno della finestra di dialogo
Opzioni fate clic sul pulsante "Seleziona qualita di stampa..." e selezionate la qualita di stampa
desiderata.

Selezionare qualita di stampa ¥

(®) Usa il suggerimento di Weidmuller:

() Stampa rapida (300 dpi)

(O stampa di qualita testo (500 dpi)
() Stampa di qualita grafica (500 dpi)
() Stampa premium (1200 dpi)

() Definita dallutente Qualita (500 dpi)

Profilo colore: Raccomandazione Weidmiller w

Azzeramento impostazioni individuali

s
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Definita dall’utente
Per ragioni di compatibilita, per le versioni piu vecchie del firmware della stampante possono
ancora essere selezionate le opzioni di impostazione precedenti.
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Nota di carattere generale:

La qualita di stampa della PrintJet CONNECT puo essere determinata dai seguenti fattori:

3.

Attraverso il file del prodotto (vedi "Aggiunta di un prodotto”)
L'impostazione di base avviene tramite il file del prodotto oggetto della fornitura (*.mcf)

Mediante l'impostazione nella Finestra di dialogo Opzioni (vedi "PrintJet CONNECT")
Questa impostazione vale in generale per tutti i prodotti e sovrascrive i valori preimpostati
contenuti nei file del prodotto.

Mediante lI'impostazione sulla pagina delle informazioni del prodotto (vedi capitolo
"Interfaccia del programma”, sezione "La pagina delle informazioni").

Questa impostazione € valida per una variante di prodotto e sovrascrive le impostazioni del
file di prodotto e I'impostazione della Finestra di dialogo Opzioni.

Mediante i livelli di riscaldamento regolabili.

Porre un segno di spunta su "Livello di riscaldamento regolabile (pagina delle informazioni)"
e riprendere le impostazioni della finestra di dialogo delle opzioni.

Aprire un prodotto e assegnarlo a una stampante PrintJet CONNECT (vedere il capitolo
"Stampare", sezione "Assegnazione della stampante a un tipo di marcatore").

Passare alla pagina delle informazioni del prodotto (vedi capitolo "Interfaccia del
programma”, sezione "La pagina delle informazioni").
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Amministrazione

Amministrazione della PrintJet CONNECT.

Selezionare stampante: PIC MW

Accesso remoto

Apri collegamento desktop remoto

File di supporto

Crea file di supporto. ..

Aggiornare il software della stampante

Aggiornare il file:

Avviare [aggiornamento della stampante

Accesso remoto

Selezionare una stampante PrintJet CONNECT collegata e fare clic su "Aprire il collegamento
desktop remoto..." per collegarsi al computer della stampante.

File di supporto

Il file di supporto contiene informazioni sulla versione del programma installata. In caso di
problemi serve da aiuto per il supporto.

Selezionare una stampante PrintJet CONNECT collegata e fare clic su "Creare il file di
supporto..." per creare un file di supporto.

Aggiornare il software della stampante

Per aggiornare il software della stampante vi preghiamo di fare clic sul pulsante "Avvia
l'aggiornamento della stampante".
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Gruppi di stampanti PJC

Le stampanti disponibili possono essere riunite in un gruppo di stampanti.
Sono supportante le seguenti stampanti: PrintJet CONNECT

Questi gruppi di stampanti possono essere assegnati a un materiale nella finestra di dialogo di
stampa. Vedere il capitolo "Assegnazione della stampante a un tipo di marcatore".

In sede di elaborazione del processo di stampa, le singole pagine di stampa vengono suddivise
tra le stampanti disponibili nel gruppo stampante, a seconda dell'opzione selezionata.

Gruppi stampanti:

USE Group

C&)
NetvokGrowp |

Assegnato: E]

PIC Metwork 01
PIC Metwork 02

® 817 8EE ®Eg
o 1y 25 BEg

Stampant disponibili:

PIC Metwork 01
PIC Metwork 02
PrintJet COMMECT (USB1)
PrintJet COMMECT (USB2Z)
Printlet COMMECT (USE3)

Opzioni di stampa gruppo stampanti

Stampa seriale:

Il numero delle pagine di stampa viene diviso per il numero di stampanti e assegnato a queste

ultime: (1-2; 3-4; 5-6)

Stampa parallela:

Le pagine di stampa di un materiale vengono inoltrate alla singola stampante del gruppo di

stampanti: (1; 2; 3) (4; 5; 6)
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PrintJet ADVANCED

Generale

Impostare le opzioni di stampa per la PrintJet ADVANCED selezionata.

Selezionare stampante: Cutput di file PrintJet ADVANCED

Qualita di stampa

Tutte le impostazioni necessarie del driver della stampante di Weidmueller
PrintJet ADVAMCED saranno configurate automaticamente,

[ Selezionare qualita di stampa...

[ Livello di rizcaldamento regolabile (pagina Info)

Mostra monitor di stato durante I'emissione della stampa

Selezionare qualita di stampa

Per adeguare la qualita di stampa della PrintJet ADVANCED, all'interno della finestra di dialogo
Opzioni fate clic sul pulsante "Seleziona qualita di stampa..." e selezionate la qualita di stampa
desiderata. i

Selezionare qualita di stampa s | S|

(®) Usa il suggerimento di Weidmuller

O Prermium

(") standard
(MetalliCard: & selezionabile solo la qualit premium)

Azzeramento impostazioni individuali

Ok ] [ Annulla ]
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Nota di carattere generale:

La qualita di stampa della PrintJet ADVANCED puo essere determinata dai seguenti fattori:

1.

Attraverso il file del prodotto (vedi "Aggiunta di un prodotto”)
L'impostazione di base avviene tramite il file del prodotto oggetto della fornitura (*.mcf)

Mediante l'impostazione nella Finestra di dialogo Opzioni (vedi "PrintJet ADVANCED")
Questa impostazione vale in generale per tutti i prodotti e sovrascrive i valori preimpostati
contenuti nei file del prodotto.

Mediante lI'impostazione sulla pagina delle informazioni del prodotto (vedi capitolo
"Interfaccia del programma”, sezione "La pagina delle informazioni").

Questa impostazione € valida per una variante di prodotto e sovrascrive le impostazioni del
file di prodotto e I'impostazione della Finestra di dialogo Opzioni.

Mediante i livelli di riscaldamento regolabili.

Porre un segno di spunta su "Livello di riscaldamento regolabile (pagina delle informazioni)"
e riprendere le impostazioni della finestra di dialogo delle opzioni.

Aprire un prodotto e assegnarlo a una stampante PrintJet ADVANCED (vedere il capitolo
"Stampare", sezione "Assegnazione della stampante a un tipo di marcatore").

Passare alla pagina delle informazioni del prodotto (vedi capitolo "Interfaccia del
programma”, sezione "La pagina delle informazioni").
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Amministrazione

Amministrazione della PrintJet ADVANCED.

Selezionare stampante: Output di file PrintJet ADVANCED +
Accesso remoto

Apri collegamento desktop remoto

File di supporto

Crea file di supparto...

Aggiornare il software della stampante

Avviare aggiornamento della stampante

Accesso remoto

Selezionare una stampante PrintJet ADVANCED collegata e fare clic su "Aprire il collegamento
desktop remoto..." per collegarsi al computer della stampante.

File di supporto

Il file di supporto contiene informazioni sulla versione del programma installata. In caso di
problemi serve da aiuto per il supporto.

Selezionare una stampante PrintJet ADVANCED collegata e fare clic su "Creare il file di
supporto..." per creare un file di supporto.

Aggiornare il software della stampante

Per aggiornare il software della stampante vi preghiamo di fare clic sul pulsante "Avvia
l'aggiornamento della stampante”.
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Gruppi di stampanti PJA

Le stampanti disponibili possono essere riunite in un gruppo di stampanti.
Sono supportante le seguenti stampanti: PrintJet ADVANCED

Questi gruppi di stampanti possono essere assegnati a un materiale nella finestra di dialogo di
stampa. Vedere il capitolo "Assegnazione della stampante a un tipo di marcatore".

In sede di elaborazione del processo di stampa, le singole pagine di stampa vengono suddivise
tra le stampanti disponibili nel gruppo stampante, a seconda dell'opzione selezionata.

Gruppi stampant:

USE Group

E&)

Assegnato: E]

PIA Metwork 01
PIA Netwark 02

Stampanti dispaonibili:

PIA Metwork 01
PJA Metwork 02
PrintJet ADVAMCED (USB1)
Printlet ADVAMCED (JSE2)
PrintJet ADVANCED (USB3)

o B[] 835 8Eg
> B[1 825 &6

Opzioni di stampa gruppo stampanti

Stampa seriale:

Il numero delle pagine di stampa viene diviso per il numero di stampanti e assegnato a queste

ultime: (1-2; 3-4; 5-6)

Stampa parallela:

Le pagine di stampa di un materiale vengono inoltrate alla singola stampante del gruppo di

stampanti: (1; 2; 3) (4; 5; 6)
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PrintJet PRO

Generale

Impostare le opzioni di stampa per PrintJet PRO (vedere anche il manuale di PrintJet PRO).
Auvio del programma

Selezionare stampante:

Proprietd del driver della stampante

Si procede automaticamente ad eseguire butke le impostazioni necessarie del
driver della stampante PRINTIET PRO.

Si procede a ridefinire tutke e impostazioni del driver della stampante,
riptistinando i valori predefiniti,
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Pulizia
Avviare le operazioni di pulizia per PrintJet PRO.
Pulizia

Selezionare stampante:

Tipo di pulizia 1: Pulizia delle testine di stampa
Pulisce le kestine di stampa quando i color sono sbiaditi,

Tipo di pulizia 2: Pulizia completa .
Pulizia completa delle testine di stampa, E necessario aggiungere inchioskrao

mil't rha milliva la Fackina di ckamna

Tenere presente che la pulizia completa necessita di pit colore rispetto alla
pulizia delle testine di stampa.

Configurazione attuale

Visualizzazione della configurazione attuale della stampante.

Configurazione atbuale

Selezionare starmpante:

Modo di stampa Stampa a colori
Slat coninchiostro nero Slak K
Qualitd di skampas: Zualitd standard
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Stampante THM

Generale

Impostare le opzioni di stampa per la stampante selezionata. Sono supportante le seguenti
stampanti: THM Plus S, THM TwinMark, THM MMP, THM MultiMark, THM MultiMark Plus, THM
MultiMark LPC, THM MultiMark Twin, THM Plus M

Selezionare stampante: THM MMP MW i |
Tadlierina
(®) Usa il suggerimento di Weidmuller (standard)
[IMessuna unita di perforazions o taglio disponibile
Impostazioni di taglio spedifiche
(®) Mai tagliare
() Tagliare alla fine di una pagina
() Tagliare alla fine dell'ordine di stampa
(O Tagliare tutti 1
Disalineamento Inizio [ Fine: EI ! EI mm
[ Taglio prima del lavoro di stampa
Impostazioni di perforazione specifiche
Non perforare
Perforazione prima del lavorao di stampa
Perforazione

Utilizza le impostazioni del driver Windows

Usa il suggerimento di Weidmiller (standard)

Vengono utilizzate le impostazioni standard predefinite dal costruttore per il materiale utilizzato
(ad es. taglio, perforazione, orientamento, velocita di stampa, tipo di sensore).

Le opzioni selezionabili sovrascrivono le impostazioni predefinite del produttore solo nella
rispettiva funzione.

Utilizza le impostazioni del driver Windows
Vengono utilizzate le impostazioni del driver della stampante (non disponibile per THM MMP,
THM MultiMark, THM MultiMark Plus, THM MultiMark LPC, THM MultiMark Twin, THM Plus M).

Alcuni parametri possono essere impostati anche tramite la pagina delle
informazioni del materiale (vedere capitolo "Interfaccia del programma", sezione
"La pagina delle informazioni").
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Avanzate

Impostazioni avanzate della stampante THM.

Selezionare stampante: THM MMP MW ~

[ invia immagini nel formato =.bmp
[ stampa la lunghezza massima
[ stampa i marcatori vuot alla fine

Valore soglia per il nero in stampa

E— 128

1 254

Invia immagini nel formato *.bmp
Invece del formato immagine *. png, le immagini vengono inviate alla stampante in formato *.

bmp.

Stampa la lunghezza massima
| marcatori possono essere inviati alla stampante in gruppo anziché singolarmente.

e Fra i marcatori raggruppati non & possibile né tagliare né perforare.

Stampa i marcatori vuoti alla fine
Con alcuni materiali su modulo continuo i marcatori vuoti non vengono inviati alla stampante alla
fine. Selezionare questa opzione per inviare alla stampante i marcatori vuoti.

Valore soglia per il nero in stampa

Imposta il valore a partire dal quale un colore viene riconosciuto come nero e quindi stampato.
e Predefinito: 128
¢ Piu grande é la soglia, piu i toni chiari vengono stampati in nero.
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Amministrazione

Amministrazione delle stampanti THM.

Aggiornare il software della stampante

Selezionare stampante: [ 170111856727 - ]

Aggiornare il file: E]

Avanzamento materiale per marcatori per morsetti
[ ottimizzazione della stampa doppia (solo THM MultiMark Twin)

[]5tampa identica su lato anteriore & posteriore (solo THM MultiMark Twin)

Aggiornare il software della stampante

Per aggiornare il software della stampante (ad es. firmware)
e selezionare una stampante,
e selezionare un file di aggiornamento e
o fare clic sul pulsante "Avvia l'aggiornamento della stampante".
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Gruppi di stampanti THM

Le stampanti disponibili possono essere riunite in un gruppo di stampanti.

Sono supportante le seguenti stampanti: THM MultiMark Plus, THM MultiMark, THM MMP, THM

MultiMark LPC

Questi gruppi di stampanti possono essere assegnati a un materiale nella finestra di dialogo di
stampa. Vedere il capitolo "Assegnazione della stampante a un tipo di marcatore".

In sede di elaborazione del processo di stampa, le singole pagine di stampa vengono suddivise
tra le stampanti disponibili nel gruppo stampante, a seconda dell'opzione selezionata.

Gruppi stampanti:

Group 1-2-3
Group 3

Assegnato: E]

THM MultiMark N 1
THM MultiMark M2

Stampanti disponibili:

THM MultiMark MW 1
THM MultiMark MW 2
THM MultiMark NW 3

© ®[1]7) 837 S

Opzioni di stampa gruppo stampanti

Stampa seriale:

Il numero delle pagine di stampa viene diviso per il numero di stampanti e assegnato a queste

ultime: (1-2; 3-4; 5-6)
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Stampa alternativa

Assegnazione di un materiale a una stampante alternativa.

Viene utilizzato per la creazione di un file di stampa per I'LPC-Tool. Vedere il capitolo “Stampa
LPC".

Sono supportante le seguenti stampanti: THM MultiMark Plus, THM MultiMark, THM MMP, THM
MultiMark LPC

|Utilizza stampa alternativa

Prodotto Digposttivo atemativo
ESG-LP 617 MM W5 THM MuttiMark
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Supporto

Generale

TeamViewer

I Avvia TeamViewer... I

TeamViewer
Offre la possibilita di avviare TeamViewer.
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Apertura di file estranei

Apertura di file estranei

Nel presente capitolo viene spiegato come aprire un file che non é stato creato con il programma

(file estranei).

® Selezionare la voce di menu File > Apri.

Viene visualizzata la finestra "Apri" nella quale sono elencati tutti i file disponibili;

Offnen

Suchen in; | |=) Test Dateien V| I A
i Anlage 1 Schaltschrank 2
| "EB .ﬁ.nlage 1 schaltschrank ¢
Zuletzt Anlage 1 Schaltschrank oben
wenwendete D1, anlage 3 Schalkschrank 1
'_T
Deskiop
Eigene D ateien
Arbeitzplatz
- D ateiname: |.-'1'-.nlage 1 Schaltzchrank 2 W | [ O ffren l
Metzwerkumgeh  Dateiyp: | M-Print PRO Datei [ mpc v | Abbrechen |

Selezionare uno dei seguenti tipi di file:

*.abp Documento M-Print

*.gdc Documento M-Print

*mld Documento M-Label

*.mpc File di progetto (Content File)
*.mpo File di ordinazione (order file)

*. mpt File modello (Template)

*.rde File di esportazione di Raildesigner
*.tmf Documento M-Comm

*.wmex File esportazione Weidmueller
*.IXX

*ixy

* xls; *.xIsx Foglio di lavoro di Microsoft® Excel®
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* xmt E' possibile selezionare piu file
* txt E' possibile selezionare piu file

Vengono elencati tutti i file presenti per il tipo di file selezionato.
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® Selezionare il file che si desidera aprire e premere il pulsante Apri.

Se non si e trovato il tipo di marcatore nel catalogo, sara visualizzato un messaggio sullo
schermo:

Der benatigte Markierertyp "vanant/matenalno’ izt nickt
werfughar.
Bitte wahklen Sie ein Produkt aus dem Eatalog.

® Selezionare qui il tipo di marcatore desiderato e confermare con OK.

| dati saranno inseriti sui marcatori.

Se in una selezione multipla € presente un tipo di file non supportato, viene
aperto solamente il primo file della selezione.

File Excel
All'apertura dei file Excel viene visualizzata un'ulteriore finestra di dialogo.

Seleccidn

Por favor, seleccone la hoja de trabajo v el tipo de oK
sefalizador.

Annulla
Hoja de trabajo seleccionada:

[Tabellel - ]

Tipo de sefializador selecdonado:

W

SM 27/27 NEUTRAL WS Selecdonar. ..

ignorar los formatos de las celdas

Qui e possibile selezionare il foglio della tabella da aprire, il tipo di marcatore e I'acquisizione dei
formati delle celle (se supportato dal programma).

e | dati del file Excel sono visualizzati solo a partire dalla seconda riga.
Un’altra possibilita di visualizzare i dati di un file Excel consiste nell'effettuare
un'importazione (vedi capitolo "Importazione da un file Excel").
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Prompt dellariga di comando

Introduzione

Il programma puo essere aperto anche dalla riga di comando (prompt dei comandi).

E possibile ricevere i parametri di chiamata immettendo il percorso del file di programma, seguito
dal parametro di chiamata "/?".

Parametri di chiamata exe

Apertura o stampa di un file

MPrintPRO.exe [-p] "file (*.gdc|*.mId|*.mpc|*.mpol|*.mpo2|*.mpt|*.rde|*.tmf|*.txx|*.txy|*.bis)"

Utilizzando il parametro di stampa "-p" il processo di stampa pud essere
interrotto mediante una finestra di dialogo.

Se la finestra di dialogo non deve essere visualizzata, vedere I'opzione " Attivare
I'interruzione di un processo di stampa (tramite riga di comando)" nella Finestra
di dialogo Opzioni (vedere il capitolo "Finestra di dialogo Opzioni").
Diversamente la finestra del programma non viene piu visualizzata.

Importazione o stampa di un file

MPrintPRO.exe "dateiname" [-p] [-ImportFilter:"scriptdateiname (*.mis)"]
[-MatNo:materialnummer] [-Fallback:materialnummer]

MPrintPRO.exe "dateiname" [-p] [-ImportFilter:CSV | WTXT | WE | VK | XML]
[-MatNo:materialnummer] [-Fallback:materialnummer]

6 Utilizzando il parametro di stampa "-p" il processo di stampa - dopo aver aperto
il programma - puo essere interrotto mediante una finestra di dialogo.
Se la finestra di dialogo non deve essere visualizzata, vedere 'opzione
"Visualizza tutti i messaggi disattivati" nella Finestra di dialogo Opzioni (vedere il
capitolo "Finestra di dialogo Opzioni").
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Parametri di chiamata del convertitore

| convertitori di impostazione possono essere eseguiti dalla riga di comando (vedere il capitolo
"Convertitore").

Parametri del convertitore QLS

-input:"<Path to file>\<Inputfile>"
Questo attributo € obbligatorio

-output:"<Path to file>\<Outputfile>"

Opzionale.

Se Outputfile = Inputfile, al nome del file di output viene aggiunta I'estensione ".convert".

Se non si indica nulla, viene preso il nome del file di input e aggiunta I'estensione ".convert".

-separator:<separator>
Opzionale, ma solamente 1 carattere

Di default & il punto e virgola,
nessuno white space (spazio vuoto)
eccezione TAB

-start:<start>
Opzionale

Prima riga di importazione;
Di default & 1

-end:<ende>

Opzionale

Ultima riga di importazione;

Di default & 0 (significa: fino alla fine)

-concate:<concate>

Opzionale

Di default € 2

Non puo diventare piu piccolo di 2

-ignore
Opzionale
Se indicato, vengono ignorati gli spazi

-?

IAttenzione! Se viene indicato questo parametro, vengono ignorati tutti gli altri parametri e
visualizzata solo la "Usage".

Esempio:
1. "C:\ glsconverter.exe" -? -> Elenca tutti i parametri
2. "C:\ glsconverter.exe" -input:"C:\gls\testbasis_cmd.csv"

Crea il file "C:\gls\testbasis_cmd.csv.convert"
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Parametri del convertitore TNV

-input:"<Path to file>\<Inputfile>"
Questo attributo € obbligatorio

-output:"<Path to file>\<Outputfile>"

Opzionale.

Se Outputfile = Inputfile, al nome del file di output viene aggiunta l'estensione ".convert".

Se non si indica nulla, viene preso il nome del file di input e aggiunta I'estensione ".convert".

-separator:<separator>
Opzionale, ma solamente 1 carattere

Di default & il punto e virgola,
nessuno white space (spazio vuoto)

-start:<startlineno>
Opzionale

Prima riga di importazione;
Di default & 1

-end:<endlineno>

Opzionale

Ultima riga di importazione;

Di default & 0 (significa: fino alla fine)

-pairl:<colnol><delimiter><colno2>

Opzionale

Prima coppia di colonne collegate

Di default: colonna 0 e colonna 1 vengono collegate con i due punti
Se il delimiter ="', le colonne vengono composte SENZA delimitatori.

-pair2:<colnol><delimiter><colno2>

Opzionale

Seconda coppia di colonne collegate

Di default: colonna 3 e colonna 4 vengono collegate con i due punti

Il delimitatore viene estratto dal parametro "pairl". Se pairl non € presente, vengono utilizzati
come delimitatore i due punti.

Per ricevere un elenco di tutti i parametri, fare doppio clic sul file "TNVConverter.exe".
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Esempio:
1. "C:\ tnvconverter.exe" -input:"C:\tnv\testbasis_cmd.csv" -separator:”," -pairl:"2:5" —pair2:"3:4"

L'importazione avviene in base ai seguenti parametri:

® delimitatore del file sorgente: virgola

® delimitatore del file di output:  due punti

® Coppie di colonne collegate:  colonna 2 con colonna 5 e colonna 3 con colonna 4
® crea il file di output "C:\tnv\testbasis_cmd.csv.convert"

234 e Prompt della riga di comando Istruzioni per l'uso



Importazione di file

Introduzione

Questo capitolo spiega come importare i file in formato estraneo (ad es. Microsoft® Excel®) e
come aggiungere i loro contenuti ai tipi di marcatore.

| file possono essere importati nei tipi di marcatore previsti dal catalogo oppure in file di modello
creati dall'utente (*.mpt) (vedere il capitolo "Modelli").

Esistono diverse modalita di importazione:

1. Importazione manuale (con possibilita di creare un file script di importazione) (vedere il
capitolo "Importazione manuale")

2. Importazione automatizzata mediante un file script (vedere il capitolo "Importazione
automatizzata™).

3. Importazione automatizzata con uno o piu file script (Importazione batch) (vedere il capitolo
"Importazione batch™).

4. Importazione controllata da remoto mediante riga di comando (prompt dei comandi) (vedere
il capitolo "Prompt della riga di comando").

Al momento é possibile importare i seguenti formati file:

*.asc

*.csv
*.mpx

* txt

*.wbe
*.we?

* xml

* xls, *.xlsx
* vk
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Importazione manuale

Se viene selezionata I'importazione manuale, l'utente verra assistito nella scelta dei parametri di
importazione dall'importazione guidata.

Al termine dell'importazione guidata i parametri scelti potranno essere salvati per essere utilizzati
di nuovo come importazioni automatizzate con le medesime impostazioni (vedere il capitolo
"Importazione automatizzata").

Avvio dell’'importazione

Awviare l'importazione selezionando le voci di menu File > Importa...
Seguire le singole fasi dell'importazione guidata.

Fase 1. Paginainiziale

Importazione dati guidata E|

L'impartazione guidata dei dati consente di impartare in
M-Prink® PRO i Formati file sequenti.

[Inon visualizzare nuovamente

’ Abbrechen ] [ Hilfe ]

La pagina iniziale dell'importazione guidata puo essere disattivata.
Selezionare "Non visualizzare nuovamente" per iniziare dalla fase 2 all'avvio successivo
dell'importazione guidata.

E possibile attivare di nuovo la pagina iniziale accedendo alla finestra di dialogo Opzioni (vedere
il capitolo "Finestra di dialogo Opzioni").
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Fase 2: Filtro e tipo di importazione

Nella fase 2 selezionare il file sorgente che deve essere importato.
E inoltre possibile selezionare il tipo di filtro, la routine di importazione salvata o un convertitore.

Importazione dati guidata g]
Filtro e tipi di filtro =
Specificare il nome del File da importare & selezionare un tipo disponibile dallelenco a _J_-,'J
discesa,
Seleziona file di origine:
C\projectswksample. bt Sfoglia. ..
Selezionare i tipo di file di origine:
(@) Filbrci ) seript [Jutilizzare convertitore
Farmato testa (F, A4S0 C* THT;* W51 -v. 4.4, 3.5 -
Proj.l 1 Cable bl 2 -1Xla 1 ey ¥ i
Proj.l 1 Cable bl 2 -1X1h 2 g ¥
Proj.l 1 Cable bl 2 -1Xlc 3 ey ¥
Proj.l 1 Cable bl 2 -1¥1d 4 ey ¥
Proj.l & Cable bl 2 -2Kle 5 ey ¥
Proj.l Z Cable bl 2 -Z2X1f [ ey ¥
Proj.2 1 Cable bl 2 -1¥Za 7 ey ¥
Proj.2 Z Cable ws 5 -Z2XZh g ey ¥
Proj.3 3 Cable ws & -3KZa =] e T
Proj.3 Z Cable ws 5 -Z2XZh 14 ey ¥
Proj.3 3 Cable ws 5 -3Kac 11 X ¥
Proj.3 3 Cable ws 5 -3X2d 1z ey ¥
Proj.3 3 Cable ws 5 -3Kde 13 X ¥ s
[ < Zuriick ” Weiter = l abbrechen ] ’ Hilfe

Seleziona file di origine

® Premendo il pulsante Sfoglia.... si apre la finestra nella quale € possibile selezionare il file
da importare.

® Selezionare il file da importare e premere il pulsante Apri.

Nel campo "Seleziona file di origine:" vengono ora visualizzati il percorso e il file che si desidera
importare.

Tipo di file sorgente
Selezionare successivamente il tipo di importazione:

® Filtro: l'importazione viene eseguita automaticamente mediante un file filtro.
Selezionare il tipo di filtro (ad es. *.txt, * WEI) nel menu a tendina.
Normalmente viene visualizzato automaticamente il filtro adatto al file sorgente.

® Script di importazione: I'importazione viene eseguita automaticamente mediante uno script
salvato in precedenza (vedere il capitolo "Importazione automatizzata™)

® Utilizzare un convertitore per prefiltrare il file sorgente (vedere il capitolo "Convertitore").
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Fase 3: Selezione del progetto e delle varianti

In questa fase selezionare il progetto o il tipo di marcatore con il quale deve essere eseguita
l'importazione.
A seconda della situazione di partenza & possibile scegliere tra diverse opzioni:

® FElemento selezionato

® Tipo di marcatore esistente nel progetto corrente
® Nuovo tipo di marcatore nel progetto corrente

® Nuovo progetto

Importazione dati guidata *
selezionare la destinazione dell'importazione

prego selezionare l'importazione per | passi successivi, }-__:J

Elemento selezionato

Tipo di marcatore esistente nel progetto corrente

..... Muovo progetto

@ Muovo tipo di marcatore nel progetto corrente

Come da file di riferimento

----- Muovo progetto

O Muovo progetto
Come da file di riferimento Catalogo...
Crea sottoprogett
[ riunisci tipi di marcatori uguali
[ Mostra informazioni sul progetto solo in Esplora progett

Elemento selezionato

Questa opzione prevede che venga aperto un tipo di marcatore e selezionato un marcatore.
L'importazione viene inserita a partire dal marcatore selezionato!

Se non viene selezionato alcun marcatore, i dati vengono inseriti a partire dal primo marcatore.

Tipo di marcatore esistente nel progetto corrente
Questa opzione prevede che venga aperto un tipo di marcatore.
L'importazione avviene a partire dal primo marcatore del tipo di marcatore selezionato.
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Nuovo tipo di marcatore nel progetto corrente

® Fare clic su "Catalogo..." per selezionare un tipo di marcatore dal catalogo o dai modelli
salvati (*.mpt).

Durante l'importazione viene aggiunto un nuovo tipo di marcatore al progetto corrente.

Come da file di riferimento
Viene eseguita un'importazione VK e i tipi di marcatori vengono assegnati
tramite il file di riferimento. La selezione catalogo € quindi inattiva.

Nuovo progetto

® Fare clic su "Catalogo..." per selezionare un tipo di marcatore dal catalogo o dai modelli
salvati (*.mpt).
L'importazione avviene in un nuovo progetto con il tipo di marcatore selezionato.

Se dovesse essere ancora aperto un progetto o un tipo di marcatore diverso non
salvato, prima dell'importazione verra visualizzato un messaggio di conferma.

Crea sottoprogetti
Per ogni identificazione di progetto di nuova siglatura (marcatore del progetto), viene creato un
nuovo sottoprogetto in Esplora progetti.

Esempio:
Importazione dati guidata Importazione dati guidata
selezionare la destinazione dellimportazio Associazioni campo
_l
- . . N I ——
Project 1 P1,M1 -
P1,M2
P1,M3
PROJECT b |Co|onna 1w || v ||
P1,M4
P1,M5 -| MARKER 5 |Co|onna 2w || v ||
P1,M6 (O nuova tipo di marcatore nel progetto corrente
P1,M7
P1,M8 P
. -~ Muava progetto Colonna 1 Colonna 2
Project 2 P2,M1 )
P2M2 Project 1 P1,M1
' P1,M2
P2,M3 P1,M3
P2,M4 P1,M4
Project 3 P3,M1 @ P1,M5
P3.M2 b P1,M&
ERYE | CC 15/17 K MC NE WS P1,M7
' P1,M8
] Ci oy qui]
P3,m4 rea sottoproge! . Project 2 P2,M1
[ Riunisd tipi di marcatori ugual e
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[ 2 Project 1]

L B CC157

C e Cc1s7
| =-[=F Project 3 |

4 CC1SATKMCNEWS | CC15/17KMCNEWS | CC15/17 KMCNEWS |

|||r1|°|||ﬁ°|||ﬁ°||T'P|||F'P||\F’P||7F"|||P|°|||P|°|r1P|°||NHJFPJFHJFHJ?P|r1F’|°||r17|°||r1ﬁ°|FP|°||‘FPP||'
SEI -
%Z o
ig IIIlI IIFI \IFI III IIP IIF IIY IIPI I\PI IIIPI I}Ill IPF IFF IF“
iR
Hoi &
i

- CC 15/17 KTmed

Ilﬁ \IFIlllf‘ IIP IIP|IIY IIPI:
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Riunisci tipi di marcatori uguali
| contenuti degli stessi tipi di marcatori possono essere riuniti durante l'importazione.

Questa funzione si usa solo in relazione alla casella di controllo "Crea sottoprogetti”.

Esempio:

Project1

Project 2

Project 2

Project1

Project 1

Project 2

Project 3

[+] Crea sottoprogett
[Riunisc tipi di marcatori uguali

Project 1

=58 6/15

Project 2
=

Project 3
ed 6115
= Project 1
CowE Es
E| Project 2
L w5 6s
E| Praoject 1
6/15

|II|?IDIII|EIDIII|5IDIII|4PIII|3PIII|2IDIII|1IDIII

P

Project 2

e
E| Praoject 1
o ens
E| Project 2
- =58 ens
E| Project 3
o-E8 615

B

|II|?IDIII|EIDIII|5IDIII|4FIII|3PIII|2IDIII|1IDIII
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Esempio:

Mostra informazioni sul progetto solo in Esplora progetti
Questa opzione si applica ai marcatori senza livello di progetto.

E| Project 1
- w53 ens
E| Project 2
w53 615
E| Project 3
w365
E| Project 1
@53 615
E| Project 2
- w5 ens
E| Project 1

w-53 615

E Crea sottoprogetti
[ riunisdi tipi di marcatori uguali
[ IMostra informazioni sul progetto solo in Esplora progett

Bk

E| Project 1
- w53 ens
E| Project 2
- @-Eens
E| Project 3
w53 ens
E| Project 1
D w565
E| Project 2
- @5 615
E| Project 1

w52 615

[+] Crea sottoprogetti
[] Riunisci tipi di marcatori uguali
[+] Mostra informazioni sul progetto solo in Esplora progett

Questa funzione si applica solo in combinazione con la casella di controllo "Aggiungi progetto"”.
Vedere il capitolo “Aggiungi progetto*.
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Fasi 4/5: Selezione del tipo di dati e dei delimitatori di campo

Indicare se nel file sorgente le colonne sono separate da delimitatori (ad es. da punto e virgola,
tabulatori) o da una larghezza fissa (vedere la sezione "File di importazione con delimitatori" e
"File di importazione con larghezza di colonna fissa").

E possibile inoltre selezionare:

® |nizio del file
Indicare in quale sistema operativo & stato creato il file.

® Caratteri di delimitazione testuale
| caratteri testuali tra i caratteri di delimitazione testuale sono interpretati come testo. |
delimitatori vengono dunque ignorati (mascherati).

Importazione dati guidata

Tipo di dati -
Selezionare il tipo di dati che corrisponde meglio ai propri dati, i J:-;ﬁ

Tipo di dati originale

() Delimitato (caratteri, come punka e virgola o fabulazione, che separano i campil

() Larghezza fissa (i campi sono disposti in colonne con larghezza Fissa)

Inizio del file Campo racchiuso da
(&) WINDOWS mac Caratters:
(@I () M5-DOS(PCE)
< Zuriick, ” Weiter = abbrechen ] [ Hilfe
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File di importazione con delimitatori

® Selezionare I'opzione "Delimitato..." quando le colonne del file sorgente sono delimitate da
delimitatori, ad esempio punto e virgola o tabulatori.

File esemplificativo con delimitatori

Aperto con Microsoft® Excel®: Aperto con un editor di testo:
A B =-x1;1

11 |=x1 1 %

2 2 '

3 3 ;5

1 4 g

5 5 Laleolsll

B B L1

7 7 Lz

B |=A1+ L1 iLz

=Al+2;mML:LL

9 L1 sML:LZ

10 L2 MLl

11 12 ;I 1.0

;I 1.1

12 |=A142 M1:L1 117

13 M1:L2 (T1.3

14 M1:L3 % %g

15 1.0 I16

16 1.1 (117

17 [1.2 % 35

18 1.3 1302

19 1.4 (I 2.3

20 115 % 3.».;

21 116 ;I 2:?

22 1 1.7 1T 3.0

23 12.0 I %%

24 121 ;I3

25 122 ENERE

26 123

7 12.4

28 125

29 127

30 13.0

31 13.1

32 13.2

33 133

Le rappresentazioni di cui sopra mostrano un file Excel® a due colonne e a sinistra le colonne
con un punto e virgola definito quale delimitatore. Poiché ad es. la seconda riga non contiene
alcun carattere prima del punto e virgola, la colonna resta vuota.

Il file a destra & stato salvato da Excel® con il formato CVS (separato da delimitatori).
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o

Fare clic su Avanti per passare alla fase successiva.

Delimitatore

[ ]Punto e virgala Tabulatore Riga di intestazione:
[|spazio [virgola Ignora linee

[ ]altro Prima riga di importazione:
[ Mantieni 'altri' delimitatori LItima riga di importazione:

Viene suggerito il tipo di carattere che serve da delimitatore per le colonne. Se il file dovesse
invece presentare un altro tipo di delimitatore, & possibile selezionare quest'ultimo facendo
clic sull'opzione corrispondente.

Facendo clic sull'opzione Altro € possibile indicare un delimitatore diverso nel campo
adiacente.

Per aggiungere ulteriori delimitatori diversi, immetterli nel campo Altri e attivare l'opzione
"Mantieni altri delimitatori".

Questa opzione puo essere selezionata solamente se nella fase 2 e stato scelto il filtro csv,
VK, oppure WES.

Nei punti in cui € presente un delimitatore viene creata una nuova colonna.

Definire la riga di intestazione. Vedere il capitolo ,Mostra I'intestazione del file di
importazione*.

Indicare la prima e l'ultima riga di importazione.

| delimitatori punto e virgola, tabulatore, spazio vuoto e virgola purtroppo non
possono essere mantenuti con I'opzione "Mantieni altri delimitatori"!
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File di importazione con larghezza di colonna fissa

® Selezionare I'opzione "Larghezza fissa..." quando le colonne del file sorgente presentano
una larghezza predefinita, ad es. colonna 1 = 10 caratteri, colonna 2 = 2 caratteri.

File esemplificativo con larghezza di colonna fissa aperto con un editor di testo:

Prujekt A Al a1l
Frojekt & a12
Prulekt A A3 al3
Prulekt A ad ald
Prulekt A A5 als
Prulekt A AR AlE
Prulekt A AT AlF
Prulekt A AR Al18

F'r‘DJEk‘t El Bl E11l
F'r‘n:qelc:t El B2 B12Z
F'r'cuj!ekt El B3 B13
F'r‘DJEk‘t El B4 Bl4
Pr‘n:qekt El EBS% BLS
F'r‘DJEk‘t El BE ELlR
F'r‘n:qelc:t El BY E17
Projekt Bl BS BLS

® Fare clic su Avanti per passare alla fase successiva.

Importazione dati guidata >

Larghezza campo
In questa schermata & possibile stabilire la larghezza campo.

Suggerimento
Le linee con frecce stanno ad indicare un'interruzione di colonna.
Per CREARE un'interruzione di colonna diccare nella posizione desiderata.
Per ELIMINARE una linea di interruzione diccare sulla linea.

Ignora linee
Riga di intestazione: I:I Prima riga di importazione:

Ultima riga di importazione:

5 10 15 20 25 20 25 40 45
1 “rojekt A:Al:All

2 cAZ2:A12

3 CAZCALS

4 “hd-AT4

o [
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Definire le larghezze delle colonne.
® Segnare sul righello le posizioni in cui inizia una nuova colonna. Le colonne sono delimitate
da una freccia.

5 10 15 20 25 20 25 <0 45
Projekt A Al;AL1 s
cAZ2ALE
CA3ALS
ch4: 414 hud

® Facendo nuovamente clic sulla freccia viene eliminata l'interruzione di colonna.

Importazione da un file Excel

In caso di importazione di un file Excel® (*.xIs) in questa sede € possibile selezionare il foglio
della tabella e I'intervallo da importare.

Importazione dati guidata g|
Impostazioni importazione Excel .
Selezione degli ambiti di importazione dei fogli di lavori di Micrasoft Excel i J_-_.-;Jl

Tabella:
[mmplete_ﬂ 1 -

(%) Tutti i dati disporibil

) Ambito
ad es, 410 ad es. C200

Da: o

E possibile importare da un solo foglio di lavoro.
Vengono importati solo i contenuti, non i formati.
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Importazione veloce di Excel®

Per una rapida importazione di Excel® & possibile aprire con il programma un file di script
dell’importazione (*.mis) salvato.

| campi di query possono essere selezionati qui. Vedere il capitolo ,Importazione veloce di
Excel®".

Importazione dati guidata *

Impostazioni importazione Excel®
Selezione degli ambiti di importazione dei fogli di lavori di Microsoft® Excel ®. J.:J

Utilizza query
Questa impostazione consente di utilizzare lo script salvato per una importazione veloce di
Excel® .

Possono essere, in via facoltativa, specificati solo i campi per il filtra,
I walori della prima riga vengono interpretati come intestazioni di colonna e non vengono
imnportati.

Seleziona i campi query. .. Opzioni avanzate...
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Fase 6: Op

zioni

Consente di definire ulteriori opzioni di importazione:

Filtro: regola semplice di filtraggioLa colonna selezionata viene importata dopo essere stata

filtrata con la caratteristica selezionata

Ripetizioni: La riga di importazione viene ripetuta piu volte. Il fattore di ripetizione per ogni

riga viene acquisito dalla colonna selezionata.
Filtro avanzato

Altre regole filtro che possono essere applicate su piu colonne.

Importazione dati guidata

Opzioni
E possibile selezionare il testo di filkro, il Fatbore di ripetizions e F'ordinamento per il
contenuta di una colonna,

Filkra

Colonna: Caratteristic |Inizia con V| |D

Ripetiziani

Colanna: Colonna 2 | X | 2 = | [ Filtro esteso...

Cliceando sullinkestazione di una colonna sard possibile ordinarla in ordine crescente o

Foz  Caolonna Calokna 2 Colomna 3 Colonna 4 Cole

1 b B C n] E

2 G H I ] K

3 1 2 3 4 5

4 7 g a 10 11

< >
< Zuriick ][ Weiter = abbrechen ] l HilFe:
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Fase 7: Associazioni di campo

In questa fase occorre definire le associazioni di campo.

Tipo di
Tipo di

Importazione dati guidata

Associazioni campo
In questa fase & possibile assegnare le colonne di origine ai campi di destinazione.

marcatore (solo con vk-Import)
elaborazione

Associazioni campo
Formattazione campo

*

Tipo di marcatore: THM MT30
Tipo di elaborazione: (®) colonna per colonna (O riga per riga
= A& |IE
[] Aggiungi progetto () Continuo () Inizio riga
PROJECT = |COI0nna 1~ || ~ || ~ |
e -
Colonna 1 Colonna 2 Colonna 3 Colonna 4 Colonna 5

Descrizione dei simboli:

o
=

Impostare le proprieta avanzate

Apre una finestra di dialogo per impostare diversi attributi di font mediante il
contenuto del file di importazione. Vedere il capitolo ,Impostare le proprieta
avanzate®.

Nota: Possono essere formattati solo elementi di testo.

Ripristinare le proprieta avanzate
Azzera le colonne assegnate di tutti i campi di dati.

Imposta formato
Apre la finestra di dialogo per 'impostazione dei font e della spaziatura dei
caratteri. Vedere il capitolo ,Formattazione dei campi®.

Ripristina il formato predefinito
| formati di tutti i campi dati vanno riportati ai valori di default.
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Impostare le proprieta del marcatore

Bei endlosen Streifen kann die Markiererlange (bzw. Breite) tiber eine
Spalte der Importdatei gesetzt werden. Vedere il capitolo ,Lunghezza del
marcatore dal file di importazione*.

[E [E Importareil testo del progetto alivello di progetto o alivello del
marcatore
Durante l'importazione i testi del livello del progetto (marcatori di progetto)
possono essere inseriti automaticamente nelle aree del marcatore
(marcatori). Vedere il capitolo ,, Importazione del testo di progetto nei
marcatori “.
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Tipo di marcatore

Visualizza il tipo di marcatore in cui si sta importando.

Il campo diventa attivo se I'importazione viene eseguita su diversi tipi di marcatori (ad es. vk-

Import). Vedere il capitolo "Associazioni di campo VK"

Tipo di elaborazione

Per colonna
Fa riferimento alle colonne della griglia dei dati.

Selezionare "Per colonna" quando si desidera associare i contenuti a colonne

(marcatori/elementi) particolari.

Per riga
Fa riferimento alle righe della griglia dei dati.

PROJECT MARKER TEXTEOR]
1 y 2 $ 3
¥ < 5
5] § 7 § 8

Selezionare "Per riga" quando si desidera inserire i contenuti importati per riga (come
raffigurato nella griglia dei dati).

Associazioni di campo

Mediante le associazioni di campo € possibile importare dei dati all'interno di elementi presenti
(sul tipo di marcatore). | nomi dei campi, ad es. PROGETTO, MARCATORE o CASELLA DI
TESTO1, vengono definiti mediante le proprieta degli elementi (vedere il capitolo "Elaborazione
di un elemento™)

Le colonne da importare possono essere collegate tra loro a piacere.

Tramite il menu a tendina "Incolla su" con le etichette a modulo continuo (strisce a modulo
continuo), é possibile selezionare il numero di strisce su cui deve avere luogo l'importazione
(vedi capitolo "Istruzioni generali", sezione "Strisce a modulo continuo").

Nei materiali che non dispongono di campo “PROJECT® sussiste la possibilita di aggiungere
informazioni di progetto aggiuntive ai campi del marcatore. Utilizzare a tal proposito la casella di
controllo “Aggiungi progetto”. A seconda del materiale, & anche possibile selezionare la
posizione (di queste informazioni di progetto) tramite le opzioni "Continuo” e "Inizio riga".

Incolla su strisda n.: 4 -

[ ] Aggiungi progetto () Continuo () Inizio riga

PROJECT = Colonnal = - -

MARKER. = Colonmna2 = Tab - Colonna3 - - -
TEXTBOX1 = Colonna5 w Pid ~ SEEGOEN v - -

Alcune possibilita di collegamento sono ad esempio:

interruzione di riga
spazio
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tabulatore
senza spazi (Piu)
testi

Campo successivo

Per rendere disponibili campi aggiunti a posteriori (testo, codice a barre) per
l'ulteriore lavorazione sul materiale continuo, occorre impostare la proprieta
"Ordine di riempimento” nelle proprieta del campo (vedere capitolo "Interfaccia
di programma”, sezione "Comportamento").

Formattazione dei campi

| contenuti delle colonne da importare possono essere formattati mediante l'importazione
guidata.

® Selezionare un menu a tendina con colonna selezionata.

® Fare clic sull'icona A per aprire la finestra di dialogo della formattazione. Vedere il capitolo
»Adatta tipo di carattere®.

® Selezionare I'opzione di formattazione dei dati.

| dati gia formattati saranno evidenziati cromaticamente:

Tipo di elaborazione: {(#) colonna per colonna () riga per riga
PROJECT = |Colonnal w w
MARKER =

Spa; w | |Colonna 3 s L w
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Importazione del testo di progetto nei marcatori

Durante l'importazione i testi del livello del progetto (marcatori di progetto) possono essere

inseriti automaticamente nelle aree del marcatore (marcatori).

® Fare clic sul pulsante

® || pulsante modifica il proprio aspetto in

Esempio:

= per importare i testi del progetto nei marcatori.

Il seguente file di testo deve essere importato mediante le associazioni di campo visualizzate:

1
2 31
30031
4 31
5 531
g 31
T 32
ES I 4
o 32
10 32
11 33
12
13 33
14
15 33
e 33
1% 33
19 33
13
Z0

Al
Al
Al
AZ
AZ
Al
Al
AZ
AZ
A3

A3

A3
bg
Lg
g

—Z0
-E1
—XZ
-X3
—-E4
—-E5
—-E6
—-E7
- X8
—E9
—-X10
-X11
o

-E14
-X15

—-E17

Tipo di elaborazione:

PROJECT

MARKER

(%) colonna per colonna (Jriga per tiga

Colonna 1 s || Ava w | |Colonna 2 s
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Se il file viene importato SENZA la funzione, si otterra il seguente risultato:

40| 1l I5|U| 1l I6I0| Il I?ID‘ [N} Is\ul 1l I9|U| | |1|U|U| | Illllo‘ | I1I%0| I|I1I3ID| | Illqlo‘ | |1|5P| | Il\slol | \1I7I0| | Illglol | |1|9|U| | \%Dlol

[ |TI.UI 1l |6|0| ) |5|0\ ] |4P\ ] |3P| ] RDI ] |1|U| )

Se il file viene importato CON la funzione, si otterra il seguente risultato:

]I 11 I?III:'I 1| |6IUI 11 |5ICII 11 |4FII 11 |3PI 1| |%UI 11 |1I0I [
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Aggiungi progetto

Questa opzione si applica ai marcatori senza livello di progetto.

Durante l'importazione i testi del livello del progetto (marcatori di progetto) possono essere
inseriti automaticamente nelle aree del marcatore (marcatori).

Esempio:

Se il file viene importato SENZA la funzione, si otterra il seguente risultato:

Project1

Project 2

Project 3

Project1

Project 2

Project1

P1,M1
P1,M2
P1,M3
P2,M1
P2,M2
P2,M3
P3,M1
P3,M2
P3,M3
2-P1,M1
2-P1,M2
2-P1,M3
2-P2,M1
2-P2,M2
2-P2,M3
3-P1,M1
3-P1,M2
3-P1,M3

Importazione dati guidata

Associazioni campo

[ aggiungi progetto

R camz ][
Columnn 1 Column 2
Project 1 P1,M1
P1,M2
P1,M3
Project 2 P2,M1

6/15 MM W5

|5IUI 1 H‘PI Il |3PI 1l |2IUI Il |1IUI Il

11l Illol Il I2IU| I ! I3ID| Il

i P1.M2

40' Nl |5|D| 1 |5|D| ||| 7

Se il file viene importato CON la funzione, si otterra il seguente risultato:

Project1

Project 2

Project 3

Project1

Project 2

Project1

P1,M1
P1,M2
P1,M3
P2,M1
P2,M2
P2,M3
P3,M1
P3,M2
P3,M3
2-P1,M1
2-P1,M2
2-P1,M3
2-P2,M1
2-P2,M2
2-P2,M3
3-P1,M1
3-P1,M2
3-P1,M3

Importazione dati guidata

Associazioni campo

Aggiungi progetto

S e |
Column 1 Column 2
Project 1 P1,M1
P1,M2
P1,M3
Project 2 pP2,M1

4

6/15 MM W5

1l ILID| Il I2ID| [N I3ID| 11

el !|5|°| L

il

III|1

il

III|4PIII|3PIII|2

50

IUIII|
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Impostare le proprieta avanzate

Le seguenti proprieta avanzate possono essere impostate tramite le colonne di importazione:

Proprieta: Valore:
Tipo di carattere: Font come da nome font di Windows
Esempio: "Times New Roman", "Century Gothic"
Dimensioni: Dimensione carattere
Grassetto: 1=on,
0 = off (valore predefinito)
Corsivo: 1=on,
0 = off (valore predefinito)
Sottolineato: 1=on,
0 = off (valore predefinito)
Barrato: 1=on,
0 = off (valore predefinito)
Colore testo: #RRGGBB = Codice colore esadecimale
Spaziatura caratteri: Valore numerico in %. Vedere il capitolo “Adatta
tipo di carattere®.
Esempio:
80 = 80%
100 = 100%
120 = 120%
Apice/Pedice: Valore numerico in %. Vedere il capitolo “Adatta
tipo di carattere®.
Esempio:
0 = Standard
-5 = 5% subscript
3 = 3% superscript
Allineamento orizzontale: 1 = centrato,
2 = allineato a destra,
0 (e tutti gli altri valori) = allineato a sinistra

Allineamento verticale: 1 = centrato,

2 =sopra,

0 (e tutti gli altri valori) = sotto
Allineamento del testo: 0, 90, 180, 270
Bordo: 0 =senza

1 = a sinistra

2 =sopra

4 = destra

8 = in basso

Esempio 1: 5 = sinistra / destra
Esempio 2: 15 = sinistra / destra / sopra / sotto
Spessore linea: Esempio: 0,01 0 0.01
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Unita di misura: Campo a discesa per la selezione

Tipo di linea: 0 = Pieno
1 =Tratto
2 = Punto

3 = Tratto-punto

4 = Tratto-punto-punto

5 = Senza
Colore linea: #RRGGBB = Codice colore esadecimale
Colore riempimento: #RRGGBB = Codice colore esadecimale
Interlinea: Valore numerico in %. Vedere il capitolo “Adatta

tipo di carattere®.

Esempio:

80 = 80%

100 = 100%

120 = 120%
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Esempio:

Il file di importazione:

Project Marker

Font

Pl Arial

Century
Times

unknown
P2 Bold
Italic

Underline
Strikethrough
P3 Hor zent
Hor right
Hor left
Hor xxx
P4 Vert middle
Vert top
Vert bottom
Vert xxx

P5 [
9p°

180°
270°
Pa Black

Red

Green
Blue

Arial
Century Gothic
Times New Roman

XXX

L'assegnazione del campo:

X X X

0
o
1
0

(===
(== -

Importazione dati guidata

Associazioni campo

In questa fase & possibile assegnare le colonne di origine ai campi di destinazione.

Tipo di elaborazione:

(®) colonna per colonna

O riga per riga

PROJECT = |Co|onna 1w || o || - |
|
i MARKER = |Colonna 2 v || w || v|
|
I Colonna 2 Colonna 3 Colonna 4 Colonna 5 Colonna & Colonna 7 Colonnad 3
[ Arial Arial 12 b b b b
Century Century G...
| | mimes Times New... 8
unknown XXX 10
Bold 1 0 0 0
Italic [u] 1 [u] [u]
Underline 0 0 1 0
Strikethr... a a a 1
< >

FontSize Bold Italic Underlin Strikett FontColor HorizAlign VertAlign Orientation

X
0 1 1
] #000000 1 1
o #000000 1 1
1 #000000 1 1
#000000 1 1
#000000 2 1
#000000 0 1
#000000 XXX 1
#000000 1 1
#000000 1 2
#000000 1 o
#000000 1 XXX
#000000 1 ] 1]
#000000 1 o 90
#000000 1 ] 130
#000000 1 o 270
#000000
#FFOO0O
#OOFFOO
#0000FF
Impostare le proprieta avanzate (MARKER) X
Selezionare le colonne con le informazioni di formattazione.
Proprieta testo
Proprieta: Colonna:
Font: Colonna 3 i
Dimensioni: Colonna 4 ~
Grassetto: Colonna 5 ~
Corsivo: Colonna 6 ~
Sottolineato: Colonna 7 ~
Barrato Colonna 8 ~
Colore testo: Colonna 9 s
Proprieta del campo
Proprieta: Colonna:
Alinezmento orizzontale Colonna 10 ~
Alineamento verticale Colonna 11 ~
Imposta orientamento: Colonna 12 s
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I risultato dell'importazione:

unknown

! Underline

Italic

Verl middle
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Lunghezza del marcatore dal file di importazione

Nel caso di strisce a modulo continuo, la lunghezza (o larghezza) del marcatore pud essere
impostata utilizzando una colonna nel file di importazione.

La funzione & disponibile per i materiali seguenti: Strisce a modulo continuo

Esempio:

L'assegnazione del campo:

Importazione dati guidata =

Associazioni campo
In questa fase & possibile assegnare le colonne di origine ai campi di destinazione.

Tipo di marcatore: o Applica a tutti i tipi di marcatori 2N
Tipo di elaborazione: (@ colonna per colonna Origa per riga EI m
Incolla su striscia n.: 1 ~
TEXTBOX1 (1) = |colonna 1 || || v
Impastare le proprietd del marcatore
Selezionare le colonne con le informazioni di formattazione.
Colonna 1 Colonna 2 Froprieta: Colonna:
A 10
B 20 Larghezza: |Colonna 2 ~ |
C 20 .
D e Unita di misura: ||'|'||'|'| ~ |
E 10
F 20
G 20
H 10
I 30
- - I QK | | Annulla

Il risultato dell'importazione:

[ ILI0| [N I%0| [N I3I0| [ I‘ﬁ0| [ ISIO! [ IEI0| [N Iilol [N ISIO! [ ISIO! | IH0I0| 1 IITLICI | I]12|0| | IITBIcl | I]T“i0| | I]TSIO! | IJTEI0| | I]T?Iol | I]TSIO! | I1|9I0| | I2|0I0| 1 I2|LI0| |

Ai B i ¢ i b EP F i & i H i

3PI [N |2IUI Il |1IUI [
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Imposta proprieta avanzate marcatori: LPC

Durante la creazione dei file di stampa per il LPC-Tool & possibile impostare proprieta avanzate

dei marcatori nell’importazione guidata.
La funzione & disponibile per i seguenti materiali: materiale LPC

Questi dati aggiuntivi vengono visualizzati nel LPC-Tool nell’area "Campi di informazione".
Vedi manuale LPC-Tool.

Le associazioni dei campi possono essere effettuate dalle seguenti fonti;
e Direttamente dai dati di importazione
e Da un file di riferimento (*.Ipr). Vedere il capitolo “File Ipr“.

La colonna "Prodotto" € il riferimento utilizzato durante I'importazione per eseguire
l'assegnazione alle righe di importazione.

Esempio:

L'assegnazione del campo:

Importazione dati guidata 4 Imposta proprieta avanzate marcatori
Associazioni campo '} || Selezionare le colonne con le proprietd avanzate.
In questa fase & possibile assegnare le colonne di origine ai campi di destinazione. ./)';EJJ
Proprietd avanzate marcatari
ot (Predefinito) Stabilire la fonte di dati per | campi.
Tipo di elaborazione: (®) Colonna per Colonna (ORiga per Riga | 2lUtiizza file di riferimento: referencefle.pr °
SHA | |5 J ==
#E A R Proprieta: *  Colonna:
Informazioni - lpr: Info: Informazione - lpr: Info
MARKER. =
Colonna 2 ” ¥ ” hd Prodotto **) - lpr: Product: Colonna 1 - Product No.
Riferimento 1 - lpr: Category: Riferimento 1 - lpr: Category
Riferimento 2: [0 colonna 3 - Serial No.
Riferimento 3: |
Colonna 1 Colonna 2 Colonna 3 2
Product No. Import Data Serial No. Riferimento 4 - pr: Manufacturer: Riferimento 4 - Ipr: Manufactu
0270100000 FADO4 4008150105135 Riferimento 5 - Ipr: Picture: Riferimento 5 - Ipr: Picture
1879030000 FAD10 4032248473786 .
2465870000 FAD15 4050118481457 s ® O
2500980000 FAD22 4050118514322
2589500000 FAD23 4050118601251 *) Se selezionato, vengono utilizzati | dati del file di riferimento.
2589830000 FAD34 4050116603200
2531520000 FAD40 4050118599329 v **) Assegnazione del file diimportazione al prodotto di riferimento nel file lpr.
Amnula
Il file di riferimento:
Ipc-tool-reference-file.dlpr
Ipr: Info |Ipr: Product  Ipr Category Ipr: Manufacturer |lpr Picture
0001 | T533x15/2.3 2M/CU/BK 0270100000  Terminal rail, Accessor | Weidmdller 0270100.jpg
0002 |75 33x7.5/3X18 2M/ST/SZ 1879090000  Terminal rail, Accessor. Weidmaller 0314500,jpg
0003 |PRO TOPT 120W 24V 5A 2466870000 | Power supply, switch-1 | Weidmdller 2466870.jpg
0004 | SC524VDC P1SIL3DS | 2500980000 | SAFESERIES, Safety relz | Weidmdller 2500080.jpg
0005 | CD-BO 1006120 4/6 GY 2589500000 | Cable duct, 100 mmx | Weidmdller 2500980.jpg

Il risultato dell'importazione:
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Proprieta X 4 . ESG-LP6/15SMMWS |
Em| 4
2*‘ | H | FE | II1IG| !I 12|0| [ |3|0|| | I4i0| | II5I0| 11 IEIt

Avvio del programma

Dimensioni e posizione

E Avanzate
Informazione - lpr: Info TS 35X15/2.3 2M/CU...
Prodotto - lpr: Product 0270100000
Riferimenta 1 - lpr; Category Terminal rail, Accesson..
Riferimento 2 4008150105136
Riferimento 3
Riferimento 4 - lpr: Manufacturer  Weidmdiller
Riferimento 5 - pr: Picture 0270100 jpa
Riferimento &

| |?Iul M |&IUI I|I |5IDII | |4PI 11 |3PI M |2IUI 11 |1IUII |

Nel file di progetto, le proprieta avanzate del marcatore per 'LPC-Tool vengono
visualizzate facendo clic sul marcatore con "Ctrl + tasto destro del mouse".
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Fase 8: Salvataggio e conclusione

L'ultima fase conclude la procedura di importazione. Sono disponibili le seguenti opzioni:
® Definire il numero delle ripetizioni di importazione

® Salva
Le fasi di importazione impostate vengono salvate come file di script (vedere il capitolo
"Importazione automatizzata" o "Importazione batch").

® Fine
Importa il file sorgente con le impostazioni definite.

® Attiva numerazione delle pagine (MultiCards)
Durante l'importazione viene inserita una numerazione di pagina al livello libero. Questo vale
solo per le MultiCard. Vedere il capitolo ,Campi.

Importazione dati guidata >
Carica dati =
Adesso & possibile avviare limportazione dati. )_,J

Dopo aver inserito correttamente tutte le informazioni, diccare su Fine per esegquire ['esportazione
dei dai.

MNumero di iterazioni dellimportazione dati:

Attiva numerazione delle pagine (MultiCards)
Formato: Pagina ###% ™
Posizione: Primo identificatore progetta ~
1l pulsante Salva consente di salvare le impostazioni correnti, per l'uso futuro.

Salva...

Se i dati sono stati importati correttamente, verra visualizzato un messaggio di avviso con il
numero delle serie di dati importate:

Per limportazione, i caratteri possono essere adeguati automaticamente tramite "Trova" e
"Sostituisci" (vedere capitolo "Finestra di dialogo Opzioni", sezione "Importa").

Se al termine dell'importazione alcuni campi di testo del campo di lavoro
presentano un triangolo rosso, cio significa che il testo importato non rientra
nello spazio previsto dal campo.

Il testo non verra quindi visualizzato né stampato in modo completo.

Sara dungue necessario ridurre il testo o le dimensioni dei caratteri! (vedere
anche "Adatta dimensioni font")
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Importazione automatizzata

Se é gia stata effettuata un’importazione e questa routine di importazione é stata memorizzata
(vedere la sezione "Fase 8: Salvataggio e conclusione"), si puo riutilizzare questa routine.

® Avviare I'importazione come descritto nel capitolo "Avvio dell'importazione”.

Importazione dati guidata

Filtro e tipi di filtro
Specificare il nome del file da impattare & selezionare un tipo disponibile dal'elenco a
discesa,
Seleziona file di origine:
Ciiprojectsvksample kxt Sfoglia...
Selezionare il tipa di fil: di arigine: .

CFiltro (%) Script [

CHiprojects\importscript. mis Sfoglia...
Proj.l 1 Cable bl 2 -1¥la 1 paad TT -
Proj.l 1 Cable bl 2 -1X¥1h 2 B T
Proj.l 1 Cable bl 2 -1Xlc 3 b i
Proj.l 1 Cable bl 2 -1¥1d 4 paad T
Proj.l 2 Cable bl 2 -ZXle 5 HTH T
Proj.l 2 Cable bl 2 -2X1Ef ] paad TT
Proj.Z2 1 Cable bl 2 -1XZa 7 e T
Proj.2 2 Cable ws § -ZXZh g BT i
Proj.3 3 Cable ws 5 -3XZa ] o T
Proj.3 & Cable ws § -2XZbh 10 B T
Proj.3 3 Cable ws § -3XIc 11 b i
Proj.3 3 Cable ws & -3¥2d 1z paad T
Proj.3 3 Cable ws §5 -3XZe 13 HTH T 2

[ < Zuriick " Weiter = Abbrechen ] [ HilFe

Seleziona file di origine

® Premendo il pulsante Sfoglia.... si apre la finestra nella quale € possibile selezionare il file

da importare.
® Selezionare il file da importare e premere il pulsante Apri.

Nel campo "Seleziona file di origine:" vengono ora visualizzati il percorso e il file che si desidera

importare.
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Seleziona script di importazione
® Selezionare come tipo di file sorgente Script di importazione e fare clic su Cerca....
® Aprire il file script (*.mis).

® Premere il pulsante Fine o
se si desidera effettuare ancora una modifica, fare clic sul pulsante Avanti >.

Sara avviata la routine di importazione e i dati saranno inseriti sul tipo di marcatore.
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Importazione batch

L'importazione batch € un tipo di importazione automatizzata.

Sono disponibili le seguenti opzioni:

® |mportazione di uno o piu file sorgente diversi.
® Ogni file sorgente pud essere importato con un proprio script di importazione (vedere "Fase

8: Salvatagqgio e conclusione").

di comando.

E possibile importare su tipi di marcatore dal catalogo o su modelli (*.mpt).

E possibile importare su tipi di marcatore del progetto aperto.

Il batch cosi formato pud essere salvato e caricato di nuovo in qualunque momento.

Un file di importazione batch "*.bis" puo essere aperto anche mediante un prompt della riga

Awviare l'importazione batch mediante il menu File > Importazione batch....

C:\ISB\WeidmuelleriTestcomplete), ..
C:\ProgramData\Weidmueller\M-Pri...
C:\ProgramData\Weidmueller \M-Pri.. .

C:\ProgramData\WeidmuellerM-pr...
C:'ProgramData‘\WeidmuelleriM-Pr...
C:\ProgramData\Weidmueller\M-pr. ..

[ Caticare imposkazioni ]

[ Salvare le impostazioni. .. ]

*ELS 7/40 MC NEUTRAL WS
THM MT 30X Pica 101/74 51
CC 15/17 K MC NELTRAL GE

annulla

Importazione batch E|
File:
File sorgente C:\ProgramDataWeidmueller M-Print PROVdata\Typelabel, txt
File script: C:'\ProgramData\Weidmueller M-Print PRO\data\Typelabel_Weidmueller. mis E]
area di destinazione: () Muovo tipo di marcatore
() Tipo di marcatore del progetto
(@) all'inizio O alla fine
SubProject\sM 2727 NEUTRAL WS E]
[ Aggiungi ] [ Adattare ]
Elznca di file
File sorgenke File script Tipo di marcatore

L'asterisco che contrassegna le voci della colonna "Tipo di marcatore” indica
che la destinazione di importazione & un modello (*.mpt) (vedere il capitolo

"Modelli").

Istruzioni per l'uso

Importazione di file e 267



Creazione/Aggiunta di batch

® Per assegnare al batch una nuova procedura di importazione € necessario compilare i campi
"File sorgente”, "File script” e "Area di destinazione".
A questo scopo premere ogni volta il pulsante E]

® Nell'area di destinazione € inoltre possibile scegliere se importare i dati in un nuovo tipo di
marcatore o in un tipo di marcatore appartenente al progetto aperto. Nel secondo caso e
possibile stabilire anche se i dati debbano essere aggiunti all'inizio o alla fine del rispettivo
tipo di marcatore.

® Fare clic sul pulsante Aggiungi per aggiungere al batch la combinazione di importazione
selezionata.

Modifica dei batch

Modifica della combinazione di importazione
® Nell'elenco fare clic sulla voce di batch che deve essere adattata.

® Modificare la combinazione di importazione mediante i pulsanti E] o le opzioni di selezione
disponibili nell'area di destinazione.

® Modificare la voce di batch mediante Personalizza.

Spostamento della voce di batch
® Servirsi dei pulsanti freccia per adattare la sequenza dell'elaborazione del batch.

Eliminazione delle voci di batch

Elimina la voce dell'elenco evidenziata.

s Elimina TUTTE le voci dell'elenco.

6 L'eliminazione avviene senza alcuna richiesta di confermal
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Importazione VK

Utilizzando il filtro vk, le singole righe di importazione possono contenere le informazioni relative
al materiale importato e vengono importate su questo materiale.

Filtro di importazione VK

® Come filtro di importazione selezionare: ,VK Text Format®

discesa.

Seleziona file di origine:

| vk-mport.csv

Selezionare il tipo di file di origine:

(®) Filtro () Seript

VK Text Format (*.%) - v. 8. 5. 1. 1015

Destinazione di importazione VK

[Jutilizzare convertitore

Sfoglia...

Altro...

Importazione dati guidata >
Filtro e tipi di filtro ;
Specificare il nome del file da importare e selezionare un tipo disponibile dall'elenco a . _}'4‘11

Quando si seleziona la destinazione di importazione, & possibile importare solo i tipi di marcatori

in base al file di riferimento. Vedere il capitolo ,Colonna di riferimento®.

selezionare la destinazione dell'importazione
prego selezionare limportazione per i passi successivi.

elemento selezionato

Tipo di marcatore esistente nel progetto corrente

=~ MNuevo proyecto

@ nuovo tipo di marcatore nel progetto corrente

Come da file di riferimento

Catalogo...

- Muevo proyecto
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Assegnazione VK

Ci sono diverse opzioni per l'assegnazione.

Import Data Wizard x

Assignment
First select the counter column and the reference column and then select the
reference file,

Counter Column: vl X 1

Reference Column: ~

(C) Reference Column contains Material numbers

(®) Use Reference File: Browse...
() In order of appearance (®) In order of Marker Type
Column 1 Column 2 Column 3 Column 4 Column 5
1 DEK 1609801044 Al 1
2 DEK 1509801044 A2 2

Colonna con numero

La colonna selezionata contiene un valore numerico che determina la frequenza di importazione
della riga.
Questo valore colonna puo essere inoltre moltiplicato per un fattore.

Esempio:

Counter Column: Column 5 K 1

— dl

4k

LR e B

n o — I on omoms o mmm
= R ] —— Column5
B m 1
T ol | 2
= o = 3
. £ B ] n 4

III{'I0|III%0|III?O|I|II?0|III?0|III?0|III?IO|III

I|1qlll
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Colonna di riferimento

La destinazione di importazione viene determinata tramite la colonna di riferimento.
Ogni riga di importazione contiene le informazioni sul tipo di marcatore da importare.

Due sono le opzioni di riferimento tra cui scegliere:

® |a colonna di riferimento contiene numeri di materiale

® Utilizza file di riferimento

Esempio:

Import Data Wizard

Assignment

reference file,

Counter Column:

First select the counter column and the reference column and then select the

Reference Caolumn: Calumn 3

(®) Reference Column contains Material numbers

(O) Use Reference File: Browse...
() In order of appearance (®) In order of Marker Type
Column 1 Column 2 | Column 3 Column 4 Column 5
1 DEK 1609501044 Al 1
2 DEK 1609501044 A2 2
3 CcC 1131920000 21
4 CcC 1131920000 22
5 SM 1243610000 Z-1-%

[ 5M 1243610000 2-2-%

7 DEK 1609801044 A3 3
8 CC 1131920000 23

9 5M 1243610000 Z-3-%

10 DEK 1609501044 Ad 4
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La colonna di riferimento contiene numeri di materiale
La colonna di riferimento del file di importazione contiene il numero del materiale in cui
importare.

Esempio:

Import Data Wizard x

Assignment
First select the counter column and the reference column and then select the
reference file,

Counter Column: v| X 15

Reference Column: Column 3 ~ |

(®) Reference Column contains Material numbers

() Use Reference File: Browse...
(O In order of appearance (®) In order of Marker Type
Column 1 Column 2 | Column 3 Column 4 Column 5
1 DEK 1609301044 Al 1
2 DEK 1609301044 A2 2
3 CcC 1131920000 21
4 CcC 1131920000 22
5 5M 1243610000 Z-1-%

[ 5M 1243610000 Z-2-%

7 DEK 1609301044 A3 3
3 cC 1131520000 23

9 5M 1243610000 Z-3-X

10 DEK 1609301044 A4 4
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Utilizza file di riferimento
La colonna di riferimento del file di importazione contiene un alias che viene cercato in un file di
riferimento e assegnato a un materiale.

® Selezionare prima la colonna di riferimento dal file di importazione

® Selezionare quindi il file di riferimento (*.mpr). Vedere il capitolo ,Editor file di riferimento*.

Esempio:

Il file di riferimento:

= vk-reference - ReferenceFileEditor - O bt
Alias Mumerc materiale Mome della variante &
0001 | DEK 1609801044 DEK 5/53 MC ME WS
ooz | CC 1131920000 CC15/17 K MC ME GE
0003 | SM 1248610000 Sh 18/9.5 K MC ME GR.
W
£ >
L'assegnazione:
Import Data Wizard x
Assignment

First select the counter column and the reference column and then select the

reference file.

Counter Column:

Reference Column:

Column 2

{_JReference Column contains Material numbers

(®) Use Reference File:

(") In order of appearance

vk-reference .mpr

Browse...

(®) In order of Marker Type

Co

[V S R T e U O, TR O Y B O IS

[y
(=)

lumn 1

Column 2

DEK
DEK.
CC
CC
5M
5M
DEK
CC
5M
DEK

Column 3 Column 4

1609301044 Al
1609801044 A2
1131920000 21
1131920000 22
1248610000 I-1-X
1248610000 I-2-X
1609301044 A3
1131920000 23
1248610000 I-3X
1609301044 A4

Column 5

1
2

Istruzioni per l'uso

Importazione di file e 273



Il risultato:

a

DEK5/5MCNEWS | CC151TKMCNEGE | SM18/2.5KMCNEGR |
O O O . O T W P, T O e e P e s
2 - v 4 DEKS/SMCMNEWS < CC15/17KMCNEGE | SM18/2.5KMCNEGR

g T ‘tllé' 20,29, 20, 50,80, 3[n| e el ool el e 3l el sl el e e el

[ T T T

.|5-F||||"mePm ey 1Py

L

Colonna di riferimento vuota

Se il contenuto di una colonna di riferimento € vuoto, viene utilizzato automaticamente |l
riferimento della riga precedente. In caso di dubbio, viene visualizzato un messaggio e
I'assegnazione puo essere effettuata durante I'importazione tramite il catalogo.

Riferimenti che non si trovano
In caso di dubbio, viene visualizzato un messaggio e I'assegnazione puo essere effettuata
durante l'importazione tramite il catalogo.

274 e Importazione di file Istruzioni per l'uso



In ordine di apparizione

Quando le righe di importazione nelle colonne di riferimento passano da un tipo di marcatore
all'altro, vengono aperti e importati nuovi tipi di marcatori.

Esempio:
Import Data Wizard *
Assignment c
First select the counter column and the reference column and then select the . )'j

reference file.

Counter Column: w| X 1

Reference Column: Column 2 w

() Reference Column contains Material numbers

(®) Use Reference File: wk-reference.mpr Browse...
(") In order of appearance (®) In order of Marker Type
Column 1 Column 2 Column 4
1 DEK Al 1
2 DEK. A2
3 CC 21 2
4 CC 22
5 SM 7-1% 3
5 SM Z-2-%

7 DEK A3 [ 4
8 [ 23 |'g
3 5M 73X 16

DEKS5/SMCNEWS | CC1SATKMCNEGE | SM1885KMCMNEGR | DEKS/SMCNEWS | CC15/17KMCNEGE | SM18/9.5 K MC NE GR
Il |3|D| L 1 ]l [ Islol [ IGPl 1l I: 2 Islol [ |9|U| I IHUPl [ 3 IH%Dl IIH3|D| I IH4ID| I 4 | I |]15|0| I IH7|D| I IITr 5 ]'Iglol I I%Dlol I I%Llol 1. 6 I J%Elol I I%‘
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Ordinati per tipo di marcatore

Le righe di importazione vengono ordinate in base ai tipi di marcatori della colonna di riferimento,

raggruppate e poi importate nel rispettivo tipo di marcatore.

Esempio:

Datenimport Assistent

Zuordnung

die Referenzdatei,

Wahlen sie zuerst die Zahl- und Referenzspalte aus der Importdatei aus und danach

Spalte mit Anzahl: |

Referenzspalte: Spalte 2

() Die Referenzspalte enthilt Materialnummern

(®) Verwende Referenzdatei: |vk—reference .mpr

() In Reihenfolge des Aufiretens (®) Nach Markierertypen sortiert

Spalte 1 Spalte 2 Spalte 4

IIll?llljlII|EI¢|III|5IDIII|4FIII|3FIII|2IDIII|1IDIII
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Associazioni di campo VK

Oltre alle associazioni generali di campo (vedi capitolo "Fase 7: Associazioni di campao"), &
possibile effettuare associazioni di campo per diversi tipi di marcatori.

Importazione dati guidata x
Associazioni campo .
In questa fase & possibile asseanare e colonne di origine ai campi di destinazione, | )‘:;ﬁ
Tipo di marcatore: (Predefinita) v

Tipa di elaborazione: (® colonna per colonna (riga per riga

A |K(E

A
e
TexthoxTol = -
g ;
Colonna 1 Colonna 2 Colonna 3 Colonna 4 Colonna 5
53 [abel [
59 leparello t6
&0 multicard 7

(Predefinito)
Per impostazione predefinita, vengono visualizzati tutti gli elementi esistenti di tutti i tipi di
marcatori in cui pud essere eseguita I'importazione.

Viene utilizzata la logica di importazione precedente (fino alla versione di programma 8.4).

Tipo di marcatore selezionato
Se nel campo di selezione viene selezionato un tipo di marcatore, vengono visualizzati solo i
suoi elementi.

In questo modo & possibile associare i campi singolarmente per ogni tipo di marcatore.
Importazione dati guidata X

Associazioni campo
In questa fase & possibile assegnare e colonne di origine ai campi di destinazione., | J}J

Tipo di marcatore: multicard, mpt | Aoplica 2 tut 1t di mercatoi

Tipo di elaborazione: {®) colonna per colonna ()riga per riga

FEARE

g B
Colonna 1 Colorna 2 Colonna 3 Colonna 4 Colonna 5
58 abel t5
59 leporello t6
&0 multicard t7
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Applica a tutti i tipi di marcatori
Se si seleziona questa opzione, continuando a scorrere la pagina le associazioni di campo del
tipo di marcatore selezionato vengono applicate ai campi recanti lo stesso nome di tutti gli altri

tipi di marcatore.

Esempio:

Importazione dati guidata

Associazioni campo

In questa fase & possibile assegnare le colonne di origine ai campi di destinazione.

1 label

I R

Tipo di marcatore:

Tipo di elaborazione: (@) colonna per colonna

multicard.mpt v Applica a tutti i tipi di marcatori

Origa per riga

:l L]

100% - QR qH

||\‘2|u|\||1\u

4 leporelio

MARKER

Incalla su striscia n.: ~ ALK
MARKER = —
TEXTBOX1 | = ‘cq\umnq v” VH v

Colonna 1 Colonna 2 Colonna 3 Colonna 4 Colonna 5

58 label t5

59 leporello 5

&0 multicard t7

< >

\\Illﬂll\\Zlﬂl\llg\ﬂll\ﬁplll\s\ﬂll\

[l ‘zlnl‘l | |1':I

q 7 multicard

oo -3&ald

TextboxTop \ TextboxLeft \ Textbm(nght‘

11 \l\l]l 1 IZIU‘ 1 \Slﬂl [N Iﬂp‘ 11 \Slﬂ‘ [ Islﬂl Ll \7Iﬂ| L1 I%clll L \Elﬂl 1 IjTu\l]l 1 \llllu‘ IIJT2|U| 1 Illg\ﬂ‘ 1 I.

Importazione VK sui template

FPIIIFFHIPFIII ‘IIDIH

1o R
PROECT | MARKER | TEXTBOXI
G

L'importazione tramite il filtro VK puo essere eseguita anche su modelli (templates).

Vedere il capitolo ,Modelli“.
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Importazione veloce di Excel®

Grazie all'importazione veloce di Excel®, le aree filtrate di una tabella Excel® possono essere
importate o stampate tramite uno script di importazione predisposto.

Preparare I'importazione veloce di Excel®

Eseguire I'importazione di un file per acquisire e salvare i dati fondamentali dell'importazione.

® Selezionare un file Excel® come file sorgente.

Filtro e tipi di filtro

discesa.

Seleziona file di origine:

| fast-excel. ¥LS

Selezionare il tipo di file di origine:
(®) Filtro () Seript [Jutiizzare convertitore

Nell'esempio viene utilizzato il seguente file di importazione:

A B C D E
1 Coll Col2 Col3 Cold Col5
2 Devl PL-01 20081 KWa4 ABC
3 Devl PL-02 19528 KwW4a4 BCD
4 Devl PL-03 11180 KwWa4 CDE
5 Devl PL-04 13562 KwW4a4 DEF
i) Devl PL-05 14523 Kwa4 EFG
7 Devl PL-06 17492 KwWa4 FGH
B Devl PL-07 18120 Kwa4 GHI
9 Devl PL-08 12466 KwWa4 HLI
10 Devl PL-09 20152 Kwa4a K
11 Dev2 PL-01 12685 KwWa4 JKL
12 Dev2 PL-02 19590 KwW4a4 KLM
13 Dev2 PL-03 14666 KW45 LMIN
14 Dev3 PL-01 15372 KW4a5 MMNO
15 Dev3 PL-02 18695 KW45 orQ
16 Dev3 PL-03 18318 KW4a5 POR
17 Dev4 PL-01 11311 KW45 QRS
18 Devd PL-02 13573 KW45 RST

Selezionare I'opzione seguente: “Utilizza &query”
® Fare clic sul pulsante: “Seleziona i campi query”.

Formato testo (* ASC;* CSV;* TXT; ®.XLS; ®.XLSX) -v. 8. 5. 1. 1015

Spedficare il nome del file da importare e selezionare un tipo disponibile dall'elenco a

Sfoqlia...

Altro...

Colé

o
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Impostazioni importazione Excel®

Tabella:

(®) Tutti i dati disponibil

() Ambito
ad es, AlD
Da: Eino a:

Tabelle1 ~

Selezione degli ambiti di importazione dei fogli di lavori di Microsoft® Excel®.

ad es, C200

| IUtilizza guery

Excel® .

impoartati.

Seleziona i campi query. ..

Questa impostazione consente di utilizzare lo script salvato per una importazione veloce di

Possono essere, in via facoltativa, spedficati solo | campi per il filtro,
I valori della prima riga vengono interpretati come intestazioni di colonna e non vengono

Opzioni avanzate. ..

® Nella finestra di dialogo, selezionare le colonne del file Excel® che possono essere
selezionate successivamente come campi di query.

Campi di query
Selezionare le colonne per la query.

Disponibile

Col3
Col4
Cols
Cols

=r

=

>
Selezionato i || ¥
Coll
Col2

QK annulla

L'importazione inizia automaticamente dalla seconda riga, poiché la prima riga
viene interpretata come intestazione della colonna.

® Fare clic sul pulsante: “Opzioni avanzate...”. Questa immissione & opzionale.
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Impostazioni importazione Excel®

Selezione degli ambiti di importazione dei fogli di lavari di Microsoft® Excel @. . J___Eﬁ
Tabella:
Tabelle 1 w

(®) Tutti i dati disponibili

() Ambito
ades, A10 ad es, C200

Da: Fino a:

Utilizza query
Questa impostazione consente di utilizzare lo script salvato per una importazione veloce di
Excel® .
Possono essere, in via facoltativa, specificati solo | campi per il filtro,

1 valori della prima riga vengono interpretati come intestazioni di colonna e non vengaono
impartat.

Seleziona i campi query... Opzioni avanzate...

Opzioni avanzate >

abilita il filtro dello stato del processo
Filtro dello stato del processo.

Colonna: Cols R

Valore iniziale: X

Informazioni progetto

Per compilare il prime marcatore con la parte del nome del file (ad es. nome del progetto), inserire i
seguenti parametri.

Py file:
TN EE LR Fi'\ProgramDatalweidmueller M-Print PROVdata\fast-excel xdsx

Cerca: | Y |
Awvvia alla (comparsa): I:l Lunghezza
Risultato: fast-excel

Anrua

Abilita il filtro dello stato del processo

Se si desidera salvare lo stato di importazione nel file Excel® (dopo un’importazione veloce di
Excel® ), selezionare una colonna vuota esistente nella finestra di dialogo. Il valore di stato viene
salvato dopo l'importazione.

Informazioni progetto

Per compilare il primo marcatore con la parte del nome del file (ad es. nome del progetto),
inserire i seguenti parametri.

® Salvare i passaggi come file script (*.mis).

Con questo file script € possibile eseguire l'importazione veloce di Excel®
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Importazione dati guidata >

Carica dati
Adesso & possibile avviare importazione dati. | J'j

Dopa aver inserito correttamente tutte le informazioni, diccare su Fine per eseguire 'esportazione
dei dai.

Mumero di iterazioni dellimportazione dati:

1l pulsante Salva consente di salvare le impostazioni correnti, per l'uso futuro.

Salva...

Se si esegue l'importazione di queste impostazioni, verranno importati solo 20
record, non l'intero file di importazione.
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Eseguire I'importazione veloce di Excel®

Per eseguire un’importazione veloce di Excel®, nel programma deve essere aperto un file script
(*.mis).

® Selezionare la voce di menu File > Apri.
® Selezionare un file script (*.mis) predisposto per lI'importazione veloce di Excel®.

o Il file script deve essere stato creato con le impostazioni del passaggio 1.
Vedere il capitolo ,Preparare I'importazione veloce di Excel".

Si apre la finestra di dialogo per lI'importazione veloce di Excel® .

= Importazione veloce di Excel ® *

Importa file di saript (*mis):  foct ewcel mis

Obiettivo: fast-excel.mpt
File sorgente (*.xls, = xlsx): | fast-excel ¥LS ' . ) g
Foglio di lavoro:
Informazioni progetto sul 1° marcatore Dettagli
fast-excel
Filtro area: Colonna Da Fino a Rimuovi
Coll Devl Dev2 X
Col2 PL-01 PL-0& X

Seleziona colonna

[ visualizza anche i dati gia importati
Linee filtrate: 9

Importa Stampa Annulla

File sorgente:
Il file Excel® da importare.

e Le intestazioni di colonna del file devono corrispondere al file script.

Informazioni progetto sul 1° marcatore
Per compilare il primo marcatore con la parte del nome del file (ad es. nome del progetto),
inserire i seguenti parametri.

Filtro area:
Qui vengono visualizzate le colonne selezionate come campi di query nel passaggio 1.

La combinazione di diverse righe e colonne seleziona l'intervallo da importare.

Se nel filtro area non sono selezionati valori, vengono importate tutte le righe del
file sorgente.
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Esempio:

Colonna Da Fino a
I Coll Devl Dev2 |
| col2 L PL-01 PL-06 |

N [ c D E F G H
Coll Col2 Devl PL-04 13562 KWWaa DEF
Devl PL-04 | B Devl PL-05 14523 KWaa EFG
Devl PL-05 B Devl PL-06 17492 KWaa FGH
Devl PL-06 | & Dev2 PL-01 12685 KWaa JKL
Devl PL-07 PSS | Devz2 PL-02 19590 KWWaa KLM
Devl PL-08 = Dev2 PL-03 14666 KWAS LMM
Devl PL-09 =] Devl PL-01 20081 KWaa ABC
Dev2 PL-OL Devl PL-02 19528 KWaa BCD
Dev2 PL-02 Devl PL-03 11180 KWW CDE
Dev2 PL-03
Dev3 PL-01 B =
Dev3 PL-02 | ] = |
Dev3 PL-03 B = |
Devl PL-O1
Devl PL-02
Devl PL-03
Deva PL-01 -l =

Visualizza anche i dati gia importati:

Se la casella di controllo € selezionata, vengono visualizzati anche i record gia marcati in una
sessione precedente.

Anteprima:

Facendo clic sull'area dellimmagine si apre una finestra di anteprima.

284 e Importazione di file

Istruzioni per l'uso



Esempio:

Dopo I'importazione veloce di Excel®, il file sorgente di questo capitolo risulta importato e

aggiornato come segue:

fasl—gxoel 100% RN R R R |
: TextboxTop | TextboxLeft | TextboxRight
Fiyew] fast-excel
; Devi PL-04 DEF
PL-04 |  DEF Dev1 PL-05 EFG
By Devi PL-06 FGH
B Dev2 PL-01 JKL
: Dev2 PL-02 KLM
Devi Dev2 PL-03 LMN
PLOE | FGH Devi PL-01 ABC
: Dev1 PL-02 BCD
Dev2 Devi PL-03 CDE
PLO1 i JKL
Gavs
PL-02 KLM
Bavs
PL-03 LMN
De.v1
PL-01 ABC
Delv1
PL-02 BCD
B
PLO3 |  CDE
A A B [ D E F
1 Col1 Col2 Col3 Col4 Cols Colé
2 Devl PL-04 13562 Kwa4a DEF X
3 Devl PL-05 14523 Kwa4a EFG X
a Devl PL-06 17492 Kwa4a FGH x
5 Devl PL-07 18120 Kwa4a GHI
5] Devl PL-08 12466 Kwa4a HUJ
7 Devl PL-09 20192 Kwa4a K
B8 Dev2 PL-01 12685 Kwa4 JKL X
9 Dev2 PL-02 19590 Kwa4d KLM X
10 Dev2 PL-03 14666 KW4as LMIN X
11 Dev3 PL-01 15372 KWa4a5s MMNO
12 Dev3 PL-02 18695 KWa4a5s ora
13 Dev3 PL-03 18318 KwW4s PQR
14 Devl PL-01 20081 Kwa4d ABC X
15 Devl PL-02 19528 Kwa4d BCD X
16 Devl PL-03 11180 Kwa4d CDE X
17 Devd PL-01 11311 KwW4s QRS
18 Devd PL-02 13573 KWa4a5s RST
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Convertitore

Il convertitore consente di prefiltrare il file sorgente. Pud essere eseguito mediante I'importazione
guidata (vedere "Impostazioni dell'importazione guidata™) o dal prompt dei comandi (vedere il
capitolo "Parametri di chiamata del convertitore").

Convertitore QLS

Il convertitore QLS consente di riassumere un certo numero di righe in un'unica riga.

Se nella finestra di dialogo di importazione (vedere il capitolo "Importazione manuale") si
seleziona il convertitore "glsconverter.exe", il file di importazione verra prefiltrato
automaticamente (vedere I'esempio Importazione QLS).

Le impostazioni predefinite del file "QLSConverter.exe" sono:

delimitatore: punto e virgola
numero di righe collegate: 2

Il capitolo "Parametri di chiamata del convertitore" illustra i parametri che possono essere
impostati.

Esempio di importazione QLS:

Il cliente desidera importare nel programma i dati del file sorgente in modo che venga creata 1
riga ogni 2 righe del file sorgente.

File sorgente:
Questo file deve essere convertito prima dell'importazione.

[=] wkzample bt
1 LE:C:DE:F
2 GrH:I:J:E:L
3 1:;2:3:4:5:6
4 T;8:9:10:11:12
5
< >
File di output:

Questo file verra importato.
Normalmente le righe consecutive sono separate da un punto e virgola (vedere la figura).

[= wkzample_conwvert bt ]

1 AyBrC:DrE:FGrH:I:T:E:L
2 1;2:;3:4;5;:6)7:;8;9;10;11;1=2
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Convertitore TNV

Il convertitore TNV consente di suddividere in due righe due coppie di colonne contenute in una
riga. Tali colonne saranno separate da un nuovo delimitatore.

Se nella finestra di dialogo di importazione (vedere il capitolo "Importazione manuale") si
seleziona il convertitore "TNVConverter.exe", il file di importazione verra prefiltrato
automaticamente (vedere Esempio di importazione TNV).

Le impostazioni predefinite del file "TNVConverter.exe" sono:

delimitatore del file sorgente: punto e virgola
delimitatore del file di output: due punti
Coppie di colonne collegate: colonna 0 con colonna 1 e colonna 3 con colonna 4

Il capitolo "Parametri di chiamata del convertitore" illustra i parametri che possono essere
impostati.

I delimitatori per il file di output vengono estratti automaticamente dal parametro "pairl”.

Se per il file di output viene utilizzata come simbolo del delimitatore una barra verticale ("), le
colonne verranno assemblate SENZA alcun delimitatore. La barra verticale significa "Nessun
delimitatore"”.

Le colonne possono essere denominate solo numericamente; la prima colonna
del file sorgente € la colonna O.

6 Spazi o coppie di colonne prive di contenuto non vengono importati.
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Esempio di importazione TNV 1:

Il cliente desidera combinare due colonne di ogni riga del file sorgente, importandole come
nuova riga nel programma.

Non sono stati selezionati parametri aggiuntivi.

File sorgente:
Questo file deve essere convertito prima dell'importazione.

[= trvsample csv

Qr1;2:3:4:5
6;7:87;9;10;:11
arbrerdrert

L RS

grhrizjrkrl

File di output:

Questo file & stato convertito dal convertitore TNV e pud essere importato.
(vedere la figura).

L'importazione avviene in base ai parametri standard:

® delimitatore del file sorgente:  punto e virgola
® delimitatore del file di output:  due punti
® Coppie di colonne collegate:  colonna 0 con colonna 1 e colonna 3 con colonna 4

[&=] tnveample cev.convert

0:1

[ S I R S

1 &y Ln

[T T o T (TR T - B T

TS ]
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Esempio di importazione TNV 2:

L'importazione avviene in base ai parametri seguenti: -separatore:"," -pairl:"2|5" —pair2:"3|4"
® delimitatore del file sorgente: virgola

® Delimitatore del file di output: nessun delimitatore

® Coppie di colonne collegate:  colonna 2 con colonna 5 e colonna 3 con colonna 4

File sorgente:
Questo file deve essere convertito prima dell'importazione.

[&=] tnveample cav l

P,1,2,3,4,5
6,7,8,9,10,11
a,b,c,d,e,f

[V I =

g,h, 1,3,k 1

File di output:
Questo file & stato convertito dal convertitore TNV e puo essere importato.
(vedere la figura).

E] tnvsample csv.convert
s

34

811

310

cf

de

il

ik

Y T % T S

1 & Ln

[T =]
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Impostazioni dell'importazione guidata

® Selezionare il file sorgente "vksample.txt".

® Apporre un segno di spunta su "Utilizzare convertitore" e fare clic su "Altro..."

Importazione dati guidata

Filtro e tipi di filtro

discesa,

Seleziona File di arigine:

Specificare il nome del file da importare & selezionare un tipo disponibile dall'elenca a

Cprojectsivksample. bxk

[ afoglia. .. ]

Selezionare il tipo di File di origine:
{*1 Filtro ) 3cript [«]Ltilizzare convertitare:

Formato tesko (¥ A5C0% oy * TuT ¥ 6l5 - v. 4. 4, 3. 5

LESR

A:B:C:D:E:F
G:H:I:J:K:L
1:2:3:4:5:6

T:8:9:10;:11;:12

r

|2

£

[.ﬁ.l:ul:urechen ] [ HilfF e

Viene aperta la finestra di dialogo che consente di impostare i dettagli del convertitore.

Dettagli del conwvertitore

Percorso completo & nome del | C:\flter XX Converter. exe
file del conwvertitare {exel:

Percorso '_:':"T'F'le':':' & nome del | i projects\vksample_convert, kxk r=; |

File di arigine:

Parametri aggiunkivi: | |
Ik, l [ Annulla ]
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® Fare clic sui pulsanti di selezione per selezionare il file convertitore "XXXConverter.exe" e il
file di output.

® Se il campo del file di output rimane vuoto, viene considerato valido il percorso del file di
input e aggiunta l'estensione "convert" al nome del file di input.

® Nel campo dei "Parametri aggiuntivi" & possibile definire i delimitatori e le coppie di colonne.
® Selezionare "OK" per tornare all'importazione guidata.

La procedura di importazione continua con il file di output.
Per eseguire il file del convertitore "XXXConverter.exe" con altri parametri, &

necessario eseguirlo dal prompt dei comandi (vedere il capitolo "Parametri di
chiamata del convertitore").
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Mostra l'intestazione del file di importazione

Per i file di importazione con molte colonne puo essere utile vedere le intestazioni delle colonne
guando si assegnano le colonne.

Specificare nel campo ,Riga di intestazione* |a riga con le intestazioni dei dati di importazione. E
possibile selezionare qualsiasi riga. Vedere il capitolo ,,Fasi 4/5: Selezione del tipo di dati e dei
delimitatori di campo®.

Importazione dati guidata >

Tipo di dati
In questa schermata & possibile stabilire i delimitatori per i propri dati.
Mell'anteprima mostrata qui sotto & possibile verificare come apparira il testo,
Delimitatore

[Jrunto e virgola Tabulatore Riga di intestazione:
[ spazio [Jvirgola Ignora linee

[ altro Prima riga di importazione:

[IMantieni ‘Altri' delimitatori Ultima riga di importazione:

P. C.. C. C.. C.. Coonna5 Colon... Colonn... Colon... C... Colonn... ¢
1 No. Type Year MachineMo Power Power-HZ Power-A 5CC  Machine-v [
2 150 5 488 2023 11738 3x 380 50 100 3 x 400 !
3 151 5 796 2023 11774 3x400 50 7 3 x 400 !
4 152 5 433 2023 11350 3x400 50 100 3x 400 !
< >

Le intestazioni vengono mostrate come suffisso quando si selezionano le colonne di
importazione.

Importazione dati guidata X Impostare le proprieta avanzate (Type) >
Associazioni campo y Selezionare le colonne con le informazioni di formattazione.
In quests fase & possibile assegnare le colonne di origine ai campi di destinazione. [ ‘
Proprieta testo

Tipo di marcatore: {Predefinito) PR i

Font: -
Tipo di elaborazione: (®) Colonna per Colonna () Riga per Riga i

Dimensioni; Colonna 1 - No.
Colonna 2
Grassetto:
[] Aggiungi progetto Continuo Inizio riga Colonna 3 - Type
Corsivo: Colonna 4 - Year
Q : Colonna 5 - MachineMo
T =
Ype Colonna 3 |v || ~ | V| - Colonna 6 - Power-Y
ottolineato: Colonna 7 - Power-HZ
Year = Colonna 8 - Power-A
IColonna 1 - MNo.
alonna 2 sl Colonna 9 - 5CC
MachineNo = b - - . Colonna 10 - Machine-V
Colonna 3 - Type v Erie T Colonna 11 -Machine-HZ
olonna 4 - Year Colonna 12 - ControlVoltage
Colonna 1 Colicolonna 5 - MachineMo 13 Colonna 4 Colonna 5 ™ Proprietd del campo Colonna 13 - Wiring
Colonna 14
Mo. olonna & - Pawer-V Year MachineNo Promrict: Colonna 15
150 5 [Colonna 7 - Power-HZ 2023 11738 Hais Colonna 16
151 g [colonna 8 -Power-A 2023 11774 Alineamento orizzontale Colonna 17
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Stampa

Introduzione

Questo capitolo descrive la struttura, la calibrazione e I'assegnazione delle stampanti ai
marcatori MultiCard, alle etichette, ecc. dopo la siglatura e le due possibilita di stampa:

1. Tramite la finestra di dialogo predefinita di stampa (vedere la sezione "Richiamo del menu di
stampa").

2. Tramite la stampa veloce (vedere la sezione "Stampa rapida").
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Richiamo del menu di stampa

® Selezionare la voce di menu File > Stampa...

Viene aperta la finestra di dialogo di stampa che consente di stampare o di definire tutte le
impostazioni per le stampanti.

[~ B
ZF Stampa progetto ﬁ

Stampante

[ - Impostazioni..
Assegna stampante per DEK 5/6 MC NE WS Aszegna .
MNumero di copie Duplica marcatori

Numero di copie: = umero duplicati: 1

["] cambia ordine di stampa Ordinato

Lawori

(@) Tuth i tipi di marmtori. . .

() Tipo di marcatore CC 1527 Spostarmento! 1=

() Pagine singol

() Cartellini selezionat .

Senza identificazione progetto, mantieni la posizione dei cartellini

o

E

riscaldamento astro inchiostrat

[ visualizzare Ia finestra del messagaio per il cambio del tipo di marcatore .
["] senza fissaggio (solo Printlet ADVANCED.

Stampa I [ Annulla

1 Impostazioni
Consente di visualizzare, se presente, la finestra di dialogo relativa all’'installazione
della stampante.
PrintJet PRO puo essere configurato solo mediante il menu Opzioni (vedere il
capitolo "PrintJet PRO").
Se il pulsante non fosse attivo dopo la selezione di una stampante, puo essere
attivato tramite la Finestra di dialogo Opzioni (vedere capitolo "Finestra di dialogo
Opzioni", sezione "Ambiente", sezione "Visualizza")

2 Assegna
Consente di assegnare una stampante al tipo di marcatore selezionato.
L'assegnazione selezionata viene salvata. Per modificare vedere il capitolo
"Assegnazione della stampante a un tipo di marcatore".
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3 Numero di copie
Con quale frequenza deve essere eseguito il processo di stampa?
La stampa pud anche avvenire separatamente in base ai marcatori (duplicati)
(vedere il capitolo "Impostazione processi di stampa").
Il campo di selezione "Cambia ordine di stampa" mantiene il valore selezionato
fintantoché il programma resta aperto. L'ordine di stampa inverso viene utilizzato
solo per il materiale continuo.

4 Tuttii tipi di marcatori
Vengono stampati tutti i tipi di marcatore indicati nell'elenco.

5 Tipo di marcatore
Viene stampato solo il tipo di marcatore selezionato.

6 Pagine singole
Selezione di pagine speciali per la stampa di diversi tipi di marcatore.

7 Marcatori selezionati
Scegliere se stampare anche l'identificazione progetto, se i marcatori devono
mantenere la loro posizione o se devono essere riuniti.

8 Stampa di sottoprogetti
Consente di stampare i marcatori da sottoprogetti. Vedere il capitolo: “Stampa di
sottoprogetti®.

9 Spostamento
Nella finestra di dialogo "Stampa progetto” € indicato un campo "Spostamento” nel
caso in cui sia selezionato solo un tipo di marcatore per la stampa.
L’offset sposta il punto di inizio della stampa su un marcatore diverso dal primo.
Scegliete ad esempio un offset di 8 per stampare a partire dall’ottavo marcatore (i
primi 7 rimangono vuoti). Normalmente il campo & impostato su 1.

10 Selezione delle pagine definita dall’'utente
Se si seleziona "Singole pagine” (vedi punto 7) & possibile scegliere tra i tre
pulsanti. La selezione puo essere effettuata tra:
- Pagine definite dall’'utente (selezione manuale delle pagine)
- Seleziona tutte le pagine
- Deseleziona tutto (non selezionare alcuna pagina)

11 Tipo
Consente di visualizzare tutti i tipi di marcatore del progetto attivo che possono
essere stampati.

12 Titolo del tipo di marcatore/Nome della variante
Il titolo del tipo di marcatore. Il titolo del tipo di marcatore. Facendo clic sul titolo
della colonna vengono visualizzati i nomi delle varianti (vedere il capitolo
"Rinominare un prodotto™).

13 Pagine
Consente di visualizzare il numero delle pagine stampabili del tipo di marcatore
14 Numero
Con quale frequenza deve essere stampato il tipo di marcatore presente
nell'elenco?

Fare clic sul campo e immettere il numero di copie.
Notare che il numero viene moltiplicato per il numero di copie.
15 Stampante
La stampante assegnata al tipo di marcatore. Per modificare vedere il capitolo
"Assegnazione della stampante a un tipo di marcatore".
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16 Riscaldamento
Il riscaldamento prescritto per il tipo di marcatore (a seconda della stampante
scelta).

17 Qualita
Viene visualizzata la qualita di stampa impostata sulla PrintJet
ADVANCED/CONNECT.

18 Nastro inchiostratore
Se disponibili, vengono visualizzate informazioni sul nastro inchiostratore della
stampante.

19 Mostra cambio del tipo di marcatore
Se il processo di stampa prevede vari tipi di marcatore, prima del passaggio a un
altro tipo di marcatore viene visualizzata una finestra di dialogo che consente ad
esempio di modificare il vassoio della stampante o la piastra di supporto del
plotter.
Il valore di questo campo di selezione viene salvato e riutilizzato al successivo
richiamo del dialogo di stampa. Nella stampa rapida (vedere capitolo "Stampa
rapida") questo campo viene ignorato.

20 Senzafissaggio (solo PrintJet ADVANCED/CONNECT)
Durante la stampa sulla PrintJet ADVANCED/CONNECT non viene avviato il
riscaldamento. Il colore non é fissato e pud essere nuovamente rimosso ad es.
con acqua fredda.
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Assegnazione della stampante a un tipo di marcatore

Di default la stampante non € assegnata ad alcun tipo di marcatore.

Se durante il processo di stampa non € stata assegnata una stampante a uno o a tutti i tipi di
marcatore, la stampa avverra, dopo aver confermato il messaggio di avviso, sulla stampante

predefinita.

® Aprire la finestra di dialogo di stampa mediante le voci di menu File > Stampa....

® Nel campo di selezione evidenziare il tipo di marcatore a cui si desidera assegnare una
stampante.

® Nel settore "Stampante" selezionare una stampante e premere il pulsante Assegna.

® Nella finestra di dialogo di selezione visualizzata in seguito sara possibile definire se si tratta
di una stampante o di un plotter.

® Nella finestra di dialogo seguente potete determinare se devono essere assegnate tutte le

varianti del prodotto alla stampante. Selezionate "No" per assegnare solo la variante
selezionata.

Ad ogni stampa successiva la stampante selezionata verra assegnata automaticamente a
guesto tipo di marcatore.

Anziché a singole stampanti, I'assegnazione puo essere effettuata anche a gruppi di stampanti.
Vedere il capitolo "Gruppi di stampanti PJC", "Gruppi di stampanti PJA".

6 Per modificare la stampante assegnata al tipo di marcatore, selezionare la

stampante prescelta tra quelle installate o attivare la finestra di dialogo di
assegnazione (vedere il capitolo "Finestra di dialogo Opzioni", sezione "Plotter",
sezione "Generale").

e L'assegnazione € necessaria solamente per i tipi di marcatore che possono

essere stampati su stampante o su plotter. Le etichette a modulo continuo
possono essere stampate solo sulla stampante.

e Se nell'elenco mancano delle stampanti, controllare I'elenco dei dispositivi di

output disponibili. Vedere capitolo "Finestra di dialogo Opzioni", sezione
"Assegnazione".
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Correzione della stampante

La stampante puo, per motivi dovuti alla casa costruttrice o per motivi ambientali, variare la
calibrazione predefinita in direzione orizzontale e verticale.

Per provvedere alla correzione della stampante, selezionare il menu Strumenti >

Impostazioni stampante > Esegui correzione stampante....

Viene aperta la finestra seguente:

Effettua comrezione stampante

]

Fase 1: selezionare la stampante

Selezionare |a stampante per guesto tipo di marcatore.

= ] [ Impostazioni...

[ Margine pagina...

Assegna stampante per ESG 9,20 [ Aszegna

Fase 2: stampare una pagina di prova

Per determinare la velodta di avanzamento pagine della stampante si deve
prima stampare un rettangolo di grandezza predefinita.

Larghezza specifica (X): 210 mm

Altezza spedfica (Y): 43 mm Stampa rettangolo

Fase 3: misurare le dimensioni effettive

Misurare la larghezza e 'altezza correnti del rettangolo ed immettere i valari
nel campo sottostante.

Larghezza corrente (X): 210 mm 100 %
Altezza corrente (Y): 43  mm 100 %
[ Stampa rettangolo
[ OK ] [ Annulla
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Stampare una pagina di prova con un rettangolo con dimensioni predefinite.

® |mmettere nei campi Larghezza specifica (X) e Altezza specifica (Y) le dimensioni del
rettangolo e premere il pulsante Stampa rettangolo.

® Misurare la larghezza e I'altezza del rettangolo stampato e riportarne i valori nei campi
Larghezza corrente (X) e Altezza corrente (Y) nel caso in cui le misure divergano dai valori
predefiniti.

® Chiudere la finestra con OK.

6 La correzione della stampante non & consentita per i plotter!
Tutte le stampanti che vengono dichiarate plotter (vedere "Plotter") non sono
visualizzate nel campo di selezione della stampante.

La correzione della stampante pud essere effettuata una sola volta per ogni
stampante. Non dipende dal tipo di marcatore.

@

Sulla PrintJet ADVANCED/CONNECT questa funzione viene stampata senza
fissaggio e nella qualita di stampa "Rapida"/’Standard (300 dpi)“.

Anche con la PrintJet CONNECT la calibratura automatica viene disattivata per
un breve periodo.

@
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Compensa dilatazione materiale

Per impostare il margine della pagina MultiCard e 'avanzamento MultiCard richiamare la voce di

menu Strumenti > Impostazioni stampante > Correggi ingresso materiale...

Compensa dilatazione materiale ESG 9/20 (E5G 9/20 MC NEUTRAL WS5)

LX)

Fase 1: selezionare la stampante

Selezionare |a stampante per guesto tipo di marcatore.

b ] [ Impostazioni. ..

[ Margine pagina...

Assegna stampante per ESG 9,20 [ Aszegna

Fase 2: stampare una pagina di prova

Per determinare la velodta di avanzamento pagine della stampante si deve
prima stampare un rettangolo di grandezza predefinita.

Larghezza specifica (X): 210 mm

Altezza spedfica (Y): 43 mm Stampa rettangolo

Fase 3: misurare le dimensioni effettive

Misurare la larghezza e 'altezza correnti del rettangolo ed immettere i valari
nel campo sottostante.

Larghezza corrente (X): 210 mm 100 %
Altezza corrente (Y): 43  mm 100 %
[ Stampa rettangolo
[ OK ] [ Annulla
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Stampare una pagina di prova con un rettangolo con dimensioni predefinite.

® |mmettere nei campi Larghezza specifica (X) e Altezza specifica (Y) le dimensioni del
rettangolo e premere il pulsante Stampa rettangolo.

® Misurare la larghezza e I'altezza del rettangolo stampato e riportarne i valori nei campi
Larghezza corrente (X) e Altezza corrente (Y) nel caso in cui le misure divergano dai valori
predefiniti.

® Chiudere la finestra con OK.

Sulla PrintJet ADVANCED/CONNECT questa funzione viene stampata senza
fissaggio e nella qualita di stampa "Rapida"/”Standard (300 dpi)“.

Anche con la PrintJet CONNECT la calibratura automatica viene disattivata per
un breve periodo.
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Impostazione della stampante a seconda del tipo di marcatore

Se la stampa non avviene nella giusta posizione sull’'oggetto da stampare (cartellino MultiCard,
etichetta ecc.), esiste la possibilita di adattare la stampante al relativo oggetto.

L'impostazione puo avvenire sul lato di stampa con la scelta dell’oggetto da stampare (vedere la
sezione "Impostazione della stampante a seconda dell’oggetto da stampare™) oppure sul
programma con 'impostazione dei margini, del’avanzamento ecc. (vedere la sezione
"Adattamento offset della stampante").

Nelle seguenti stampanti per materiale continuo € possibile adeguare la posizione di stampa:
THM MMP, THM MULTIMARK, THM MULTIMARK PLUS, THM Plus M. Vedere capitolo
"Impostazione della posizione di stampa”.
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Impostazione della stampante a seconda dell’oggetto da stampare

Nella stampa di etichette la stampante deve essere impostata correttamente sull’oggetto da

stampare.

® Aprire la finestra di dialogo di stampa mediante le voci di menu File > Stampa...

Viene aperta la finestra di dialogo di stampa.

® Selezionare la stampante da impostare e premere sul pulsante Impostazioni....

M Stampa progetto (Nuovo progetto)

Skampante
|pica 10408 w | [ Impostazioni. .. ]
Assegna stampante per CC 15027

Viene aperta la finestra relativa all'installazione della stampante.

Druckeinrichtung
Drucker
M arne: pica 1048 R | [ Eigenschaften... ]
Status: Beieit
Typ: Lexmark Optra
Standort:  Part
K.ommentar.
Fapier Orientierung
GroRe: Standardetikett 101 = 150 rm B (®) Hochformat
Guele: ‘ Automatizch auswahlen v | ) Querformat

® Selezionare nel settore Carta I'oggetto corretto da stampare e fare clic su OK.

Se l'oggetto corretto da stampare non & disponibile, & possibile immettere le opportune
impostazioni mediante il pulsante Proprieta... della stampante.
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Per fare in modo che queste impostazioni siano disponibili all'avvio successivo del programma,
occorre impostare le proprieta della stampante direttamente nel driver di quest'ultima (vedere a
guesto proposito anche il manuale o la guida rapida della stampante).

® Fare clic sul pulsante Start di Windows, dopodiché selezionare Pannello di controllo >
Stampante.

® Fare clic con il pulsante destro del mouse sulla stampante corrispondente e selezionare la
voce Proprieta dal menu di scelta rapida.

® |mpostare 'oggetto corretto da stampare.
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Adattamento offset della stampante

Per calibrare una stampante assegnata, richiamare la voce di menu Strumenti > Stampante >
Amministrazione stampante > Calibrazione....

o In caso di selezione della stampante "Stampa file PJA" non é possibile una
calibrazione. Compare un messaggio di avviso corrispondente.

Viene visualizzata la finestra seguente:
(La riproduzione della figura dipende dal tipo di marcatore)

doPDF v7 LX)

Margine della pagina
In alto: 1 mm Anzitutto calibrare I'offset stampa
diagonale. Quindi cambiare il valore

sinistro e superiore fino a che il

piano di coordinate non si trova sul
marcatore nella posizione mostrata.

| Sinistra:

0 mm
Offset stampa diagonale:

Lok

Ripristina impostazioni standard

[ Stampa piano di coordinate. .. l

[ Effettua correzione stampante... l

[ Compensa dilatazione materiale. .. l

l Imposta tipo di marcatore... ]
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Impostazione del margine destro e sinistro

Impostazioni per i marcatori

Per impostare il margine destro e sinistro di un cartellino MultiCard, si deve stampare un sistema
di coordinate sul cartellino MultiCard misurandone la posizione.

Il sistema di coordinate dovrebbe avere la seguente posizione:

o Sulla PrintJet ADVANCED/CONNECT questa funzione viene stampata senza
fissaggio e nella qualita di stampa "Rapida"/’Standard (300 dpi)“.
Anche con la PrintJet CONNECT la calibratura automatica viene disattivata per
un breve periodo.

® Per la stampa di un sistema di coordinate di prova, fare clic sul pulsante Stampa piano di
coordinate....
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Impostazione dell’angolo di rotazione

Se il materiale non é alimentato in rettilineo (ma ruotato), I'angolo di rotazione dell'immagine di
stampa puo essere regolato tramite un offset di stampa diagonale.

Sono supportante le seguenti stampanti: PrintJet CONNECT, PrintJet Mini

.-é Offset stampa diagonale:

Lo

NRNNJREND
(LTI LT LT
[LLLI LLLL

e Anzitutto calibrare I'offset stampa diagonale. Quindi cambiare il valore sinistro e
superiore fino a che il piano di coordinate non si trova sul marcatore nella
posizione mostrata.
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Contemporaneamente alla stampa si aprira la finestra "Stampa piano di coordinate".

Stampa pianc di coordinate

Misurare |a distanza sinistra (X) & superiore (¥) del sistema di coordinate e
riportare i valori misurati nei campi sottostanti.

_ L[| L& L
X Y
I Y
f
| r i r
I
X 0 mm mim
| 0K | [ Annulla ]

® Misurare il margine destro e sinistro del sistema di coordinate stampato come rappresentato
e riportarne i valori nei campi corrispondenti. Chiudere la finestra facendo clic su OK.

Ripetere eventualmente ancora una volta questi passaggi per verificare la posizione del sistema

di coordinate.
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Impostazioni per le etichette

Per impostare il margine destro e sinistro di un’etichetta, se ne dovra stampare una (puo risultare
utile un rettangolo pieno con le dimensioni dell’etichetta) misurandone la posizione.

E importante che sulla stampante sia stato impostato correttamente il tipo di oggetto (vedere la
sezione "Impostazione della stampante a seconda dell’oggetto da stampare").

L’etichetta dovrebbe avere la seguente posizione:
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Misurare il margine destro e sinistro dell’etichetta come rappresentato e riportarne i valori nei
campi corrispondenti. Chiudere la finestra facendo clic su Salva.

doPDF w7

o

Margine della pagina

Sinistra:

0 mm

In alto: i mm

Anzitutto calibrare |'offset stampa
diagonale. Quindi cambiare il valore
sinistro e superiore fino a che il

piano di coordinate non si trava sul
marcatore nella posizione mostrata.

Offset stampa diagonale:

Ripristina impostazioni standard

Stampa piano di coordinate. ..

Effettua correzione stampante...

Compensa dilatazione materiale..

—

Imposta tipo di marcatore. ..

Ripetere eventualmente ancora una volta questi passaggi per verificare la posizione
dell’etichetta.

L'impostazione del margine laterale deve essere effettuata solo una volta per
ciascuna stampante. Gli offset della stampante non dipendono dal tipo di

marcatore.
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Impostazione delle dimensioni del tipo di marcatore

Puo succedere che i tipi di marcatore non corrispondano alle dimensioni normali, ad esempio per

motivi legati alla temperatura delllambiente.

® Fare clic sul pulsante Imposta tipo di marcatore... oppure selezionare nel menu File la

voce Imposta tipo di marcatore....

Si aprira la finestra seguente.

[ Printlet CONNECT MW
[ Printlet ADVANCED {USB1)
[] ™M™ MMP usE

Adatta tipe di marcatore - ESG 8/19 (ESG 8/19 MC NE WS) e
Inserire la larghezza e l'altezza correnti del campo sottostante.
CEnTET
b
¢ +
Misurazione automatica (solo PIC)
(®) Calibra solo il primo marcatore
(C) Imposta tutti i marcatori
Grandezza spedifica (valore ideale) Dimensione corrente
Larghezza: 210 mm Larghezza (X): mm 100 3%
Altezza: 56 mm Altezza (¥): mm 100 %5
Spostamento (a): l:l mm
Spostamento (b): I:I mm =
Opzioni
Utilizzare questa impostazione per le sequenti stampanti:
~

Annla
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® Nel settore Opzioni selezionare la stampante per la quale queste impostazioni devono
essere salvate.

® Misurare la larghezza e I'altezza del tipo di marcatore in questione come rappresentato e
riportarne i valori nei campi Larghezza (X) ed Altezza (Y).

® Chiudere la finestra con il pulsante OK.
Strumento di calibrazione
Esiste la possibilita di creare una stampa di prova mediante uno strumento di calibrazione.

Questo strumento consente di stampare dei quadrati delle dimensioni del marcatore e dei punti
di centratura.

® Nel settore Opzioni selezionare la stampante in cui deve essere stampato lo strumento di
calibrazione.

=

® Fare clic sul pulsante
E inoltre possibile utilizzare il seguente pulsante per stampare una pagina di prova sulla
stampante PrintJet ADVANCED/CONNECT:

® | o strumento di calibrazione viene stampato sulla stampante.

Esempio:

o per il plotter non e disponibile lo strumento di calibrazione.

o Sulla PrintJet ADVANCED/CONNECT questa funzione viene stampata senza
fissaggio e nella qualita di stampa "Rapida"/’Standard (300 dpi)“.

o Sulla PrintJet CONNECT, lo strumento di calibratura puo essere stampato solo
se l'opzione "Misurazione automatica (solo PJC)" & deselezionata.

312 e Stampa Istruzioni per l'uso



Misurazione automatica (solo PJC)

La PrintJet CONNECT calibra automaticamente i marcatori.

Calibra solo il primo marcatore:

All'interno di un processo di stampa, viene calibrata solo la prima pagina di ogni nuovo tipo di

marcatore.

Esempio:

Imposta tutti i marcatori:
Tutte le pagine all'interno del processo di stampa sulla PJC vengono calibrate.
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Impostazione della posizione di stampa

Nelle seguenti stampanti per materiale continuo € possibile adeguare la posizione di stampa:
THM MMP, THM MULTIMARK, THM MULTIMARK PLUS, THM Plus M

® Assegnare una stampante al materiale continuo. Vedere il capitolo "Assegnazione della
stampante a un tipo di marcatore".

® Passare alla pagina delle informazioni del prodotto. Vedere il capitolo "La pagina delle

informazioni".
Impostazioni
Velodita (mm/s): Standard (75)
Temperatura: Standard (10)
Profonditd di perforazione: Standard (MA)
Taglio prima del lavero di stampa: Standard (5i)
Modalita di strappo Standard (On)
Posizione di stampa (mm): 0o Modifica. ..

® Selezionare il pulsante "Modifica...”.
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La posizione di stampa puod essere adeguata tramite un valore di spostamento.

- R
Posizione di stampa ﬁ

Immettere il valore di spostamento,
= =
L] L]
. . -
=7
|
| |
Posizione di stampa (mm): o] 0
[ 0K ] [ Annulla l
Posizione di stampa (mm):
Ripristina i valori di configurazione
[ QK ] [ Annulla ]

o Il valore di spostamento viene salvato per la combinazione di tipo di marcatore e
stampante.

Una volta modificata la posizione di stampa, al successivo processo di stampa
ha luogo un avanzamento di calibrazione di almeno 5 cm.

@
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Impostazione processi di stampa

® Selezionare nella barra dei menu le voci File > Stampa....

Si aprira la finestra di dialogo di stampa da cui selezionare i processi di stampa.

s B
ZF Stampa progetto ﬁ

Stampante

[ - Impostazioni...
Assegna stampante per DEK 5/6 MC NE WS Assegna
Mumero di copie Duplica marcatori

Numero di copie: 10 Mumero duplicati: 1

["] cambia ordine di stampa EI@III@ [¥] Ordinato

Lavari

(@) Tutti i tipi di marcatori ez

() Tipo di marcatore: CC 15/27 Spostamento: 15
() Pagine singole

() Cartellini selezionati Senza identificazione progetto, mantieni la posizione dei cartellini

Tipo Titolo del tipo di... Pagine Numero... Stampa... riscaldamento Qualitd  NMastro inchiostrat...
C... CC15/27KMC... 1 1

D... DEK 5/6 MC MNE ...

[ visualizzare la finestra del messaggio per il cambio del tipo di marcatore

["] 5enza fissaggio (solo Printlet ADVANCED)

[ Stampa ] [ Annulla ]

Se durante il processo di stampa di uno o di tutti i tipi di marcatori da stampare non é stata
assegnata alcuna stampante, la stampa avverra dopo aver confermato un messaggio di avviso.

Durante la stampa € possibile moltiplicare i singoli marcatori fino a raggiungere il numero
desiderato.
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Selezionare le impostazioni come segue:

La stampa avviene seguendo l'ordine con cui i marcatori sono disposti
sul tipo di marcatore.
La stampa avviene separatamente in base ai singoli marcatori e al

numero di duplicati impostati.

o | progetti presenti vengono mantenuti durante la duplicazione.

Esempio:

Tipo di marcatore pieno:
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Stampa ordinata con 2 duplicati:

Duplica marcatori

Murmero duplicat: 2| &
ﬂgﬂg [+] Crdinato
A5 B-5 A5 B-5
A4 B-4 A4 B-4
A3 B-3 A3 B-3
A-2 A7 B-2 Cc-2 A-2 AT B-2 C-2
A1 A6 B-1 c-1 A-1 A6 B-1 c-1
< [&] <L
Stampa separata con 2 duplicati:
Dwplica rmarcatori
Mumera duplicati: 2|z
A3 A5 B-3 B-5
A2 A5 AT B-2 B-5 c-2
A2 A4 AT B-2 B-4 c-2
A1 A4 A5 B-1 B-4 c
A1 A-3 A5 B-1 B-3 c
< <
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Stampa rapida

e Per stampare solamente la pagina attiva, fare clic sul seguente simbolo nella barra degli
strumenti.

=

Se non ¢ stata assegnata una stampante al tipo di marcatore, verra visualizzato un messaggio di
awviso.

M-Print PRO

Mon & stato possibile azzegnare ad una stampante uno o pid tipi di marcatar,
Azzegnare questi tipi di marcatorn alla stampante standard?

ok | e

Facendo clic su OK la pagina sara trasmessa alla stampante predefinita, facendo clic su
Annulla si aprira il menu di stampa per 'assegnazione a una stampante specifica (vedere la
sezione "Assegnazione della stampante a un tipo di marcatore™).

Stampa immediata avanzata
Nelle opzioni pud essere attivata la stampa immediata avanzata. (vedere capitolo "Finestra di
dialogo Opzioni", sezione "Ambiente", sezione "Generale").

Se questa funzione é attivata, in caso di stampa immediata viene visualizzata una finestra di
dialogo aggiuntiva per il numero di copie.

Starmpa immediata avanzata ot

Mumerao di copie: | = Reset

Annula

Stampa diretta

Tutti i formati file supportati dal programma possono essere stampati direttamente dalla riga di
comando.

Sintassi:  "c:\program\MPrintPRO.exe" —-p "myprint.rde"
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Monitor di stato

Durante la stampa il monitor di stato genera un messaggio relativo allo stato della stampante o

delle stampanti collegata/e.

Sono supportante le seguenti stampanti: Tutte le stampanti in Esplora stampanti

-

& Monitor di stato = | B
: Stampante Stampa lavori  Visualizza Guida
3 Monitor di stato
Stampante Stato Informazioni o x
PJA Printer Pronto = Generale -
PJA-Sim. Mon disponibile Mome
Numero seriale PA15060078
Nome modello Printlet ADVANCED
Tipo di collegame... | Rete
Indirizzo IP
Porta
Data di fabbricazio...
= Versione J
-
ﬁlnformazioni "Cartuccia
Stampa Lavori o x
ik [EE] [
Mome arti..  Mum. artic... Copie | Copie arti... | Computer... | Indirizza L., | ID stampa... 1D processo | Stato
Pronto | BLOC MAIUSC| NUM| SCRL| _.}
. <

o

Se una stampante collegata non dovesse comparire nell'elenco delle
stampanti, vi preghiamo di verificare le impostazioni della stampante
(vedere "Esplora stampanti").
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Impostazioni monitor di stato

Nel monitor mediante la voce di menu "Stampante -> Opzioni..." tra le altre & possibile effettuare
gueste impostazioni:

Opzioni *

Impostazioni generali
[ ] awvia allavvio di Windows
Mastra maonitor di stato durante l'emissione della stampa *
[] chiudi monitor di stato al termine
dei miei miei processi di stampa
di tutti i processi di stampa
solo se M-Print® PRO & stato chiuso
Ridud nella sezione dedicata alle informazioni

[ visualizza dettagli dei processi di stampa

* Riavviare M-Print® PRQ, per accettare le modifiche.

OK Annulla

Avvia all'avvio di Windows
Il monitor di stato & attivato all‘avvio di Windows.

Mostra monitor di stato durante I’emissione della stampa
La finestra Monitor di stato viene visualizzata in primo piano quando viene emessa una
nuova stampa.

Chiudi monitor di stato al termine
Chiude il monitor di stato se non sono presenti pitl processi di stampa propri o di altri.

Riduzione nella sezione dedicata alla informazioni
Alla riduzione della finestra il monitor di stato non viene visualizzato nella barra delle
applicazioni, bensi nella sezione dedicata alle informazioni.

Visualizza dettagli dei processi di stampa
Nella scheda "Processi di stampa" (vedere "Monitor di stato processi di stampa') sono
visualizzate colonne informative.
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Monitor di stato processi di stampa

Attraverso la finestra "Processi di stampa”

-

e possibile visualizzare la lista dei processi di stampa.

& Monitor di stato = | B |t
Stampante Stampa Lavori  Visualizza Guida
=F Monitor di stata
Stampante Stato Informazioni o X
PJA Printer Pronto = Generale -
PJA-Sirmn. Meon disponibile Mome
Murnero seriale PA15060078
MNome modello Print/et ADVAMNCED
Tipe di collegame... | Rete
Indirizze IP
Porta
Data di fabbricazio...
= Versione J
-
flnformazioni "Cartuccia
Stampa Lavori o X
t5: ][]
Mome arti.. | Num, artic... Copie | Copie arti... | Computer... | Indirizzo L., | ID stampa... D processo | Stato
Pronto | BLOC MAIUSC) NUM| SCRL| .
L A

Per cancellare i processi di stampa esistenti, selezionare I'opzione "Processi di stampa" nel

menu del monitor di stato.

Per modificare il numero delle colonne informative da visualizzare si rimanda alla sezione

"Impostazioni monitor di stato").

Apri statistiche di stampa

Tramite la voce di menu "Processi di stampa > Apri statistiche di stampa..." vengono visualizzate

le statistiche di stampa correnti.

Attivare inoltre anche la funzione di protocollo. Vedere il capitolo ,Salva statistiche di stampa®“.
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Informazioni

All'interno della finestra "Informazioni" sono visualizzate le informazioni relative alla stampante.

Vengono ad esempio visualizzati i livelli di iempimento e la data di scadenza delle singole
cartucce di stampa (in funzione della stampante).

o R
l_‘_ Mconitor di stato E‘Elg
! Stampante Stampalavori  Visualizza Guida
=& Monitor di stato

Stampante Stato Informazioni o ox
Eji—:lr:%er Eroo:zoisponibile 0 = 10

L —— 8%

| 78%

) — 73%

Ll 73%

@Informa-zi-oni I ICartuccia

Stampa Lavori o x
EReN-
Mome arti... | Mum, artic... Copie Copie arti... | Computer... Indirizzo L.. | ID stampa... | ID processo | Stato
Pronto | BLOC MAIUSC| NUM| SCRL| )
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Esplora

stampanti

Con Esplora stampanti & possibile aggiungere o rimuovere le seguenti stampanti: PrintJet
ADVANCED, PrintJet CONNECT, PrintJet MINI, THM MMP, THM MultiMark, THM MultiMark

Plus, THM MultiMark LPC, THM MultiMark Twin

Al contrario di quanto accade nel caso delle stampanti consuete, per queste stampanti non &

necessario installare alcun driver, poiché si tratta di stampanti in rete.

Avviare Esplora stampanti tramite il menu di avvio di Windows (cartella "Weidmueller").

& Ecplora stampanti — *

MNome & | Nome del modello Mumero di sere MNome di rete / IP

PrintJet CONNECT MW PIC PIC20100003 192, 168.42.47

PrintJet ADVANCED {(USE1) PJA PA15060078 172,16.30.1

THM MultiMark MW THM MultiMark. 192,.168.42.244

< »
Aggiungi. .. Prova Proprietd ... Elimina Chiudi
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Aggiungi stampante
Per aggiungere una stampante, avviare Esplora stampanti e fare clic sul pulsante "Aggiungi...".

® Selezionare il modello di stampante.

Muodello di stampante

Selezionare il modello di stampante che si desidera aggiungere.

Stampante a trasferimento termico:

Stampante a getto dinchiostro:
THM MultiMark Printlet MINI
THM MultiMark Plus PrintJet CONMECT
THM MultiMark LFC Printlet ADVANCED

THM MultiMark Twin

THM MMP

® Selezionare tramite quale connessione é collegata la stampante.

LX)

Tramite guale connessione & collegata la stampante?

| USB )

[ Rete |

Annulla
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Connessione USB

® Fare clic sul pulsante "USB".
® Viene avviata automaticamente la ricerca delle stampanti collegate.

Aggiungi Printlet - USE >

Gill & possibile vedere il risultato della ricerca. Selezionare le interfacce USE che &
necessario aggiungere alla lista stampant.

[ ]usB1 (non trovata)
[ ]usB2 (non trovata)

[ JUsSB3 {non trovata)

Cerca di nuovo Agaiungi selezione

(o]

Aggiungi - USB ||

Gill & possibile vedere il risultato della ricerca. Selezionare le stampanti da aggiungere
alla lista stampanti.

Mumero di serie

170111856727

Cerca di nuovo Aggiungi selezione ] [ Interrompi

® Selezionare la connessione USB o stampante desiderata.
® Fare clic sul pulsante "Aggiungi selezione".
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Collegamento in rete
® Fare clic sul pulsante "Rete".
pulsante "Aggiungi" oppure

"Aggiungi stampante selezionata".

Aggiungi Printlet ADVAMNCED - Rete

s

Qui si ha la possibilita di aggiungere una stampante con il suo numera

di serie [ nome di rete oppure con il suo indirizzo IP.

Mumero di serie;

I @

H Aggiungi
Mome di rete:
| | '@' Aggiungi
Indirizzo IF:
| | '@' Aggiunagi
Cerca in rete... Annulla
oppure

Aggiungi Printlet CONMECT - Rete

E possibile aggiungere una PrintJet CONNECT inserendo

lindirizzo IP e |la porta.

Indirizzo IP:

Porta:
| 8181 |

Cercain rete. ..

Aggiunagi

Annulla

Nella finestra di dialogo inserire le impostazioni della stampante in rete e fare clic sul

Fare clic sul pulsante "Ricerca in rete ..." e nel dialogo di ricerca fare clic sul pulsante
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oppure

Aggiungi THM - Rete % |

E possibile aggiungere una stampante inserendo l'indirizzo IF € la
porta.

Indirizzo IP: | |

Porta: FTP Port:

Aggiungi Annulla
oppure
Aggiungi SmarkLaser CEMTER - Rete x
E possibile aggiungere una SmarkLaser CENTER inserendo lndirizzo
IP & |a porta.
Indirizzo IP: | |
Porta: | 2100 |

Aggiungi Annulla

Nella finestra di dialogo inserire le impostazioni della stampante in rete e fare clic sul pulsante
"Aggiungi".

Per testare le impostazioni selezionare la funzione di prova (vedere "Testare la stampante").
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Testare la stampante

Per testare la raggiungibilita di una stampante collegata, € necessario avviare Esplora stampanti,
selezionare una stampante dall'elenco e fare clic sul pulsante "Test".

Se il test di connessione non dovesse andare a buon fine, vi preghiamo di verificare le
impostazioni della stampante (vedere "Proprieta della stampante").

Sono supportante le seguenti stampanti: PrintJet ADVANCED, PrintJet CONNECT, PrintJet
MINI, THM MMP, THM MultiMark, THM MultiMark Plus, THM MultiMark LPC, THM MultiMark
Twin

Proprieta della stampante

Per visualizzare e adeguare le proprieta di una stampante collegata, & necessario avviare
Esplora stampanti, selezionare una stampante dall'elenco e fare clic sul pulsante "Proprieta".

Si aprira quindi una finestra di dialogo nella quale potete impostare il nome della stampante ed
eventualmente la porta.

Sono supportante le seguenti stampanti: PrintJet ADVANCED, PrintJet CONNECT, PrintJet
MINI, THM MMP, THM MultiMark, THM MultiMark Plus, THM MultiMark LPC, THM MultiMark

Twin
Proprietd stampante >
Mome visualizzato: PIC Printer
Mumero di serie; PIC20100003
Mome di rete: PIC20100003
Indirizzo IP: 192, 168.42.47
Porta: 8181
E QK i Interrompi
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Impostare marche di taglio

Per stampare materiale continuo su una stampante € possibile impostare e rimuovere le marche
di taglio manuali (vedere il capitolo "Interfaccia del programma”, sezione "THM MMP").

Puo essere inoltre inviato un comando di taglio diretto alla stampante, se questa & assegnata al
materiale e collegata.

Sono supportante le seguenti stampanti: THM MMP, THM MULTIMARK, THM MULTIMARK
PLUS, THM Plus M

Esempio: Marche di taglio prima (1) e dopo (2).

s

| | Illﬂ| | | I%U| l | I3IU| | | I4iU| | | IEIU| | | IEIU| | | I?IU| | 1 I8I0| | | ISIU| | IITUIU| | IHllnl 1 I]12|U| |
L @
ol
k= : : :
ﬂ:
=
E:
==
-
]
oo
=2
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Stampa di sottoprogetti

E possibile selezionare sottoprogetti e relativi contenuti nella finestra di dialogo di stampa ai fini
di una stampa mirata degli stessi. Vedere il capitolo: "Richiamo del menu di stampa".

1. Fare clic sull'icona Esplora progetti nella finestra di dialogo di stampa.
2. In Esplora progetti selezionare il sottoprogetto da stampare.

- Esplora progetti ; E

Seleziona un sottoprogetto per stamparne lintero

contenuto.

EIE Muowo progetto
MultiCard

MetalliCard
MultiMark

ShrinkTube
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Modo di stampa

Commuta tra le seguenti visualizzazioni:

® Normale
® Modo plotter

Modalita di stampa - Normale
Tutti gli elementi sono visualizzati.

Modalita di stampa - Modo plotter

Nel Modo plotter vengono indicate nell'interfaccia utente solo quelle funzioni e quegli elementi
che sono disponibili per il plotter. Vedere il capitolo ,Modo plotter*.
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Stampa LPC

Per creare file di stampa LPC, selezionare la seguente stampante: Output di file THM MultiMark
LPC-Tool

Per la stampa € necessario selezionare la modalita output.

Modalitd output LPC-Tool x

Seleziona la modalitd output per la stampa:

() Modalitd Online

La stampa deve essere eseguita tramite LPC-Tool,

(®) Modalita standalone

La stampa deve essere eseguita tramite chiavetta
USE,

Annuila

LPC: Modalita Online

La stampa deve essere eseguita tramite LPC-Tool.
Viene creato un file di stampa di tipo *.Ipc.

LPC: Modalita standalone

La stampa deve essere eseguita tramite chiavetta USB.

Opzieni modalita standalone dell'LPC-Tool X
Name file [EsGp 615 MM s |
Cartella di | | =]

[ sovrascrivii file esistenti

MNome progetto: | Meues Projekt
Modslita di laverazione Conferma di stampa
(®) Definizione utente (®) Definizione utente
() Scan Mode Oon
(O} Batch Mode O off
Annula
Scan Mode

La stampante seleziona il marcatore tramite la scansione di un segno di identificazione presente
nel file di stampa.

e Uno scanner deve essere collegato alla stampante.

Batch Mode
I marcatori vengono stampati nell’'ordine del file di stampa.
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Comando del plotter

Introduzione

Questo capitolo descrive l'installazione, il comando e I'assegnazione del plotter ai fogli
MultiCard, alle etichette ecc. siglati e le possibilita di utilizzo del plotter.

Il plotter pud essere comandato tramite interfaccia Centronics o USB.

Tutte le funzioni generali di stampa sono reperibili nel capitolo "Stampa".

Modo plotter

Nel Modo plotter vengono indicate nell'interfaccia utente solo quelle funzioni e quegli elementi
che sono disponibili per il plotter.

Nel Modo plotter sono consentiti i seguenti elementi:
5. Grafica, nei limiti dei simboli del plotter (*.mps)
6. Campi di testo con caratteri del font del plotter

7. Linee

Tutti gli elementi sono rappresentati in bianco e nero.

Quando si effettua il passaggio al Modo plotter, vengono verificati tutti i livelli alla ricerca degli
elementi che non si possono plottare. Se vengono rilevati elementi di questo tipo, viene
visualizzato un messaggio di awviso.

Questi elementi (ad esempio codici a barre) non vengono piu visualizzati, anche se restano
disponibili internamente. Quando si abbandona il Modo plotter, tutti gli elementi diventano
nuovamente visibili.

® Per attivare o disattivare il Modo plotter, selezionare le voci di menu Commuta modalita di
stampa > Plotter o fare clic sul simbolo:

(2] > eet

® || Modo plotter & segnalato dalla dicitura "Modo plotter", posta accanto al numero di versione,
come pure da un simbolo rappresentato premuto nella barra dei simboli:

Quando si passa al Modo plotter, tutti gli elementi del livello bloccato restano
visibili, affinché sia possibile notare eventuali spazi liberi che potrebbero
danneggiare il pennino del plotter.

Il livello bloccato non viene perd utilizzato nel Modo plotter!
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Opzioni di avvio per il Modo plotter

E possibile impostare la visualizzazione del Modo plotter nelle Opzioni (menu Strumenti >

Opzioni).
Opzioni *
3 Ambiente Avvio del programma
23 Plotter Awviare con Plot Mode
Ao
g Avvic del programma @® Sempre
Struttura MultiCard
Struttura SF 4-6 (0 Quando l'ultimo mods & stato il Modo Plot
Provare il pennino velocitd Plotter: Standard ~

Fare clic sul quadratino di "Avvia con Plot Mode", se & necessario avviare M-Print® Pro dopo un

riavvio del computer, all’apertura di un file M-Print Pro memorizzato o del nuovo impianto di un
progetto nel Modo plotter.
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Stampare/Plottare

L’'uso del plotter segue la stessa procedura della stampa (vedere "Stampa").
Per prima cosa va assegnato un plotter al tipo di marcatore (vedere "Assegnare il plotter a un

tipo di marcatore").

Fatto cio, si procede alla calibratura del marcatore (vedere "Impostazione della stampante a
seconda del tipo di marcatore") e il plotter pud essere calibrato (vedere "Adattare il tipo di

marcatore al plotter").

Scegliere il pennino e la piastra di supporto

Prima dell’'avvio del plotter appare una finestra di dialogo con le impostazioni per il tipo di
marcatore scelto.

Struttura MultiCard

Selezione
Flotter; Generic | Text Only

Pennino: SUN pEnning

Skrutkura 1 Skrutkura 2

Impostare le regolazioni del plotter e trasferitle come indicato nellilustrazione .

Strutbura 3 Skrukkura 4

Strutkura 5

M ZTIZT K
MELTRAL WS

1753000000

SF 221
MELITRAL WS

1696100001

Senza piastra di
supparto

SF 312
MELITRAL BL

17113570002

Ukiizza Lltjizza Ltizza Lkizza Lkiizza
carnice COFNice carnice carnice carnice
( ® ® ® ®

L Continuare a plottare ] [

Ignora ] [

Annulla

Scegliere il pennino

Scegliere il pennino che deve essere utilizzato dal plotter. La preimpostazione del pennino
awviene nella finestra di dialogo Calibratura (vedere "Dialogo Calibratura").

Impostando "Nessun pennino" si puo utilizzare un pennino esterno che non viene rimesso nel

portapennino.
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Impostare i livelli per la piastra di supporto

Con la stampa di un MultiCard vengono indicate le impostazioni dei livelli per la piastra di
supporto.

Disporre la piastra sul livello indicato (da 1 a 5). Ricordarsi che per alcuni MultiCard non &
necessaria alcuna piastra di supporto.

Cambiare i tipi di marcatore

Se si stampano piu pagine o tipi di marcatori nell’ambito di un progetto, in una finestra di dialogo
viene indicato supporto ed equipaggiamento per la stampa immediatamente successiva.

Struttura MultiCard X
Selezione
Plotter: Generic § Text Only
Pennino: ' n penning

Impostare le regolazioni del plotter e trasferirle come indicato nellillustr azione .

Skruktura 1 Skruttura 2 Skrutkura 3 Skrubtura 4 Skrukkura &
Lkiizza Ukizza Utiizza iizza Utiizza
cornice cornice cornice carnice cornice
( ® ® ® ® b

Senza piastra di
supporka

M ZFIETK SF 312
HELITRAL %S MEUTRAL BL

1783000000 1711370002
SF zf21
MELITRAL WS

1696100001

L Continuare a plottare J [ Ignora ] [ Annulla ]

® || pulsante "Continuare a plottare" invia la configurazione indicata al plotter.
Se sono presenti pit pagine o tipi di marcatori viene indicata la configurazione successiva.
Il plotter, dopo il processo di stampa, attende che si azioni di nuovo il pulsante.

® Scegliete "Ignora” per non stampare la configurazione indicata.
Se il progetto comprende piu pagine o tipi di marcatori, viene indicata la configurazione
successiva, altrimenti il processo di stampa termina.

® "Annulla" interrompe l'intero processo di stampa.
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Adattare il punto di scrittura di prova del pennino

La posizione di scrittura di prova del plotter é fissata normalmente su due blocchi accanto al
vano del pennino, soggetti a sporcarsi abbastanza velocemente.

Per adattare il punto di scrittura scegliete nella barra dei menu la voce Strumenti e quindi
Opzioni....

Alla pagina "Prova il pennino" & possibile regolare i punti di scrittura del plotter.

Opzioni r'$_<|

77 Ambiente Imposta posizione di prova scrittura
3 Platter Ouon provare il pennino
Avwvio del programma
Skrubhura Multicard (%) Posizione standard del platker
Strutkura SF4-6 (") Posizione adattata (solo per MultiCard) § Posizione standard del platter per
g Provare il pennino etichette
Linea 1 ®1: I:l i W1 I:l i
Linea 2 X1 I:I i Y1t I:I i
e[ Sfmm vz [ 7 ]mm
Linea 3 Al I:I mm Yl I:I mm
e o ova 5|
< >
o] [omas ]

La posizione adattata vale solo per MultiCard. Per le etichette viene utilizzata tuttavia in questo
caso la posizione standard del plotter.

Il punto di scrittura adattato considera i parametri Offset X e Offset Y della correzione dei fogli.
Un punto di scrittura scelto erroneamente pud danneggiare il pennino. Vi

raccomandiamo di fare sempre prima una prova delle impostazioni eseguite
senza il pennino!
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Assegnare il plotter a un tipo di marcatore

Normalmente ad ogni tipo di marcatore va assegnata una stampante o un plotter.

Se durante il processo di stampa non € stata assegnata una stampante a uno o a tutti i tipi di
marcatore, la stampa avverra, dopo aver confermato il messaggio di avviso, sulla stampante
predefinita.

® Aprire il dialogo di stampa mediante le voci di menu File > Stampa....

® Evidenziare il tipo di marcatore che si desidera assegnare alla stampante nel campo di
selezione inferiore, selezionare una stampante nel settore "Stampante” e premere il pulsante
Applica.

Ad ogni stampa successiva la stampante selezionata verra assegnata automaticamente a
guesto tipo di marcatore.

® Selezionare nella finestra di dialogo visualizzata se si desidera assegnare la stampante o il
plotter prescelti come stampante o come plotter.

Indicare la stampante

%) Come stampante

O | Come MCP PlusfiP-2: ¥ |

Se si seleziona "Come MCP Plus..." la stampa & sottoposta alle limitazioni del modo Plot.

Questa impostazione potra essere disattivata in qualunque momento accedendo alla finestra
di dialogo delle opzioni (vedere "Assegnazione").

Se si seleziona un tipo di marcatore al quale non pud essere assegnato alcun plotter (es.
etichette su modulo continuo), verra visualizzato un messaggio di avviso.

M-Print PRO

A cauza di infarmazioni mancant nel file di configurazione il tipo di cartelling scelta

ET 57 -12/80:44 non pud ezzere stampato del platter.
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Adattare il tipo di marcatore al plotter

Per calibrare un plotter assegnato, richiamare la voce di menu Strumenti > Stampante >
Amministrazione stampante > Calibrazione....

Nella finestra che appare é possibile decidere se dimensionare il tipo di marcatore (vedere
"Impostazione della stampante a seconda del tipo di marcatore™) o calibrare i punti zero del
plotter.

| Imposta tipo di marcatore. .. |

[ Punti zera. .. ]
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Impostare i punti zero

Viene visualizzata la finestra seguente:
(La riproduzione della figura dipende dal tipo di marcatore)

x]

Opzioni
Struttura SF4-6 |
ankeprima
a - - - . 7
L ] L ]
. . .
Flokket: Informazione:
i prega di modificare i valori
Pennino: r-JE- SUM pEnninG » | % e Y fino a guando viene
raggiunto in punto zero del
0 | 1370 3| v:| 11695 |3 |plotter.
Stampare il punkozero ] [ Punti zero agaiunkivi ... ]
[ Ik ] [ annulla ] applica

® Selezionare il pennino, con il quale si desidera plottare (vedere "Scegliere il pennino e la
piastra di supporto").

® Per calibrare il punto zero, registrare le coordinate nei campi X e Y e fare clic su "Stampare il
puntozero".

® Per una regolazione di precisione fare clic con il cursore sul campo X o Y e dirigere il punto

zero sulla tastiera con i tasti N e N (per le coordinate X) o i tasti =—V e N (per le

coordinate Y).
® Scegliere il pulsante "Punti zero aggiuntivi..." per impostare altri punti zero disponibili.

Queste impostazioni possono essere effettuate anche nella finestra di dialogo Opzioni (vedere
"Dialogo Calibratura™).
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Adattare la stampante selezionata

Selezionare nella barra dei menu la voce di menu Strumenti e quindi Opzioni....

Sul lato "Generale" del plotter si trova I'assegnazione attuale delle stampanti.
Vedere capitolo "Finestra di dialogo Opzioni", sezione "Assegnazione".

Opzioni >
23 Ambiente Avvio del programma
= Plotter Avviare con Plot Mode
g fvvio del pmg!ramma @® sempre
Struttura MultiCard
Struttura SF 4-6 () Quando l'ultimo modo & stato il Modo Plot
Provare il pennino velodta Plotter: Standard ~
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Explorer simboli / Editor simboli plotter

Symbol Explorer & stato ampliato con i simboli del plotter (*.mps) e un campo di selezione per
sottoelenchi dei simboli.

Simboli x

| “aymbals, - |

| |

.

[}

"LH_\-L.EL_

I__:
=
m—

Ulteriori informazioni sul Symbol Explorer sono reperibili nel capitolo "Comando generale” nella
sezione "Inserimento di simboli".
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Elaborare un simbolo del plotter/creare un nuovo simbolo

Creare un nuovo simbolo del plotter

® Fare clic con il pulsante destro del mouse nel Symbol Explorer su un campo simbolo vuoto e
selezionare Editor dei simboli plotter....

Elaborare un simbolo del plotter

® Fare clic con il pulsante destro del mouse su un simbolo del plotter e selezionare Compilare
con l'editor dei simboli plotter....

Dialogo Calibratura

Con il plotter possono essere utilizzate tre diverse piastre di supporto in funzione dei tipi di
marcatore scelti.

Queste piastre di supporto possono essere impostate nel dialogo Calibratura (punto zero,
pennino ecc.).

® Selezionare nella barra dei menu la voce di menu Strumenti e quindi Opzioni....
Si apre la finestra di dialogo Opzioni.

| passi da seguire per la calibratura sono descritti nel file allegato "printersetup.pdf”.
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Piastra di supporto MultiCard

® Selezionare nella finestra di dialogo Opzioni "Struttura MultiCard".

Opzioni E|

1 Ambiente Anteprima
=3 Plotker

Avvio del programma

Strutbura MultiCard
Strutkura SF4-6
Provare il pennino

Plotter: |'|,'|,ISBPBSR\E'|,Lexmark Cptras P w | Infarmazione:
Si preqga di modificare i valori
Penning: |Nessun pEnninG L | ¥ e ¥ fino a gquando viene
raggiunko in punto zero del
% | 130 (5| w | 11e90 g |plotter.
< | » [ Stampate il puntozero ] l Punki zero aggiuntivi ... ]

I [al'4 H anndlla ] Applica
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Piastra di supporto SF4-6

® Selezionare nella finestra di dialogo Opzioni "Piastra di supporto SF4-6".

Opzioni &|
3 Ambiente Anteprima
3 Plotter 5 . =
Awvio del programma
Struttura MulkiCard * *
Struttura SF4-6
Provare il pennino
. . .
Plokter: |'|,'I,ISBPBSR\I"|,Lexmark Cpkra 5 P W | Infarmazione:
Si preqga di modificare i valari
Pennino: |Nessun pEnninG w | | e Y Fino a quando viene
raggiunta in punto zero del
0 | 13m0 | v 11695 3| |plotter.
< | | [ Stampare il punkozera l l Punti zero aggiuntivi ... l
I a4 l [ Annulla ] Applica
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Versione di rete

Introduzione

L'installazione dovrebbe essere eseguita da una persona specializzata. Per
eseguire questo processo € necessario disporre di diritti di amministratore.

La versione di rete di M-Print® PRO ¢ utile quando piu utilizzatori necessitano di utilizzare il
software all'interno di una rete. Invece di installare M-Print® PRO su ciascun computer, in questo
caso basta installare il software a livello centrale (Setup.exe su un server o PC centrale). | PC
client (o gli utilizzatori) accedono a M-Print® PRO tramite percorsi di rete condivisi.

Mediante la versione di rete € possibile stampare solo se le stampanti da
utilizzare sono collegate alla rete tramite un cavo di rete (non tramite USB)!
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Setup

Eseguire il programma di setup:

Il processo di installazione si avvia automaticamente e viene visualizzata la procedura guidata di
configurazione.

p
4 Installazione di M-Print@ PRO 1& S =0 B

Installazione guidata di M-Print® PRO

L'Installazione guidata consente di installare M-Print® PRO
niel computer. Fare dlic su Avanti per continuare oppure su
Annulla per uscire dallInstallazione guidata.

Indietro I Avant I Annulla |

— — 4

Fare clic sul pulsante Avanti.

14l Installazione di M-Print®
—

Weidmiiller <

WEIDMUELLER SOFIWARE LICENSE AGREEMENT

IMPORTANT: THIS SOFTWARE END USER LICENSE AGREEMENT
("EULA"™) I5 A LEGAL AGREEMENT BETWEEN YOU (EITHER AN
INDIVIDUAL OR, IF PURCHASED OR OTHERWISE ACQUIRED BY
OR FOR AN ENTITY, AN ENTITY) AND Weidmueller. READ
IT CAREFULLY BEFORE COMPLETING THE INSTALLATION
FROCESS RND USING THE SOFTWARE. IT PROVIDES R
LICENSE TC USE THE SCOFTWARE RND CONTAINS WARRLNTY
INFORMATICN AND LIAEILITY DISCLAIMERS. BY SELECTING
THE DOWNLOAD OR INSTALL NOW BUITON RND USING THE

[¥ Accetto i termini del Contratto di Licenza:

Stampa | Indietro I Avant I Annulia |

Accettare le condizioni dell'accordo di licenza, quindi premere il pulsante Avanti.

Scegliere il tipo di configurazione nella finestra seguente:
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5 Installazione di M-Print®

Weidmiiller <

Wengono installate le funzionalita del programma pid comuni. Opzione
consigliata per la maggior parte degli utenti.

Personalizzata |

Consente agli utenti di scegliere le funzionalith del programma da installare e
la posizione in cui verranno installate. Opzione consigliata per utenti esperti.

Completa |

Verranno installate tutte le funzionalitd del programma. E necessaria la

quantita massima di spazio su disco.

Rete |

Consente di selezionare le opzioni di programma da installare, Installa il
programma in rete per [utilizzo da parte di pid utent,

Indietro fvanti

® Premendo il pulsante Rete.

ﬂ Installaziene di M-Print® PRO

sottostante.

it pro R

LPC-Tool

Per modificare la modalita di installazione delle funzionalita, fare dic sulle icone nell'albero

Percorso: C:\softwarel,

M-Print@® PRO

La funzionalith specificata richiede
27MB sul disco rigide.

| Rempesta || Utlzzodisco || Indieto [ Avant || Anmuila |

E possibile verificare lo spazio di memoria disponibile sulle unita esistenti tramite il pulsante

Utilizzo disco.
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® Fare clic sul pulsante Sfoglia...

® Selezionare la directory di destinazione, per esempio C:\software\.

Gli utenti dei PC Client devono poter accedere con diritti di lettura e scrittura alla
directory di arrivo.

® Fare clic sul pulsante Avanti.

ﬁ M-Print® PRO-lmpostazione —

Apri file:

Salva file:
Importa:
Catalogo:
Simboli:
Immagine:
LPC Immagine:
Madelli:

Scripts:

Fare dic sul pulsante Sfoglia per selezionare la cartella di destinazione.

C:¥ProgramDataweidmueller WM-Print PROYdatal,
C:\ProgramData weidmuellerM-Print PRO \datal,
C:\ProgramData weidmuellerM-Print PROYmporty
C:\ProgramData weidmuellerM-Print PROYproductsy,
C:\ProgramData YweidmuellerM-Print PRO\symbols)
C:\ProgramData yweidmuellerM-Print PROYimages),
C:\ProgramData weidmueller M -Print PRO pcproducts)
C:\ProgramData Wweidmueller\M-Print PROVtemplates

C:\ProgramDataweidmueller M -Print PRO \scripts)

Utente con privilegi avanzati: I

Indietro Avant

® Per singoli componenti come il catalogo € possibile utilizzare il pulsante [...] per scegliere

altre directory (per esempio il catalogo in C:\data\catalog).

e Le directory di destinazione devono trovarsi su un‘unita locale del server.

Tutte le cartelle elencate in precedenza devono essere accessibili agli utilizzatori
dei computer client presenti in rete. Per alcune cartelle € indispensabile godere

di diritti di scrittura (vedere la sezione "Condivisione di cartelle").

Vedere il capitolo ,Avvio del programma®.

® Fare clic sul pulsante Avanti.
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14l Installazione di M-Print® (2] |-

Weidmiiller <

Fare dic su Installa per avviare l'installazione. Fare dic su Indietro per rivedere o
modificare le impostazioni di installazione. Fare dic su Annulla per usdre dalla procedura
guidata.

® Fare clic sul pulsante Installa.

Potrebbe essere visualizzato il Controllo account utilizzatore (CAU) di Microsoft Windows®.

® |n questo caso confermare il proprio consenso alla modifica di Windows.

Dopo la conferma il sistema crea le directory di destinazione e copia o crea i file al loro interno.

R
14l Installazione di M-Print® (2] |

Weidmiiller <

Attendere. E in corso linstallazione di M-Print® PRO.

Copia dei nuovi file in corso. ..

Indietro | fvanti |

Lo stato di avanzamento € indicato da una barra.
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® Al termine del processo di installazione premere il pulsante Fine.

Installazione guidata di M-Print® PRO
completata

Fare dic sul pulsante Fine per uscire dallInstallazione
guidata.

Indietro

Una volta chiusa l'installazione guidata, si apre una finestra con cui regolare I'impostazione di
sicurezza. Vedere il capitolo ,Sicurezza®.

Bereit

3E M-Print PRO - - O
i File Guida
3F M-Print PRO Administration
Sicurezza *
23 Ambiente Sicurezza
g Sicurezza
Versione file in fase di salvataggio: |\fers:'one 9.2 i |
Versione file al'apertura: |Tuth' i file ~ |

Se la versione del file non & univoca (ad es. manca la SHA):

[ visualizza messagai di errore

[ apri file non univod
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Condivisione di cartelle

M-Print® PRO utilizza le cartelle seguenti; la struttura delle cartelle dipende dalle impostazioni
eseguite nel corso del processo di configurazione:

AppData
bin

~ AppData
ProgramData

ProgramFiles ~ User
backups
data
images
misc
profiles
temp

spooler

PregramData
data
images
import
misc
products
samples
symbols

templates

~

ProgramFiles
in
cefsharp
locales
install
dot_net_desktop_runtime
frdi_cdrm_driver
usblan
usblan_9500
we_redist
misc
updates
pia
pirm
PrintletCOMNMNECT_UPDATE_W1_2_5_BIMN

thrm_multimark_thrm_multimark_plus
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Il significato delle cartelle & il seguente:

Cartella Contenuto Diritti di
scrittura
richiesti

AppData/User File di programma specifici per l'utente e modificabili X

backups File di backup (directory predefinita) X
Esempio: Backup del profilo utente

data File M-Print® PRO (opzionali, vedere ProgramData)

images Immagini (opzionali, vedere ProgramData) X

misc File di programma modificabili (opzionali, vedere X
ProgramData)

profiles Profilo utente (directory predefinita)
Esempio: impostazioni specifiche dell'utente eseguite
tramite Strumenti > Opzioni, Mappature stampante, ecc. X
Le impostazioni vengono lette e scritte durante I'esecuzione
del programma.

temp File temporanei (directory predefinita)Esempio: File spooler X
per la stampa

ProgramData File di programma generali modificabili X

data File M-Print® PRO di tutti gli utenti (directory predefinita) X
Esempio: Salva o apri i file M-Print® PRO

images Immagini (directory predefinita)
Esempio: Inserimento di un‘immagine

import File di importazione (directory predefinita) X
Esempio: Script di importazione standard

misc File di programma modificabili (directory predefinita) X
Esempio: Licenza, stampanti aggiunte

products Catalogo prodotti (directory predefinita) X

samples File di esempio per I'importazione

symbols Icone del programma (directory predefinita)
Esempio: Icona messa a terra di protezione

templates File di modelli (templates) (directory predefinita) X
Esempio: Vedere il capitolo ,Modelli“

ProgramFiles File di programma eseguibili -

bin File di programma eseguibili

Esempio: Impostazioni di programma, parametri stampante
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documents Manuali, file della Guida -

importmodules | File filtro per 'importazione/Esempio: filtro csv, filtro xml -

install Moduli per comando stampante
Esempio: Comunicazione USB

misc File di programma non modificabili
Esempio: Licenza, stampanti aggiunte

updates Directory di archiviazione per le routine di aggiornamento
Esempio: aggiornamenti pja, aggiornamenti thm
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Operazioni da effettuare sui client

Configurare il computer client
Sui client non € necessario eseguire alcuna configurazione aggiuntiva.
Per impostazione predefinita gli utilizzatori devono lanciare il file 'start.exe' dalla cartella 'bin'.
L'effettiva posizione del file 'start.exe' dipende dalle impostazioni eseguite in fase di
configurazione (directory).

La finestra di dialogo contiene tutte le funzioni necessarie:

Per queste funzioni non sono richiesti diritti di amministratore di Windows.

= scremaa o 2o S ctines PO N
Weidmiiller <

Selezionate un'opzione

Aprire M-Print® PRO.. Creare un collegamento sul desktop

Creare una voce nel menu di avvio Assegnare file a M-Print@ PRO

Chiudi

Caopyright (C) 2013 Weidmueller Interface GmbH & Co. KG
Klingenbergstrasse 16, D-32758 Detmold
All rights reserved.

All'interno della finestra sono disponibili i seguenti pulsanti:

Aprire M-Print® PRO...
Facendo clic su questo pulsante si avvia il programma M-Print® PRO.

Creare un collegamento sul desktop
Facendo clic su questo pulsante e possibile creare sul desktop un collegamento a M-Print®
PRO.

Creare una voce nel menu di avvio
Facendo clic su questo pulsante & possibile creare un collegamento a M-Print® PRO nel menu
di avvio.

Assegnare file a M-Print® PRO
Facendo clic su questo pulsante & possibile associare file a M-Print® PRO in modo tale che
facendo doppio clic su di essi, questi si aprano direttamente con M-Print® PRO.

Chiudi
Con il pulsante & possibile chiudere la schermata di avvio.
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Trasmettere le impostazioni ai client

Le attuali impostazioni della versione di rete per la stampa possono essere messe a disposizione
di altri clienti della versione di rete.

La funzione seguente permette di condividere automaticamente tali impostazioni con gli altri PC
client.

® |anciare il programma M-Print® PRO.

® |n M-Print® PRO selezionare Strumenti, quindi Opzioni.

Verra visualizzata la finestra seguente.

-
=3 Ambiente

Avvio del programma Fare dic su "trasmettere le impostazioni di stampa”, per rendere disponibili le
Vista impostazioni attualil per lastampa da parte di altri utenti di questo computer.

Trasmettere le impostazioni di stampa

Avvio del programma

Estensioni file -Esequila correzione_ della siampanhe_. "
A - Correggere o scorrimento del materiale. ..
Directory - Calibrazione stampante plotter
>
Menu Amministrazione Gli utenti possono decidere se vogliono applicare queste impostazioni.
Aggicrnamento
Codifica colori [ trasmettere le impostazioni di stampa }
Campi

Spostamenti Proteggi impostazioni di stampa

Vecchia password:

Muowva password:

Conferma nuova password:

’ CK ” Annulla ] Applica

® Fare clic sul pulsante Trasmettere le impostazioni di stampa.

Al successivo avvio dei rispettivi PC gli utilizzatori vengono avvisati delle impostazioni eseguite e
possono decidere se adottarle o meno.
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A

Adatta lunghezza marcatore 77
Aggiornamento 192

Aggiornare il software della stampante 223
Allineamento di un testo 27

Apertura di file estranei 227

Applicare il filtro di overflow 76

Aree del marcatore 87

Avvertenze di installazione 2

Avvia programma 3

B

Barra di stato 87

Barre degli strumenti 87, 108
Barre dei menu 87

Bloccato 127

Blocco di un elemento 22
Blocco di un livello 32

C

Campo di documento 130

Campo di lavoro 87

Campo singolo 130

Campo specifico del documento 130
Cancellazione degli elementi 21
Carattere di testo 35

Catalogo prodotti 163

Chiudi programma 3

Codifica colori 47, 193
Comportamento 12

Convertitore 286

Convertitore QLS 286
Convertitore TNV 287

Copia pagina 86

Copiare e incollare gli elementi 20
Crea nuova scala 14

Creazione di cerchi/ellissi 8
Creazione di linee 8

Creazione di rettangoli/quadrati 8

D

Dialogo Calibratura 345
Dimensioni e posizione 54
Directory 12

Duplicazione degli elementi 21

E

Editor simboli plotter 344
Elaborazione di un elemento 6

Elementi 87

Elemento di collegamento 64
Esplora progetti 87, 118
Esplora stampanti 324
Estrarre immagini dai file 25
Explorer simboli 344

F

File Excel 227

Filtro di overflow 51

Finestra Proprieta 9, 10, 87
firmware 223

Formatta testo 27, 111

Funzioni di filtro 50

Funzioni utilizzate di frequente 6

G
Griglia dei dati 87

Importazione batch 267
Importazione da un file Excel 247
Importazione di file 235

Impostare i punti zero 341
Impostare marche di taglio 330
Impostazioni protezione del documento 73
incollare 11

Inserimento di caratteri speciali 11
Inserimento di simboli 12
Inserimento di un campo di testo 7
Inserimento di un codice a barre 10
Inserimento di un livello libero 31
Inserimento di un‘immagine 9
Inserire una forma 8

Inserire una scala 14, 56

Inserisci interruzione di riga 53, 92
Inserisci nuova pagina 136
Inserisci nuovo sottoprogetto 119
Inserisci nuovo tipo di marcatore 119
Inserisci pagina 86

Inserisci sequenza 35

Inserisci simbolo 12

Inserisci tipo di marcatore 136
Interfaccia del programma 4, 87

L

La barra dei menu 90
Lingua dell'applicazione 184
Livelli 137

Livello del progetto 87
Livello di riscaldamento 143
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M

Marcatore 2

Modalita progetto 180
Modo plotter 335
Monitor di stato 320
Morsetti multipiano 55
Morsetto multipiano 92

N

numerare all'indietro 45
Numerare in avanti 45
Numerazione automatica 35
Numero della versione 87

o

Ordine 49
Ordine dei tab 127
ordine guidato 49

P

pagina delle informazioni 142, 180
piastra di supporto 337

PLC 35

Plotter 205

Prefisso 35

prompt dei comandi 231

proprieta 121

Proprieta livello 136, 139

Protetto da scrittura 127
Protezione del documento 73, 103
Prova il pennino 207

Punti d'appoggio 59

Q
gualita di stampa 143, 208, 210, 215

R

Raggruppa 26

Registro 87

rettangolo arrotondato 8
Righello 87

Rotazione degli elementi 19

S

Salvare un'immagine su file 25
Scale 56

Seleziona script di importazione 265
Sequenza di testo predefinita 33
Simboli 2

Simmetria 23

Sincronizzazione del contenuto 48
Spostamento degli elementi 18
Stampa di sottoprogetti 331
Stampa rapida 319

Stampabile 127

Strisce a modulo continuo 64
Suffisso 35

T
Tipi di file 5

Tipo di marcatore 2
triangoli rossi 14

Vv
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